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Budget Overview 

Selected Budget Overview features 
It is vital to control a project’s budget tightly. The Budget Overview in InLoox for Outlook enables you 

to compare your project’s actual and planned expenses in real-time.  
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To get to the Budget Overview, navigate to an InLoox Project >> Start >> Budget Overview. 

 

The budget view is a visualization of your budget, so all the data in the budget overview come directly 

from your project budget. To be able to see anything in the budget overview, you will need to have 

the respective budget data. You can control which data you want to see in the budget overview, but 

you can only make edits to them in the budgets directly.  

You can decide what information you want to see in the budget overview of your project. Display 

your budget as a table, sorted by budget group, or view it in various chart types, depending on the 

information you would like to display. 
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Table View 

 

The table view gives you an overview of all your budget data sorted by group. The table shows the 

planned expenses and revenues, the actual expenses and revenues, and a comparison between 

actual and planned budget. 

Another way to identify budget overruns is to check the status column. It shows you whether your 

project is within budget or not: 

 = Project is on budget, i.e. the actual expenses are within the planned budget. 

 = Actual expenses are higher than planned expenses and you need to control your budget.  

 

Chart View 
The chart view gives you a visual overview of your planned and actual budget. This enables you to 

quickly see whether your project is still within budget. 
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Chart type 

You can choose between four chart types, which display and sort the budget according to different 

criteria: 

 

  

By Type – Graphical overview of all expenses and revenues 

By Group – Graphical overview of all expenses and revenues sorted by group  

By Date – Graphical overview of all expenses and revenues sorted by date (day, month, year) 

Expense vs. Revenue – Comparison between actual and planned expenses, and actual and planned 

revenues 

Data 

You can also choose which data should be shown in or hidden from the graphical overview. 
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Planned Expenses 

(Resources) 

  Based on the recorded resources working on the project tasks. The 

total work time of all resources multiplied by the purchase price of 

the respective group.  

Planned Expenses 

(Other) 

  All other planned expenses based on the purchase price, excluding 

resources.  

Actual Expenses 

(Time Tracking) 

  Based on the time tracking entries in the InLoox tasks.  

Actual Expenses 

(Other) 

  All other actual expenses for already received services or 

commissioned orders. The total sum is based on the purchase 

price of the group.  

Planned Revenues   All planned revenues based on the sales price of the respective 

group.  

Actual Revenues   All revenues from already invoiced services or for services the 

customer has already received. The total sum is based on the sales 

price of the respective group.  

Planned Margin   Comparison between planned revenues and planned expenses.  

Actual Margin   Comparison between actual revenues and actual expenses.  

 

Budgets 
InLoox for Outlook enables you to create and manage your project budgets, so you always have an 

overview of your project’s financial status. 

To get to your project budgets open an InLoox Project and navigate to  on the Home tab.  

Budget types 

Automatically created budget types 
InLoox generates two budgets automatically:  

• Expense (actual, time tracking)  
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• Expense (plan, resources) 

Expense (actual, time tracking) is based on the time tracking entries in the InLoox tasks, the Expense 

(plan, resources) is based on the resources working on the project tasks.  

 

Both budgets are only automatically filled with budget items if they fulfill these requirements: 

1. You have created tasks in a project 

2. You have assigned time tracking entries to project-specific tasks, or have assigned resources 

to these tasks 

3. You have specified the effort for the tasks 

You can’t edit some elements of the budget items, such as group, units etc. If you want to make 

changes then you’ll have to make the edits in the tasks or time tracking entries directly.  

 

Budget types you can create manually 
Next to the two automatically created budget, you can also create four types of budgets manually: 

Planned Expense – Use this budget type to create a budget for your planned expenses based on the 

purchase price. 

Actual Expense – Use this budget type to create a budget for commissioned orders or already 

received services. The sum of the budget items will be calculated based on the purchase price of the 

group. 

Planned Revenue – This budget type is used to create a budget for planned revenues based on the 

sales price of the respective group.  

Actual Revenue – Use this budget to create a budget for already invoiced services or for services the 

customer has already received. The sum of the budget is based on the sales price of the respective 

group.  

 

Create and edit a budget 

Create a new budget 
1. Open an existing Project or create a new one. 

2. Click on Budgets in the Start tab. 

3. Depending on what type of budget you want to create, choose one of the four budgets in the Edit 

tab: New Planned Expense, New Planned Revenue, New Actual Expense or New Actual Expense.  
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4. The new budget document will immediately appear in the budget list under Expense or Revenue 

respectively. 

 

  

5. Edit the budget from the side panel 

 

  

• General 

• Name: Give your budgets clear names that allow you and your customers to easily 

assign them to a project. InLoox automatically assigns the names Expense (Actual), 

Expense (Plan), Revenue (Actual) or Revenue (Plan) combined with the consecutive 

number, depending on the budget type you have chosen. 

• Budget Status: Choose in the dropdown list between Approved, Rejected or Open.  
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 Use the status Open for not yet received quotations or outstanding invoices etc. 

• Date: Specify a date for the budget. InLoox assigns the current date by default.  

• Created by 

• Click on […] to choose a resource from your global address book. Alternatively, click 

on the arrow to choose from a list of recently used resources.  

 

 

Manage the budget status 
Every budget can either have the status Open, Rejected, or Approved. 

 You can define your own budget status in the InLoox Options.  

 

Open and Approved budgets are defined as budget relevant by default. Budgets with the 

status Rejected are defined as budget neutral. This means, that only open and approved budgets will 

be used for the calculations of project budgets and will be shown in budget reports or the budget 

overview.  

 

Generate an invoice 
You can create, send and follow up on project-based offers and invoices with InLoox. The chosen 

budget items will automatically be marked as billed to avoid confusion and double billing. 
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Follow these steps to create an invoice:  

1. Go to Projects >> Budgets >> Edit 

2. Mark an Actual Expense in the budget list, for which you want to create an invoice (Actual 

Revenue). If you only want to bill certain budget items, then only choose the relevant budget items. 

To do so keep the CTRL button pressed while left-clicking on the items you want to include in your 

invoice. 

3. Click on Generate Actual Revenue to create an invoice based on your chosen budget. 

  

If you want to bill the whole budget, then choose All Line Items in the drop down menu. If you only 

want to bill the items marked in step 2, then choose Selected Line Items. 

4. You find the created bill in the budget list under Actual Revenue and you can edit it in the side 

panel.  

 Only use the button Generate Actual Revenue for billable budgets, e.g. performed consulting 

tasks for which you are charging a customer. For deposits for which you did not provide any services, 

e.g. rent payments, use New Actual Revenue.  

 

Create a budget report 
If you want to create a budget report, e.g. to present your customer with an invoice, follow these 

steps: 

1. Go to Project >> Budgets >> Reports 

2. Mark the budgets for which you want to create a report. 

3. The ribbon shows you all available budget report templates. The templates Revenues/Expenses, 

Budget Overview and Revenues are already included in the InLoox Options. Go to InLoox Options >> 

Reports to edit or create new templates  

. 
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4. After the budget report is created, you can preview the document and you can export the report as 

an Excel or PDF file, or send it via email.  

 Find more detailed information on reports under Project reporting features. 

 

Save and load budget templates 
You can reuse a budget for recurring projects by saving it as a template instead of creating a new one 

every time.  

 

Save a budget template 

Follow these steps to save a budget as a template: 

1. Navigate to Projects >> Start >> Budgets >> Templates 

2. Mark the budget you would like to save as a template. If you do not want to save all budget items, 

then only mark the ones in the budget items list which you want to include in the template. To 

choose multiple items, hold the CTRL button and left-click on all relevant items. 

3. Click on Save Template in the ribbon. 

 

4. You can edit the following information in the pop-up window:  
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• Name: Assign the template a clear name so you can easily find and easily match it later. 

• Type: The template will be assigned the same budget type as the original by default. 

• Line Items: You can either save the whole budget including All line items, or only the Selected 

items you have marked in step two. 

• Budget templates are not automatically visible to all users. If you would like to make it Visible 

for all users mark the box accordingly.  

 

Load a budget template 

To load a previously created budget, follow these steps: 

1. Choose an existing budget 

2. Click on Load template in the tab Templates 

3. A dialogue window will open where you can choose a template from a dropdown menu. You can 

also get a preview of the budget items saved in the template. 

4. Confirm your selection with OK.  

 

Create and edit a budget item 

Create a new budget item  
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Every budget can have as many budget items as needed. Follow these steps to create a new budget 

position: 

1. Navigate to Projects >> Start >> Budgets and open an existing budget or create a new budget. 

2. Go to the tab Budget Items and click on New Budget Item.  

 

  

3. Edit the newly created budget item in the side panel 
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• Line Item: 

• Group - Each group has their own purchase and sales price, which are necessary for 

generating the budget sum. The following groups are saved in the InLoox options by 

default: Draft, Production, Consulting, and Maintenance.  You can edit or create 

new groups in the InLoox options. 

• Template – Choose a template for the chosen group. A template is relevant for the 

pricing as it determines which quantities and units will be used to determine the 

budget. 

• General: 

• Name and Description – Assign your budget item a clear name and, if necessary, add 

a description to further clarify the item. 

• Pricing: 

• Quantity – Define how many units an item should include. For example, if you would 

like to bill 90 minutes of consulting as an hourly value, enter the number 1,5. 

• Unit(s) – Units are defined in the options, which is why the unit depends on which 

group you have chosen in General. A unit can be for 

example: Minutes, Hours or Days. 

• Sales and Purchase Price – The prices are automatically taken from the values you 

have defined in the InLoox Options. You can also manually define the sales and 

purchase prices. These changes won’t have an impact on the settings in the Options.

 Taxes are included in the prices, as InLoox only calculates with net prices. 

• Total – The quantity will either be multiplied with the sales or purchase prices, 

depending on the budget type. You can identify the price that was used for the 

calculation by the yellow highlight. With a mouse over on the information icon, you 

will also get an explanation as to why the budget was used for the calculation. 

• Details: 

• Performed by – The person who created the budget item will always be assigned to it 

by default. You can assign another person to the budget by clicking on […] and 

choose someone from your address book. 

• Provision date – The current date is automatically stated. You can manually change 

the date to the appropriate time.  

 It is also possible to copy a budget item from another budget or project: Use the 

commands CTRL+C (copy) and CTRL+V (paste), or alternatively use the copy and paste buttons in the 

ribbon in the tab Budget Items.  

 You can’t add any new budget items for the automatically created budgets Expense (actual, time 

tracking) and Expense (plan, resources). All items are automatically taken from the time tracking or 

the resources’ tasks and editing is restricted. If you want to edit an item from one of these two 

budgets, you will have to do so in the respective time tracking entry or the respective task.   
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Manage the status of a budget item 
Every budget item can have one of three statuses: Not Billed, Billed, and Not Billable. 

 

To change a budget item’s status, do as follows: 

1. Go to Project >> Budgets >> Budget Items 

2. Choose the budget item, whose status you want to change 

3. In the ribbon click on Budget Item Status and choose the appropriate status: Not Billed, Billed, Not 

Billable 

Every newly created budget item is marked as Billable and Not Billed by default, which means that 

the customer will be billed for the service. Would you like an item to be documented, but do not 

want it to appear on the invoice, then mark the item as Not Billable. 

Already Billed items will automatically be marked by the system to avoid double billing. This also 

enables you to keep an overview over all items which have not yet been billed.  

 

Link documents to budgets/budget items 
It is possible to attach an Excel table, a contract or any type of documents to project budgets or 

individual budget items. This enables you to establish better comprehensibility, e.g. for invoices. 

1. To attach a document, double-click on a budget or budget item. 

2. In the side panel, click on New link under Documents. 
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3. In the dialog box, select the document from the list of existing project documents. You can 

also search for a specific document (e.g. by file name) by typing your query in the bar above 

the respective column header. 

 

4. You can also click New to upload a new file (New file), link to a new file or add a new internet 

URL. 
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Calendar 
Introduction 
The Global Calendar displays planning elements (summary activities, activities, milestones and 

published planning elements) across projects in a combined calendar view. 

 

You find the Calendar on the InLoox PM tab in the Views group. 

 

NOTE Users need to have reading permissions (Read project and Read planning) to be able to see the 

regarding items in the calendar view. If they don’t have the necessary permissions, the items won’t 

be visible in the calendar. 

 

Views 
On the Home tab, in the Global Calendar, there are five different time spans available (day, work 

week, week, month and timeline). 

Besides that, you can adjust the zoom levels on the Home tab in the Details group and open today’s 

calendar. 

 

Click on the button Show time of day in the Ribbon on the Home tab in the Current View group to 

see the exact-to-the-minute start dates and deadlines for each planning element in the calendar. 
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To see those planning elements that take place in your projects at a certain date click on the Select 

date button in the Ribbon on the Home tab in the Current view group. 

An icon marks the activities with assigned work packages: 

 

When you hover over a planning element with your cursor, you see a tooltip. It shows at a glance the 

name of the planning element, its start, end, location, the regarding project and the name of the 

project manager in charge of the project which will be displayed as a hyperlink. If you click onto that 

link, you get all the contact information on the project manager. 

 

NOTE The tooltip shows the location that is indicated when creating an activity or a milestone – it 

does not correspond to rooms in Outlook Exchange. 

NOTE Working and non-working times in the global calendar depend on the settings you made in the 

Outlook options in the calendar area. 

 

Create your personal calendar view 
You have different options to create calendar views that are a perfect fit for your information needs: 

To gain a better overview, you can filter the calendar by the most important planning, project and 

custom information, e.g. by certain projects or by milestones only. 

 

Please follow these steps to apply a filter to your calendar: 

1. Click on the button Filter on the Home tab in the Current Views group. 

2. The Filter Editor window opens. Now you can select different criteria (e.g. project name, 

activity, critical and many more), different conditions (equals, is greater than, is less than and 

many more) and different relational operators (and, or, not or etc.) and confirm your 

selection by clicking OK. 

You will now see the filtered calendar view. An active filter is displayed below the calendar. To reset 

the filter click onto the cross beside the filter. 
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Application example 

Filter by milestones 

 

If you only want to view milestones in your calendar, please open the filter. Select “Is milestone” as 

criterion, “equals” as condition and activate the checkbox. When you confirm your selection by 

clicking OK, you will only see the milestones from your projects in the Global Calendar. 

 

Conditional Formatting 
Conditional formatting enables you to highlight certain planning elements in the calendar view 

according to custom rules – e.g. to keep an eye on critical activities. 

And this is how to use conditional formatting using the example of critical planning elements: 

1. Click on Conditional Formatting in the Ribbon on the Home tab in the Current View group, 

then select Add Simple Formatting. 

2. A side panel opens where you can edit the conditional formatting. Select “Critical” in the 

Column section and “equals” as a condition. Activate the checkbox in the value section. 

3. Now you can choose a color to highlight critical elements. In the example, we chose red. 

4. Now, all critical planning elements in the calendar are highlighted in red.    
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NOTE The color that you select in the conditional formatting section overwrites the color of the 

element in the Gantt chart.   

 

Save a calendar view 
You can save the settings that you made in the Details, Arrange and Current View sections in the 

global calendar as a view, so that you don’t have to make the settings again at a later point. 

Please follow these steps to save a calendar view: 

1. Adjust the view according to your needs. 

2. Then click on the Save button in the Ribbon on the Home tab in the Current View group. 

3. The Save View window opens. Now you can choose whether you want the view to be visible 

only for yourself or for all users.   

 

4. You can open the saved view by opening the Projects section in the Microsoft Outlook 

navigation menu. It opens a side panel on the left hand side where you can expand the 

Calendar section. There you’ll find all saved calendar views. 
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NOTE When the InLoox calendar view is called up again, the last view opened by the user is displayed. 

 

Edit planning elements 
To edit a planning element in the calendar view, you can either double-click on it or click on the Show 

Details button in the Ribbon on the Home tab. This is only possible if you have the 

necessary permissions (at least Read project and Write planning). 

 

NOTE It is not possible to edit planning elements directly in the calendar. 

The regarding project opens and the planning element that you chose is pre-selected. Now, you can 

edit it directly in the project. 

Synchronize planning elements with Outlook elements 

You can synchronize planning elements with Outlook elements directly from the calendar view. And 

this is how you do it: 

1. Mark the regarding planning element in the calendar. 

2. In the Ribbon, click on Synchronize on the Home tab in the Actions group and choose 

whether you want to synchronize the element with your Outlook calendar or your Outlook 

tasks. 

3. After synchronizing it, you will find the element as a calendar appointment in your Outlook 

calendar or as a task in your Outlook tasks.  
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Create a new project 
This chapter explains step-by-step how to create a new project with InLoox 9 for Outlook. For starting 

a new project you will need specific user permissions. If you do not have the permission to create a 

new project yourself, you can submit a project proposal to be approved by your supervisor or project 

manager. This workflow process provides increased planning security for you and an improved 

project portfolio insight for the responsible project managers and executives. For more information 

on permissions browse the articles: how to set user permissions and user permission options. 

Additionally, you can use the search feature within the projects to easily find specific project 

information. 

Activate the "Fixed Deadlines"-Feature on the management page for new or running projects. This 

highlights all activities that exceed the project end date (defined on the management page) in a red 

shaded field in the project plan. 

How to create a new project 
In the following description we will explain step-by-step how to create a new project with InLoox 9 for 

Outlook. (Therefore you will need specific user permissions. If you do not have this permission, you 

can submit a project request.)  

1. Start from your Outlook Inbox: 

 

2. After that you can see the project list, which gives you a short overview about all your projects.  
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3. The management form will open. 

Here you can enter the basic project information.  

 

• Name your project. 

• The project number is automatically generated. But administrators can customize the project 

number and the number format in the InLoox options.   

• Choose the responsible division and a category for your project. Administrators can 

customize the division structure as well as the project categories in the InLoox options. 

• To assign a picture to your project click on the grey InLoox Logo. Locate the picture you want 

to add and double-click on it.  

  

4. Assign a customer to your project. 

Additionally, administrators can edit customers and customer numbers in the InLoox options.  
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How to assign a new customer to the pre-defined customer list: 
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5. By assigning project team members (project team, project partners, customers etc.) to the 

project, your employees will know for which part of the project they are responsible. 

By setting up a project team, you define the access permissions for the project. (For more information 

on how to share permissions or add users to the list, please see Set user permissions.) 

Moreover by assigning project roles, you define the role permissions of the chosen person. 

Select the project manager and team members from your Address Book (InLoox address book, 

Microsoft Outlook address book or exchange server address book): 

• Select one or more project managers by double-clicking on the entry and click on OK. 

• Select one or more team members by double-clicking on the entry and click on OK.  

 

6. Select start and end dates as well as the status of the project. 

• Status: Administrators can individually define the project status in the InLoox Options.  

 

7. Use notes to leave any additional information on the project. 

You can change the appearance of the note with InLoox features on the Format tab. Customize your 

notes with different fonts, colors, sizes etc. … 
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• Hyperlink: If you want to link a file, website or picture, mark the relevant part of your note 

and click on Hyperlink. Select the file in the address field or enter the URL of a website. Then 

click on OK. 

• Symbol: Choose a symbol, which is not on your keyboard or is a special character. 

• Picture: Browse the folder where the picture you want to add is saved, select the picture and 

click on Insert. You can resize the picture directly in the note.  

  

8. To save your note click on Post Note. 

Your file is now linked to the note and can be accessed by pushing the Ctrl-button and clicking on the 

link. 

Additionally, you can send your note via email to the project manager or other team members. Click 

on Notify and select a contact from the address book. 

Notify: Administrators can define in the InLoox options, if notes are send via email, as Outlook-tasks 

or as Outlook meeting requests.  

  

9. Add other project information by using InLoox features on the Edit tab:  
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10. Click on Save and Close in the start ribbon when you are finished.  

 

 

How to submit a project request 
When you don't have the user permission to create a new project, you can submit a project request 

to be approved by your supervisor or project manager. For more information on permissions browse 

the articles: how to set user permissions and user permission options. In the following we will explain 

step-by-step how to submit a project request: 

1. Start from your Outlook Inbox: 
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2. After that you can see the project list, which gives you a short overview about all your projects.  

 

3. The management form will open. 

A notification will pop up (yellow highlight) on the management form to inform you that you are not 

starting a new project but editing a project request. Click OK to edit the new project request. 
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• Enter the basic project information. Therefore read the chapter How to create a new project. 

• Click on the Reviewer button in the staff area to select somebody to release your project 

request. Select the responsible person by double-clicking on the entry in the address book. 

  

4. Click on Safe and Close when you are finished. 

The reviewer you selected will receive your project request submission for approval and the project 

request will be included in the tree structure of the InLoox project list. 

 

 

Search and filter project information 
InLoox provides you with a search feature within the projects. Thereby you can easily find and access 

needed data. Scan your projects with appropriate keywords: 

1. Enter a keyword in the search box that you can find on the top right of each page. Select All 

Pages on the search tab to scan all project information. To scan just the open page (e.g. Management, 

Mindmaps …) click on Only this Page. 

2.  Select enter or click on the search icon . The search results are shown on the right side of the 

screen. 

3. Additionally, you can refine your search by using a filter on one of the search result columns.  

 

4. For creating a customized filter you can define values and logical operators in the dialog box.  
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5. When you are finished click on the discard icon X next to the search results’ list or click on Close 

Search on the Search tab.  

 

Customization 
Backup project data 
To back up all of your InLoox PM data you can use the correspondent tool producer. 

A regular data accortding to the InLoox PM editions backup is carried out as follows 

InLoox PM 

edition Procedure 

Personal It is sufficient to make regular copies of the InLoox PM files on CD-ROM or tape. The 

data file, which normally has the extension .SDF (SQL Server Database File), must 

not be opened in any program. The standard name of the file is InLoox.mdf. The file 

is stored in the InLoox PM installation folder. 

Workgroup 

Server and 

Enterprise 

Server 

Save the entire InLoox PM database on the server where it is published. You can use 

any software which supports the backup of databases during operation (scheme and 

data) and which is suitable for your database system. 

Unfortunately, it is quite difficult to backup offline copies (database replications) 

located on the users' computers. We recommend to synchronize workstations with 

the database server at frequent intervals; this strategy reduces the risk of losing 

changes which were made offline. 
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Documents stored in InLoox PM must be backed up separately. InLoox PM only saves links 

to these objects, a backup of the InLoox PM database is not sufficient to back up the documents as 

well. The backup strategy and software depend on the storage location of the documents (files on the 

local computer, the server or the SharePoint document library), the number of users and the data 

volumes. 

 

Change the time zone 
If your team is scattered across various time zones, yet has to work towards a common deadline, you 

no longer have to do cumbersome time zone conversion. Since InLoox Version 9, InLoox for Outlook 

references the time zone set on the device you are working with and automatically converts your 

deadlines for you. 

To check which time zone is set on your device or to change it, please follow these steps: 

1. Double-click on the date and time in the lower right corner of your monitor. 

2. Click on Change date and time... if you would like to change the settings. 

 

3. Select the suitable time zone. InLoox for Outlook will now convert all the dates and deadlines 

for you. 

 

Create and edit custom fields 

Create and edit custom fields 
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Note You need administrator rights to create custom fields. Custom fields are available for all InLoox 

PM versions and for InLoox now! Enterprise version. 

InLoox allows you to create new custom fields either for the entire project or for specific areas in the 

project: 

• Budgets 

• Document 

• Line item 

• Mind Maps and/or Mind Map Node 

• Planning 

• Project 

• Tasks 

• Time 

You can rename custom fields at any point and as oftern as you need to. InLoox supports several data 

types for custom fields and lets you set rules for the display of custom fields. Please find below 

instructions for creating custom fields in InLoox: 

If you have admin permissions for InLoox, you can create your own custom fields for new columns in 

the planning list. In Outlook, open the  by clicking on File and on InLoox Options.  

1. Click on Custom Fields and then on New to create a new type of custom fields. 

 

2. Name the new custom field and choose the Location where in InLoox the custom field shall be 

displayed. 
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3. Then select the Type of custom field. You can choose from Text, Date, Integer (number), Decimal 

number, Checkbox, List, or Currency. 

 

4. Then enter the Default value that will automatically be displayed in the custom field. Click on the 

edit Symbol  to open the window to edit the default value. In this example, the custom field type for 
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the custom field Risk is List and the default values are High, Medium, and Low. The InLoox users can 

select one of these three values in InLoox Projects to highlight e.g. high-risk projects. 

 

You can allow InLoox users to leave the custom field empty by setting a check mark at Allow empty 

selection. 

If InLoox users should be able their own values, set a check mark at Allow user to add new items. 

Beware, however, that allowing this kind of individual customization may cause confusion. 

5. Per default, the newly created custom field ist always displayed. If you want to set a rule for this 

custom field, select Display only if and follow the instructions below. 

6. If you want to delete custom fields, mark the field in the overview list and click on Delete. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/customization/create-and-edit-custom-fields/create-custom-fields-according-to-rules/
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Create custom fields according to rules 

Note You need administrator rights to create custom fields. Custom fields are available for all InLoox 

PM versions and for InLoox now! Enterprise  

Note Division support is only available in InLoox PM Enterprise and InLoox now! Enterprise 

Similarly to the document structure, you can create custom fields according to individual rules. This is 

convenient because not every field is relevant for every department. If you have a lot of custom 

fields, it can be difficult to keep track of which fields need to be filled in and which are only optional. 

With this new feature you can now define which fields are automatically displayed for which 

department. 

Example: 

The marketing department often creates documents that go through various feedback rounds before 

they are released for publication. Here it is convenient to have a custom field in the documents that 

indicates the editing status of the document. Follow these steps to create this custom field: 

1. Open the InLoox options: File >> InLoox Options 

2. Under General, click on Custom Fields 

3. To create a new custom field, click on New 
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4. The editing window opens 

 

          1. Give your custom field a unique and easily distinguishable name such as "Editing Status 

Documents" 

          2. Select the InLoox area in which the field should be placed. In this case, select Documents 

          3. Select List as type: 

                - Click on   to enter the list entries 

                - For example, the first entry could be "In Process". Confirm with Enter or click on the green 

plus icon.  

                - Other list entries could be "In Review" and "Final" 

                - Select which entry should be the default selection, in our case it's "In Process" 

                - Confirm with OK 

          4. Now define your rule. In the editing dialog, select "Display only if" 

          5. Click on Fields and select division 

          6. Enter the exact name of the division, i.e. how it is saved under "Divisions" in the InLoox 

Options - in this case "Marketing" 
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5. Now confirm with OK. You will now find the newly created field in the list of custom fields. 

 

 

Customizing the InLoox PM language files 
InLoox PM uses so-called resource files for all texts and messages that are displayed. These are 

located in the program folder on the InLoox PM client. If you want to adapt the displayed texts and 

messages to the requirements of your company you have to modify them in the resource files. You 

can find them in the program folder on the InLoox PM client. 

 

• Changing the files can cause problems with the program, especially if data are deleted. 

• When you re-install InLoox PM, the client setup will overwrite any changes you have made to 

the language files. 

List of the language files (delivery staus) 

File name Contents 

InLoox.xml English, German, Spanish, Italian, French 

Please follow these steps to customize the InLoox PM resource files: 

1. Close Outlook on the client concerned. 

2. Open the relevant language file with the InLoox PM Resource Editor. This tool can be found 

in the Download area of the InLoox website. 

3. Make the required changes to the file and save it. 

4. Test the changes on the InLoox PM user interface. 

5. Distribute the file among other InLoox PM clients as required. 

 

Generate personalized views 
Organize, sort, and group projects - e.g. by assigned responsibilities, deadlines, project type, priority, 

etc. You can save the created project list view and open it again as soon as you use the project list 

again. 
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Standard views included in InLoox PM 

Use the standard views provided by InLoox PM. These views help you to display data in a flexible way. 

 Learn more about the other views by default such as timeline, project requests and trash, 

see The views of the tree structure in the project list. 

 

Generate a personalized view 

InLoox PM enables you to save personalized views. Please follow these steps: 

1. On the Outlook Ribbon, on the Start tab, in the InLoox PM group click Projects. 

 In Outlook 2007, click InLoox PM Folder in the InLoox PM Toolbar. 

2. Now you can change the view directly in the project list. 

 For more information on how to do this, see Customize a view in this article. 

3. On the InLoox PM tab, in the Views group click More Views and then Save current view as.  

 In Outlook 2007, click Actual Views in the InLoox PM Toolbar. 

1. In the Save View dialog box, enter a view name. 

2. Activate the Visible for all users check box, if you want to share this view with other 

authorized users. 

3. Click OK. 

The new view is now displayed in the drop-down list More Views. 

 

Use and manage personalized views 

This is how you can use a personalized view: 

1. On the Outlook Ribbon click InLoox PM tab. 

2. In the Views group, click More Views. 

 In Outlook 2007, click Actual Views in the InLoox PM Toolbar. 

3. Select a view from the drop-down list, e.g. Project controlling. 

InLoox PM loads the saved view with customized data in the project list. 

Proceed as follows in order to manage views: 

1. On the Outlook Ribbon click InLoox PM tab. 

2. In the Views group, click More Views. 

 In Outlook 2007, click Actual Views in the InLoox PM Toolbar. 

3. Click Manage Views... in the drop-down list. 

4. In the Views dialog box do one or more of the following: 

• Edit view  double-click the view you want ot edit or click Edit. 

• Remove view  Remove permanently one view from InLoox PM. Choose a view from 

the list and click Delete. 



 46 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
• Reset views  Click Reset views, if you do not want alle changes to be accepted. 

• Export view  Save a view in your local documents. Choose one view from the list and 

click Export. 

• Load view  Load a view from your local data. Click Import and choose a view file in 

the Import File dialog box, then click Open. 

• Download view  Click Download to download an exisiting view template from the 

InLoox website. 

 

Customize a view 

In the Outlook Ribbon, on the Start tab, in the InLoox PM group, click Projects to open the project 

list. Now you can customize the project list view with the following possibilities. 

 In Outlook 2007, click InLoox PM Folder in the InLoox PM Toolbar to open the project list. 

• Sort the information in the project list  Click on a column by which the project list is 

supposed to be sorted. 

The project list will be displayed according to your choice. Click    in the column to sort in 

rising or in descending order by clicking  . 

• Group the projects according to the selected criterion  Click on a column, e.g. Status, by 

which the project list is supposed to be grouped. 

• Drag a column into the area above the column headers. 

The project list will be grouped by the selected criterion. Reset the grouping via Drag 

and Drop into the project list. 

• Add more information to the project list  Use the Choose fields feature to organize the 

project list by selected information. 

• Right-click on the project list to open the context menu. 

• Click Choose fields in the context menu. 

• On the Choose fields dialog box, click the field you want to add and drag it into the 

column headers. 

 Reset the fields via Drag and Drop into the project list. 

• Define individual fields  You can implement the workflows for all users with this feature. 

Example: The development department staff only sees projects with the status Development. 

If the status changes to Bill, the project becomes visible to accounting staff; for other persons 

the project remains hidden. 

 For more information see Search and find projects. 

 

Notifications 
Notifications simplify the project communication process. You can easily send notifications to any 

resource via InLoox. In this case it’s important to differentiate between InLoox PM and InLoox now!: 

• InLoox PM: InLoox PM allows you to manage and customize different notification templates. 
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• InLoox now: InLoox now doesn’t allow the customization of notifications, as notifications are 

predefined by the systems. Only the frequency of notifications can be changed. 

InLoox now: Change frequency of notifications 

When you are working with InLoox now! the InLoox notifications are predefined by the system. 

Therefore, only the frequency of notifications can be changed. 

InLoox now! sends notifications (e.g. on new tasks) via e-mail. Here you can see an example of an 

InLoox notification mail:  

 

   

Basic notification settings directly in the notification e-mail 

Basic notification settings can be changed directly in the notification e-mail. At the end of each e-mail 

you can increase the frequency, reduce the frequency or deactivate messages. Though in the e-mail 

the frequency can be switched between hourly and weekly only. For detailed settings change to you 

InLoox now! profile. 

  

Detailed settings in the InLoow now! profile 

For detailed settings you have to open your InLoox now! profile. Therefore, proceed as follows: 

1. Open InLoox now! in your webbrowser: https://app.inlooxnow.com/Account/Login 

2. Login and in the upper right corner click on your name and afterwards on Profile. 
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3. A new window will open. In the Person tab you can edit the notification settings. Therefore, choose 

between deactivate, immediately, hourly, daily or weekly.  

 

4. Afterwards click on OK, to save your changes.  

 

InLoox PM: Manage notification templates 

Notifications simplify the project communication process. You can easily send notifications to any 

resource via InLoox. 

InLoox PM allows you to manage and customize different notification templates. Whereas in InLoox 

Now! the customization of notifications is not possible, as notifications are predefined by the 

system.   

InLoox PM provides you with notification templates for the following areas: 

• Tasks 

• Documents 

• Planning 

This chapter is focusing on InLoox PM notification templates! 
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Introduction to notification templates 

To manage InLoox PM notification templates, open the InLoox options: 

1. We start from your Outlook inbox. Click on File in the left corner and afterwards on InLoox PM 

options. 

2. The InLoox PM options will open in a separate window. In this window select Notifications >> 

Templates in the tree structure on the left, to get to the notification template overview.  

 

3. In the overview you can see all notification templates structured into tasks, documents and 

planning. Additionally, you can define the notification type for each template by using the three icons 

on the right side (see screenshot). 

4. Furthermore, you have the possibility to design, export and download notification templates: 

 

Design notification templates 

To edit the content of an InLoox notification template, select the template from the overview and 

click on Design. A new window will open, where you individually design the template. How to work 

with the InLoox notification designer, will be explained in the next chapter: Customize notification 

templates 

When you have finished, save your changes by clicking on Apply in the InLoox options. 

 

Export notification templates 

To save a notification template locally on your computer, select the template from the overview and 

click on Export. Afterwards select the storage place in the new window and click on Save. When you 

have finished, save your changes by clicking on Apply in the InLoox options. 

 

Download notification templates 
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To download notification templates from the InLoox website, click on Download. You will we 

transferred to the InLoox website, where you select the language (German/English) for your 

notification templates.  

 

Define notification type 

Like we have already mentioned in the introduction chapter, you can define for each notification 

template different notification types. You can choose between: 1 E-Mail, 2 Task-Request and 3 

Meeting-Request.  

 

You can choose only one notification type as well as several notification types at the same time: 

1 E-Mail 

By selecting E-Mail as the notification type, the resource will be notified via e-mail. 

2 Task-Request 

By selecting Task-Request as the notification type, the resource will receive a task-request as 

notification. 

3 Meeting-Request 

By selecting Meeting-Request as the notification type, the resource will receive a meeting-request as 

notification.  

 

Default notification templates 

InLoox PM provides you with various default notification templates that can be managed in the 

InLoox options (File >> InLoox PM options >> Notifications >> Templates). 

You can use the following InLoox PM default notification templates: 

Notification  Purpose 

Task - done InLoox PM sends this notification as soon as a task is marked as done.  

Task note - added This notification is created when a new task note is added to a task.  

Task - added This notification is created when a new task is added to one of the following 

project areas: Tasks, Mind Map or Planning.  
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Notification  Purpose 

Task - resource 

added 

As soon as a resource is added to a specific task, this notification will be sent.  

Task - modified InLoox PM creates this notification as soon as a task is modified.  

Task  - resource 

removed 

InLoox informs you when a resource is removed from a task.  

Task - deleted This notification is created as soon as a task is deleted.  

Task note - 

deleted 

InLoox PM creates this message as soon as a task note is deleted.  

Document - 

added 

InLoox PM informs you about new project documents.  

Document - 

deleted 

InLoox PM informs you when a project document is deleted.  

Document - 

modified 

This notifications is created to notify about modified documents.  

Activity - 

Predecessor done 

You receive this notification when a planning element - that is a predecessor - 

is marked as done in the project plan.  

Activity - added This notification informs about new activities in project plan.  

Activity - done As soon as an activity is marked as done in the project plan you receive this 

notification.  

Activity - modified This notifications informs about changes to activities in the project plan.  

Activity - deleted InLoox PM creates this message as soon as an activity is deleted from the 

project plan. 

Milestone - 

Predessecor done 

InLoox PM creates this message when a milestone - that is a predessecor - is 

marked as completed in the project plan.  
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Notification  Purpose 

Milestone - done As soon as a milestone is marked as done in the project plan, you receive this 

notification.  

Milestone - added When new milestones are added to the project plan, this notification is 

created.  

Milestone - 

modified 

This notification informs about modified milestones.  

Milestone - 

deleted 

This notification informs about deleted milestones.  

Project note - 

added 

This message informs about new project notes.  

Project note  - 

removed 

You receive this notification as soon as a project note is removed.  

 

Customize/Design notification templates 

You can individually customize the default notification templates. Therefore, you can use several 

fields. A field can be described as a placeholder for specific project information. You can edit the 

template by deleting or adding fields. 

To customize a template, proceed as follows: 

1. Open the InLoox PM options and the notification templates area via the tree structure on the left 

(File >> InLoox PM options >> Notifications >> Templates). 

2. Select a template from the overview and click on Design, to open the notification designer. 

3. In the notification designer on the right, you will see the list of variables. Click on Variables, to see 

all available fields. 

  

The following fields are available to customize notification templates: 

Field name Description Content 

DisplayName Display 

name 

Name of tasks, planning elements, documents and project 

notes. 

Description Description Multiple-line description of planning elements. 
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Field name Description Content 

EndDate End 

planning 

element 

End date of the planning element. 

Flag Flag Highlighting for planning elements (none, green, yellow, 

red). 

GroupName Group Indicates the group of the planning element. The group can 

be a sort criterion or project cost center.  

IsProjectEndDateFixed Fixed 

deadline 

project 

Specifies whether the project has a fixed completion 

deadline. 

Link Linked 

documents 

Document paths (text-only) of the planning item. 

Location Location Free text field. States where the planning element is to be 

carried out. 

PlannerName Name of 

planner 

The name of the project planner, as stored in Outlook, e.g. 

Rita Meyer. 

Progress % 

completed 

Completion degree of a planning element in percent. 

Numeric value between 0 and 100. 

ProjectCategory Project 

category 

Category to which the project belongs. 

ProjectCompany Project 

company 

Free text field of the customer's name in the project. 

ProjectEnd Project end End date of the project. 

ProjectName Projekt 

Name 

Short, free description of the project. The project name can 

be used several times. 

ProjectNote Project 

name 

Multiple-line text for important project information.  
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Field name Description Content 

ProjectNumber Project 

number 

Unique number to identify the project. 

ProjectPriority Project 

priority 

Priority of the project. 

ProjectStart Projekt 

Start 

Start of the respective project. 

Projectstate Project 

status 

Specifies the state of project development 

PSPCode PSP code PSP code = Work Breakdown Structure code. Free text field 

for identification of phases and milestones in large 

projects. 

ResourceName Name of 

resource 

The name of the resource or recipient of the message, as 

stored in Outlook, e.g. Max Schiller. 

ResourceList Resources List of all involved resources of a planning element, 

including email address 

StartDate Start 

planning 

element 

Start date of the planning element. 

WorkAmount Work 

amount 

Work amount, which is done by the recipient resource of 

the planning element. 

 

 

Work offline with InLoox for Outlook 
Important This feature requires an InLoox PM Enterprise Server or an InLoox now! account.  

Starting with InLoox 10, you can easily access your project data offline. As soon as InLoox reconnects 

to the database (InLoox PM Enterprise Server) or the cloud (InLoox now!), the data is automatically 

synchronized. Whether the data of the InLoox PM Server respectively the InLoox now data cloud or 

the data of the client are prioritized in case of processing conflicts can be set in the InLoox options for 

all users. Read here how to proceed. 

Not the entire database is cached locally on the user's device, but only the data for which the user is 

authorized is stored. For example: There are 100 projects, but you only have read and edit 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/customization/work-offline-with-inloox-for-outlook/#Anchor:conflictresolution
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permissions for 20 projects. Then only the data of these 20 projects will be cached for working offline 

and then again synchronized when you are online again. 

For InLoox PM users: 

InLoox does not directly fetch or write data from/to the SQL database during the synchronization. The 

Outlook client communicates with InLoox Web App. Web App only needs to be installed, you do not 

need to have any Web User or Universal User licenses. The only requirement is that you have an 

InLoox PM Enterprise Server and install the Web App server.  

How to enable offline availability 

1. Click in Outlook on File 

2. Click on InLoox PM or InLoox now 

3. Under Tools for working with InLoox PM/now, click on Work Offline 

 

4. Offline availability is being prepared. This process can take a few minutes, depending on how 

much data InLoox has to synchronize. 

 

5. To follow the synchronization process, double-click on  in the Windows toolbar to open 

the synchronization window. 
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6. Once all entries have been synchronized, you can click on Complete.  

Tip To check whether offline availability is activated, click on File -> InLoox PM/now. If the feature is 

active, available offline appears next to the account name under Account information. 

 

 

When offline availability is enabled: Check settings for default document storage 

When offline availability is enabled, the download and upload of documents is automatically guided 

via the web server. If you want to continue to access documents as usual, you need to activate the 

following setting in the InLoox options: 

1. Click on File and select InLoox options.  

2. A new window opens: Click on Documents on the left side.  

3. Activate the second checkbox "Enable direct filestore access in offline mode and for the web 

application server". 

4. Click on Apply and OK to save the setting.  
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Conflict resolutions settings 

NOTICE You specify these settings in the InLoox options. For this you need administrator permissions. 

By default, client-side changes are preferred for resolving editing conflicts during the synchronization 

of the same online and offline data entries. You can change this default setting in the InLoox options 

under General >> Resolve Conflicts. 
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Server wins: Select this setting if the data available on your InLoox PM Server or in InLoox now! cloud 

should be prioritized. If changes to the same data row are detected during synchronization, the data 

from the client is NOT transferred to the database or cloud. (Existing online data wins) 

Client wins: Select this setting if, in the event of a processing conflict of the same data row, the 

changes from the client are to be adopted during synchronization in the database or cloud. (New 

offline data wins) 

Client wins (exception: Server wins in conflicts with resource allocation for tasks): In this case all 

data of the client will be accepted, except those in the data row "resource" in tasks. This means that 

the resource assignment of tasks cannot be changed by the client, but the status of the task and 

other data can. (New offline data wins, except changes to the resource allocation of tasks) 

Display event log 

If errors occur during synchronization, they are displayed in an InLoox notification window. If you click 

on it, the event log opens and displays these errors. In this case, please contact your administrator or 

IT manager to ensure that a connection to the InLoox PM Server or InLoox now! cloud can be 

established.  

 

Dashboard view 

Adjust the dashboard view 
The dashboard view shows you the main project areas. You can get all important information to the 

current projects without opening one and compose your own dashboard view from the different 

widgets. 

1. To open the dashboard view, do one of the following. 

• Click InLoox PM tab on the Outlook Ribbon and then Dashboard, in the Views group. 

 In Outlook 2007, click InLoox PM Folder in the InLoox PM Toolbar and then Dashboard in the 

InLoox PM project list. 

• Click Dashboard in the tree structure on the left. 

 

2. On the Start tab, perform one or more of the following actions: 

• Create a personal dashboard view 

On the InLoox PM Ribbon, in the Start tab, in the Current View group, click Widgets. 

• Edit an existing dashboard view 

Select one view from the tree structure on the left and click Edit dashboard, in 

the Actions group. 
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• Remove anexisting dashboard view 

Select one view from the tree structure on the left and click Delete dashboard, in 

the Actions group. 

• Print a dashboard view 

Select one view from the tree structure on the left and click Print, in the Current 

View group. 

 For more information about printing, see General features and print of the project list, in 

the Print in the project list area. 

• Refresh 

All changes are updated and the view is reloaded when clicking the Refresh button in 

the Current View group. 

 

Information rules in the dashboard view 

In the dashboard view on the side panel you can filter the project information by clicking on certain 

project from the list. 

 

Symbols in the dashboard view 

  Clear filter. 

  Dashboard parameter. 

  More information about parameters you can find under Using von dashboard parameters. 

  Export feature. The view will be exported as PDF or image 

 

Dashboard standard views 
The InLoox PM dashboard provides you with the standard views about all relevant and project-related 

information to analyze, control and compare your projects. You have always all key data, 

developments and target values at a glance - up-to-date and clearly designed. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/using-dashboard-parameters/
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Create your personal dashboard with an individual selection of  widgets. The dashboard provides you 

with a graphical overview and lists. 

 Create your personal dashboard. For more information, see Create new dashboard. 

In this table you find the descriptions of the standard views to monitor the project information. 

Widgets Description 

Expenses/revenues Shows the system-wide all planned expenses and revenues compared with 

the actual values. The dashboard provides you with different time views - 

month, quartet and year. 

Percent complete This dashboard displays the comparison between the planned and actual 

percent complete. 

The planned percent complete is defined as (the sum of the work effort all 

work packages in the planning (work packages< today)) / (the sum of work 

effort all work packages in the planning). 

The actual percent complete is defined as (the sum of the work effort all 

done work packages) / (the sum of the work effort all work packages) 

Milestone trend 

analysis 

Represents the analysis of the dates in a project and compares them with 

the planned data. The dashboard visualizes the date delay of the milestone 

in the project. With this view you can quickly see the deviations from the 

planned schedule. 

Project status 

overview 

Shows an overview of the progress and the cost-effectiveness of your 

projects. 
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Widgets Description 

Plan/actual 

comparison 

Shows planned and actual hours of your projects. 

 

Create a new dashboard 
To open the dashboard view, do one of the following. 

1. Click InLoox PM tab on the Outlook Ribbon and then Dashboard, in the Views group. 

 In Outlook 2007, click InLoox PM Folder in the InLoox PM Toolbar and then Dashboard in the 

InLoox PM project list. 

2. Click Dashboard in the tree structure on the left. 

3. In InLoox PM ribbon, on the Start tab, in the Actions group, click New Dashboard. 

4. In the New Dashboard dialog box enter a name. 

 

5. Activate the check box, if you want to make your dashboard visible for all users. 

6. This will invoke the Dashboard Designer dialog box. 

 For more information about it, see Designing dashboard. 

7. Wenn the new dashboard is ready, click Save and Close in the Dashboard Designer, on 

the Home tab. 

The new view is displayed in the Dashboard tree view on the left. 
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Designing dashboards 
This section guides you through the process of creating a dashboard. 

To open the Dashboard Designer, click New Dashboard or Edit dashboard on the Start tab. 

The following topics are available: 

Getting started 
 this lesson, you will learn how to create your dashboard using the Dashboard Designer. 

1. First, open the Dashboard Designer. 

The first steps into creating a dashboard and opening a Dashboard Designer you will find in the 

topic Create a new dashboard. 

 The dashboard designer should appear as follows: 
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2. You can use InLoox PM Database or connect to another one. 

• The InLoox PM data source is on the left site panel of the window. You can choose 

between different data sources as Project, Work Packages, Planning, Time 

Tracking, Budget and Budget Position from the drop-down list. 

• Learn how to create a new data source, see Creating a data source. 

3. Create Dashboard Items and Bind them to Data. 

Learn by example how to create a Comparison of budget types dashboard view. 

• The description of the dashboard items you can find here Creating dashboard items. 

• To learn how to bind required data, see Binding dashboard items to data. 

3. Click the wanted dashboard item on the Ribbon, e.g. Chart. 

4. Select Budget in the InLoox PM Data Source Browser 

5. Drag the Amount field to the Values placeholder in the Values section. 

 

6. Then place the Name and Number fields (for projects) in the Arguments section. 

7. After drag the Name field (for budget types) in the Series section. 

Click Save and Close on the Ribbon.  The dashboard view Comparison of budget types is now ready. 

 

Creating a data source 
The Create data source wizard allows you to create a new data source by specifying the required 

connection parameters (for instance, the server name, the database name, user credentials, the path 

to a data file, etc.). 
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Creating a data source and connecting to data 

You can connect to various types of databases and data files using the Create Data Source wizard. 

This wizard allows you to establish a connection to the data store by providing the required 

connection parameters. 

 InLoox PM provides you with its own project data sources on the side panel left in the 

dashboard designer. 

Create Data Source Wizard 

1. Data Source Name On the first page, enter the data source name and click Next. 

 

2. New or Existing Data Connection  On this page, specify whether to use one of the existing 

connections or create a new connection, and click Next. 

 This page only appears if you have already established a data connection in the current 

application. 

3. Connection Parameters  If the application has not yet been connected to a database, or you 

have chosen to create a new connection in the previous step, the connection parameters 

page will be displayed. 

1. First, select the required data provider from the Provider combo box. The Data 

Access library supports more than a dozen different data providers, including MS SQL 

Server, MS Access Database, Oracle and MySQL. 

2. The other settings on this page depend on which data provider is used. Typically, you 

will need to specify the server name or the path to the database file, the user 

credentials, and the database name. 

3. Finally, specify the name of the new connection in the Connection name field and 

click Next. 

4. Finish  On the last page, you can select a table or a view. The data from the selected table or 

view will be used in your application. 
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1. Click Finish to close the wizard. Optionally, you can run the Query Designer, which 

will help you populate the new data source with data. To do this, check the Open 

Query Designer after closing the wizard check box before finishing. 

 

Creating a data source in OLAP mode 

To bind to an OLAP cube in a Microsoft SQL Server Analysis Services database, do the following. 

1. On the first page, enter the data source name and click Next. 

2. On the next page, select Microsoft SQL Server Analysis Services from the Provider combo 

box. 

1. Specify the server name and user credentials, and select the catalog and cube name. 

2. Next, specify the name of the new connection in the Connection name field and 

click Next. 

3. On the last page, click Finish. 

 

Composing a data source 

InLoox PM Dashboard provides the Windows Forms control that can solely constitute a 

comprehensive designer application. 

The Dashboard Designer provides an easy-to-use wizard that helps you configure a connection to the 

database. 

 

After the connection has been established, use the Query Designer to select data that will be used in 

the dashboard. 

 

Designing dashboard items 
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1. To populate the dashboard with charts, pies, gauges and other elements, just click the 

desired data items in the Ribbon. 

 

2. Drag-and-drop data that you wish to display within each item into a Data items area. 

3. Now the dashboard is ready. 

 Learn more about dashboard items. See Creating dashboard items. 

 

Providing data 
The topics in this section describe how to provide the data to be visualized in the dashboard. 

This section contains the following topics. 

Data source filtering 

Apply filtering 

To apply filtering to a data source, click the Filter button in the Data Source tab.  

This will invoke the Filter Editor dialog, which allows you to build filter criteria. 

 

 To learn how to work with the Filter Editor, see the section Filter data via the filter editor in 

the Search and find in projects topic, in Use filters section. 

To clear the data source filter, use the Clear Filter button in the Data Source tab. 

 

Passing Parameter Values 

You can use the Filter Editor to filter a data source according to the current parameter value. 

 To learn more, see the Passing Parameter Values topic. 
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Filtering Limitations 

The limitations of a data source filter are as follows. 

• Fitering cannot be applied to a data source created in SQL View. You need to include the 

required conditions to the WHERE clause when editing a data source. 

• OLAP data sources do not support filtering. 

 

Calculated fields 

This document describes how to add calculated fields to a dashboard data source. Calculated fields 

allow you to apply complex expressions to data fields that are obtained from the dashboard's data 

source. 

Creating a calculated field 

After you have created a data source using the Create data source wizard, you can add a new 

calculated field based on the existing data source fields. 

1. To create a calculated field, select the required data source in the Data Source Browser and 

click the Add Calculated Field button in the Ribbon's Data Source tab. 

 Or right-click the Data Source Browser area and select Add Calculated Field in the context 

menu. 

 

 This invokes the Expression Editor dialog, which allows you to specify an expression that will be used 

to obtain calculated field values. Here you can construct the required expression. 

2. After the expression has been specified, click OK. This displays a new calculated field in the 

data source structure. 

3. Now you can specify the required calculated field type, change its default name, etc. 

 

Editing a calculated field 

To edit a calculated field, use its context menu. 

This menu contains the following items. 

Item Description 

Edit 

Expression 

Invokes the Expression Editor dialog, which allows you to change an expression for 

an existing calculated field. 
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Field Type Specifies the type of the calculated field. 

Rename Changes the calculated field name. 

Delete Removes the existing calculated field from the data source. 

 

Using dashboard parameters 
You can use dashboard parameters when it is necessary to pass data of a certain type to a dashboard 

(e.g., to pass a specific value to the data source filter string or a calculated field). 

The topics in this section describe how to use dashboard parameters. 

Creating parameters 

This topic explains how to create a new dashboard parameter and specify its settings. 

To create dashboard parameters in the Dashboard Designer, do the following. 

1. Click the Parameters button on the Ribbon's Data Source tab. 

2. In the invoked dialog, click the Add button to add a new parameter. 

3. Specify the following settings: 

Settings Description API 

Name Specifies a parameter name. Parameter.Name 

Value Specifies a parameter value. Parameter.Value 

Type Specifies the parameter's type. Parameter.Type 

LookUpSettings Specifies the parameter’s look-up editor 

settings. 

DashboardParameter.LookUpSettings 

Description Specifies the parameter's description 

displayed to an end-user. 

DashboardParameter.Description 

Visible Specifies whether a parameter's editor 

is visible within the Dashboard 

Parameters dialog. 

DashboardParameter.Visible 

Then, click OK, to include the created parameters in the dashboard. 

 

Look-up editor settings 
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There are three types of look-up editor settings that can be specified for a parameter. Select the 

required type from the LookUpSettings drop-down list. 

• No Look-Up - set the Value to use a static value as a parameter. 

• Static List - click the ellipsis button to add static values for the current dashboard 

parameter. In this case, the Value specifies the default parameter's value. 

• Dynamic List - allows you to use a list of values from the existing data source as a parameter. 

You need to select the required DataSource from the list of available data sources and data 

members for the dashboard parameter's display name and value, respectively. 

In this case, the Value specifies the default parameter's value. 

 

Passing parameter values 

In this topic, you will learn how to pass parameter values to a dashboard. 

Filtering 

You can filter a data source or apply filtering to a specific dashboard item according to the current 

parameter value using the Filter Editor. 

 For more information about filter, see Filter data via the filter editor section in the Search and 

find in projects topic. 

In the Filter Editor, you can compare a field value with the following objects. 

• A static value (represented by the  icon). Click this button to switch to the next item mode 

("another field value"), to compare the field value with another field value. 

• Another field value (represented by the  icon). Click this button to switch to the next item 

mode (“parameter value”), to compare the field value with a parameter value. 

• A parameter value (represented by the  icon). Click this button to switch back to the initial 

mode ("static value"), to compare the field value with a static value. 

Thus, to compare a field value with a parameter value, click the  button, then click the  button. 

 

Calculated Fields 

You can use parameters when constructing expressions for calculated fields. A parameter is inserted 

into the expression using the “Parameters.” prefix. 

To see a list of available parameters, click Parameters in the Expression Editor dialog. 

 

Custom SQL Queries 

You can include parameters in a data source custom SQL query in the Query Designer. To do this, use 

the parameter name. For instance, you can include a parameter to a WHERE clause or to a stored 

procedure. 

 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/providing-data/calculated-fields/
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Providing a user interface for requesting parameter values 

The dashboard provides a built-in Dashboard Parameters dialog, which provides the capability to 

change dashboard parameter values. This dialog is created automatically, depending on the 

parameter type and visibility settings. 

1. To invoke the Dashboard Parameters dialog in the DashboardViewer, click 

the Parameters  button in the dashboard title. Depending on the dashboard parameters 

enabled, this invokes the following dialog. 

 This will invoke the following Dashboard Parameters dialog. 

 

2. Select the required parameter values in the Dashboard Parameters dialog and click 

the Submit button to apply the changes. 

3. To reset changes to the default values, click the Reset button. 

 

Creating dashboard items 
Dashboard items represent elements from the Ribbon used to visualize data within the Dashboard in 

various ways. 

Adding dashboard items 

To create a dashboard item in the Dashboard Designer, click the corresponding button in the Ribbon. 

 

This creates an empty dashboard item and displays required data sections to bind this item to data. 

 To learn how to bind required data, see Binding dashboard items to data. 

 

This section describes the available dashboard items: 
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Pivot 

The Pivot dashboard item displays a cross-tabular report that presents multi-dimensional data in an 

easy-to-read format. 

Data sections in the pivot 

 

Values  the section contains data items used to calculate values displayed in the pivot table. 

Columns  the section contains data items whose values are used to label columns. 

Rows  the  section contains data items whose values are used to label rows. 

 

Layout 

If the Columns section or Rows section contains several data items, the pivot table column and row 

headers are arranged in a hierarchy, and make up column and row groups. 

Use the Initial State button in the Data tab to open or close the groups.  

This button invokes the popup menu that allows you to select whether column and row groups 

should be collapsed or expanded by default in a Dashboard Viewer. 

 

Grid 

This section describes the features available in the Grid dashboard item, and provides extensive 

information about data items and how to customize grids. 

Data sections in the grid 
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The grid has Columns and Sparkline data sections, which are used to provide data items based on the 

columns that are created.  

Sparkline column  visualizes the variation of summary values over time. 

 

Layout 

The Grid dashboard item allows you to introduce cell merging and banded rows, and specify the 

visibility of column headers and grid lines. 

To do this, use the Design Ribbon tab. 

 

The Horizontal Lines and Vertical Lines buttons control grid line visibility. Use the Column 

Headers button to toggle column header visibility. 

You can also enable the Grid to merge adjacent cells with identical data. To do this, use the Merge 

Cells button. 

To paint the background of odd and even rows differently, use the Banded Rows button. 

 Note that banded rows are not available when cell merging is enabled. 

 

Master filtering 

The Grid dashboard item supports filtering by rows. When Master Filtering is enabled, an end-user 

can click a grid row (or multiple rows by holding down the CTRL key) to make other dashboard items 

only display data related to the selected record(s). 

 To learn how to enable Master Filtering in the Designer, see Master filtering. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/interactivity/master-filtering/
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Drill-Down 

The built-in drill-down capability allows end-users to change the detail level of data displayed in 

dashboard items on the fly.  

 To learn more, see Drill-Down. 

The Grid dashboard item supports drill-down for rows. When drill-down is enabled, an end-user can 

click a grid row to view the details. 

Drill-down requires that the Columns section contains several dimensions at the top, from the least 

detailed to the most detailed dimension. 

 In OLAP mode, you can perform drill-down for either a hierarchy data item or several 

dimension attributes. 

 

Chart 

Data sections in the chart 

 

Values  the section contains data items against which the Y-coordinates of data points are calculated. 

Arguments  the section contains data items that provide values displayed along the X-axis of the 

chart. 

Series  the section contains data items whose values are used to create chart series. 

 

Layout 

This section describes the features available in the Chart dashboard item, and provide extensive 

information on how to customize charts. 

All buttons are displayed on the Design tab. 

 

• You can rotate the Chart so that the X-axis becomes vertical, and the Y-axis becomes 

horizontal. Use he Rotate button in the Diagram group. 
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• The Chart dashboard item displays two axes by default: the X-axis and the Y-axis. The X-axis is 

the axis of arguments. The Y-axis is the numerical axis of values. 

• Click X-Axis Settings to invoke the X-Axis Settings dialog. The setting Show X-

axis allows you to hide and show the X-axis. The setting Show title allows you to hide 

and show the X-axis title. You can choose whether to use the default text or specify a 

custom string. 

• If the dimension in the Arguments section contains numeric data, the Chart can 

create either a continuous X-axis or a discrete X-axis. Specify the needed type in the 

contaxt menu for the argument on the Data Item pane. 

• Click Y-Axis Settings to invoke the Y-Axis Settings dialog. The dialog contains the 

following settings: 

• Show grid lines  Allows you to hide and show grid lines for the Y-axis. 

• Show Y-axis  Allows you to hide and show the Y-axis. 

• Always show zero level  Specifies whether or not the axis' zero level is 

visible. If this option is unchecked, the visible axis range is defined based on 

the values plotted in the chart.  

• Show title  Allows you to hide and show the Y-axis title. You can choose 

whether to use the default text or specify a custom string. 

• A Legend is an element of a chart that identifies its series. You can specify whether or not a 

chart should display a legend. In the Designer, use the Show Legend button in 

the Legend group. 

• To specify the legend’s position and orientation, select one of the predefined options 

from the gallery in the Design Ribbon tab. 

• The Chart dashboard item supports different types of series - from simple bar and line charts 

to candle stick and bubble graphs. To switch between series types in the Designer do one of 

the following 

• Click an options button near a required data item (or a placeholder) in 

the Values section. In the invoked Series Type dialog, select a required series type 

and click OK. 

• Use the Series Type gallery in the Design Ribbon tab. 

 

Master Filtering 

Dashboard allows you to use any data-aware dashboard item as a filter for the entire dashboard 

(Master Filter). 

 To learn more, see the Master filtering topic that describes filtering concepts common to all 

dashboard items. 

The Chart dashboard item supports filtering by argument or series values. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/interactivity/master-filtering/
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• When filtering by arguments is enabled, an end-user can click series points to make other 

dashboard items display only data related to selected argument values. Click 

the Arguments button in the Data Ribbon tab. 

• When filtering by series is enabled, an end-user can click a series point to make other 

dashboard items display only data related to the selected series. Click the Series button in 

the Data Ribbon tab. 

 

Drill-Down 

The built-in drill-down capability allows end-users to change the detail level of data displayed in 

dashboard items on the fly. To learn more, see Drill-Down. 

The Chart dashboard item supports drill-down on argument or series values. 

• When drill-down on arguments is enabled, an end-user can click a series point to view a 

detail chart for the corresponding argument value. Drill-down on arguments requires that the 

Arguments section contains several data items, from the least detailed to the most detailed 

item. Click Arguments  in the Data Ribbon tab. 

• When drill-down on series is enabled, an end-user can click a series point (or corresponding 

legend item) to view a detail chart for the corresponding series. Drill-down on series requires 

that the Series section contains several data items, from the least detailed to the most 

detailed item. Click Series in the Data Ribbon tab. 

 

Pies 

Data sections in the pies 

 

Values  the section contains data items that define the share of pie segments. 

Arguments  the section contains data items that provide values used to label pie segments. 

Series  the section contains data items whose values are used to label pie charts. 

 

Layout 

All buttons for customizing the dashboard item Pies are on the Design tab. 

https://documentation.devexpress.com/Dashboard/CustomDocument15703.aspx
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• To control how pies are arranged, use the Content Arrangement group in the Design Ribbon 

tab. 

• By default, the Auto Arrange option is enabled, which automatically resizes pies to fit 

within the dashboard item. 

• You can also specify the number of columns in which pies are arranged. Click 

the Arrange in Columns button and specify the appropriate number in 

the Count field. 

• Similarly, you can arrange pies in a specific number of rows. 

• Pies display data labels that contain descriptions for pie segments, and provide tooltips with 

additional information. 

• You can specify which information should be displayed within data labels and 

tooltips. To do this, use the Data Labels and Tooltips buttons in the Design Ribbon 

tab. These buttons invoke the drop-down menu, which is similar for both buttons. 

This menu allows you to specify which values are displayed within data labels or 

tooltips. 

• Define the visibility of the pie caption via the Show Pie Captions button. 

• Select the diagram style, use the Pie and Donut buttons in the Style group of 

the Design Ribbon tab. 

 

Master Filtering 

Dashboard allows you to use any data-aware dashboard item as a filter for the entire dashboard 

(Master Filter). 

 To learn more, see the Master filtering topic that describes filtering concepts common to all 

dashboard items. 

The Pie dashboard item supports filtering by argument or series values. 

• When filtering by arguments is enabled, an end-user can click a pie segment to make other 

dashboard items display only data related to selected argument values. Click 

the Arguments button in the Data Ribbon tab. 

• When filtering by series is enabled, an end-user can click a pie to make other dashboard 

items display only data related to the selected pie. Click the Series button in the Data Ribbon 

tab. 

 

Drill-Down 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/interactivity/master-filtering/
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The built-in drill-down capability allows end-users to change the detail level of data displayed in 

dashboard items on the fly. To learn more, see Drill-Down. 

The Pie dashboard item supports drill-down on argument or series values. 

• When drill-down on arguments is enabled, an end-user can click a pie segment to view a 

detail chart for the corresponding argument value. Drill-down on arguments requires that the 

Arguments section contains several data items, from the least detailed to the most detailed 

item. Click Arguments  in the Data Ribbon tab. 

• When drill-down on series is enabled, an end-user can click a pie to view a detail chart for the 

corresponding series. Drill-down on series requires that the Series section contains several 

data items, from the least detailed to the most detailed item. Click Series in the Data Ribbon 

tab. 

 

Gauges 

Data sections in the gauges 

 

Gauges  the section contains data items used to calculate values displayed by gauges. 

Data items are arranged in containers. Each data item container can hold two data items. The first 

item contains actual data and the second item (optional) contains target data. If both items are 

provided, gauges show the difference between actual and target values. 

Series  the section contains data items whose values are used to label gauges. 

 

Layout 

All buttons for customizing are on the Design tab. 

 

• To control how gauges are arranged, use the Content Arrangement group in 

the Design Ribbon tab. 

• By default, the Auto Arrange option is enabled, which automatically resizes gauges to 

fit within the dashboard item. 

https://documentation.devexpress.com/Dashboard/CustomDocument15703.aspx
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• You can also specify the number of columns in which gauges are arranged. Click 

the Arrange in Columns button and specify the appropriate number in 

the Count field. 

• Similarly, you can arrange gauges in a specific number of rows. 

• The Gauge dashboard item allows you to select the gauge type: Full Circular, Half-

Circular, Left-Quarter Circular, Right-Quarter Circular, Three-Fourths Circular, Linear 

Horizontal and Linear Vertical. 

 

Cards 

Data sections in the cards 

 

Cards  the section contains data items used to calculate values displayed within cards. 

Data items are arranged in containers. Each data item container can hold two data items. The first 

item contains actual data and the second item (optional) contains target data. If both items are 

provided, cards show the difference between actual and target values. 

Series  the section contains data items whose values are used to label cards. 

Sparkline the section is used to provide a date-time dimension whose data will be used to visualize 

values using sparklines. 

 

Layout 

To control how cards are arranged, use the Content Arrangement group in the Design Ribbon tab. 

 

• By default, the Auto Arrange option is enabled, which automatically resizes cards to fit within 

the dashboard item. 



 79 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
• You can also specify the number of columns in which cards are arranged. Click the Arrange in 

Columns button and specify the appropriate number in the Count field. 

• Similarly, you can arrange cards in a specific number of rows. 

 

Choropleth map 

Data sections in the Choropleth Map 

 

Attribute  the data section contains the Attribute data item, which allows you to associate map 

shapes with data source field values. 

Maps  data section contains data items whose values are used to color map shapes. Map shape colors 

vary based on the map type. 

 

Layout 

Alle buttons for customizing the dashboard item are on the Design tab. 

 

A Legend is an element of a chart that identifies its series. You can specify whether or not a chart 

should display a legend. In the Designer, use the Show Legend button in the Legend group. 

To specify the legend’s position and orientation, select one of the predefined options from the gallery 

in the Design Ribbon tab. 

 

Providing maps 

Dashboard ships with a set of default maps showing various parts of the world. The following maps 

are included. 

• World Countries - a world map. 

• Europe - a map of Europe. 

• Asia - a map of Asia. 

• North America - a map of North America. 
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• South America - a map of South America. 

• Africa - a map of Africa. 

• USA - a map of the USA. 

• Canada - a map of Canada. 

As an alternative, use the corresponding command in the map context menu. 

Dashboard uses a Shapefile vector format to provide custom maps. Commonly, this format includes 

two file types. To open an existing shapefile, use the Load Map or Import Map button in the 

Ribbon. In the invoked dialog, locate the required .shp file. 

 

Map attributes 

After you select the default map or a custom map, you can view supplemental information (such as 

the name of the country, state, etc.). To do this, click the Options button next to the Attribute data 

item. 

In the invoked Map Attribute Binding dialog, click Preview. The table in the dialog displays the 

available attributes for the current map. Each set of attribute values is related to a specific map 

shape. 

 

Map coloring 

The Choropleth Map dashboard item colors map shapes depending on the provided values. 

The Choropleth Map automatically selects palette and scale settings to color map shapes. 

If you need to customize these settings, click the Options button next to the data item that contains 

these values. This invokes the Choropleth Map Options dialog. 

You can specify the following settings in this window. 

• Color palette - allows you to specify the start and end color of the palette. 

• Scale settings - specifies whether a percent scale or an absolute scale is used to define a set 

of colors. You can specify the number of levels that represent the number of colors used to 

color the map. 

• Preview is used to display a full set of palette colors generated based on the start/end colors 

and the number of levels. Use the Allow Edit check box to automatically change the 

generated colors or specify value ranges for each color. 

 

Delta 

The Choropleth Map allows you to indicate the difference between the actual and target values of a 

particular parameter. This difference is called delta. 

To specify delta indication settings, click the Options button next to the data item container. 



 81 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
This invokes the Choropleth Map Options dialog. When the map type is set to Delta, this dialog 

contains the following settings. 

• Value type  You can specify which values to display within map tooltips. Use the Value 

type combo box to select the value that will be displayed as the delta value. 

• Result Indication  You can specify the condition that will be used to select the indicator color. 

To do this, use the Result indication combo box. 

• Threshold type and Threshold value  You can specify that a required indicator should only be 

displayed when the difference between the actual and target values exceeds a specified 

value. 

 

Master Filtering 

Dashboard allows you to use any data-aware dashboard item as a filter for the entire dashboard 

(Master Filter). 

 To learn more, see the Master filtering topic that describes filtering concepts common to all 

dashboard items. 

When filtering is enabled, an end-user can click a shape (or multiple shapes by holding down 

the CTRL key) to make other dashboard items display only data related to selected shape(s).  

 

Geo point map 

Data sections in the Geo Point Map 

 

Latitude  the data section accepts geographic latitude points. 

Longitude  the data section accepts geographic longitude points. 

Value  the data section accepts values related to geographic points. 

 

Layout 

Alle buttons for customizing the dashboard item are on the Design tab. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/interactivity/master-filtering/
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Dashboard ships with a set of default maps showing various parts of the world. The following maps 

are included. 

• World Countries - a world map. 

• Europe - a map of Europe. 

• Asia - a map of Asia. 

• North America - a map of North America. 

• South America - a map of South America. 

• Africa - a map of Africa. 

• USA - a map of the USA. 

• Canada - a map of Canada. 

Dashboard uses a Shapefile vector format to provide custom maps. Commonly, this format includes 

two file types. To open an existing shapefile, use the Load Map or Import Map button in the 

Ribbon. In the invoked dialog, locate the required .shp file. 

 

Master Filtering 

Dashboard allows you to use any data-aware dashboard item as a filter for the entire dashboard 

(Master Filter). 

 To learn more, see the Master filtering topic that describes filtering concepts common to all 

dashboard items. 

When filtering is enabled, an end-user can click a callout (or multiple a callouts by holding down 

the CTRL key) to make other dashboard items display only data related to selected a callout(s).  

 

Range filter 

The Range Filter dashboard item allows you to apply filtering to other dashboard items. This item 

displays a chart with selection thumbs that allow you to filter out values displayed along the 

argument axis. 

Data sections in the Range Filter 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/interactivity/master-filtering/
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Values  the section contains data items against which the Y-coordinates of data points are calculated. 

Arguments  the section contains data items that provide values displayed along the horizontal axis of 

the Range Filter. Filtering is performed based on these values. 

Series  the section contains data items whose values are used to create chart series. 

 

Layout 

The Range Filter dashboard item supports various Line and Area series types. 

 

To switch between series types in the Designer do one of the following. 

• Use the Series Type group in the Design Ribbon tab. 

• Click the options button next to the required data item in the Values section. In the 

invoked Series Type dialog, select the required series type and click OK. 

The Range Filter supports the following series types: Line, Stacked Line, Full-Stacked 

Line, Area, Stacked Area and Full-Stacked Area. 

 

Image 

Use the Image dashboard item to add static images to a dashboard. 

 

Loading an image 

To load an image into a dashboard item, use the Load Image and Import Image buttons in the 

Ribbon. or commands in the context menu (Load Image... and Import Image..., respectively). 
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These commands invoke the Open dialog, which allows you to locate the desired image. 

The Load Image command saves the path to the image in the dashboard definition, while the Import 

Image command saves the image itself. 

Image alignment 

To specify how the image is aligned within the dashboard item, use the Alignment group in the 

Ribbon's Design tab. 

 

 

Image size mode 

You can specify the image size mode that defines how the image fits within the dashboard item. 

To do this, use the Size Mode group in the Ribbon's Design tab. 

 

The following table illustrates each size mode in two cases: when the image is smaller than the 

dashboard item, and vice versa. 

Clip The image is clipped if it is larger than the image dashboard item. 

Stretch The image within the image dashboard item is stretched or shrunk to fit the size of 

the image dashboard item. 

Squeeze If the dimensions of the image dashboard item exceed those of the image it contains, 

the image is shown full-size. Otherwise, the image is resized to fit the dimensions of 

the image dashboard item. 
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Zoom The image is sized proportionally (without clipping), so that it best fits the image 

dashboard item. If the aspect ratio of the image dashboard item is the same as the 

aspect ratio of the image, it will be resized to fit into the image dashboard item while 

maintaining its aspect ratio. Otherwise, the closest fitting side of the image (either the 

height or the width) will be sized to fit the dashboard item, and the remaining side 

(height or width) will be sized proportionally (leaving empty space). 

 

Text box 

Use the Text Box dashboard item to display rich text within a dashboard. 

Editing text 

 

To edit text within the text box, click the Edit button in the Ribbon's Design tab, the corresponding 

item in the context menu, or double-click the Text Box dashboard item. 

dashboard item to display rich text within a dashboard. 

This invokes the Edit Text window in which you can edit the text content and customize its formatting. 

 InLoox PM provides you with a range of formatting features. For the detailed description, 

see Create and change comments in the Customize comments section. 

 

Binding dashboard items to data 
Dashboard items must be bound to data source fields to display data. 

Each kind of dashboard item has a specific set of data sections such 

as Values, Arguments and Series in the chart, Columns in the grid, and Values, Columns and Rows in 

the pivot grid. Each data section corresponds to a particular dashboard item area or element, and 

should be mapped to data to be displayed within this area/element. 

Mapping is performed using special objects called data items. A data item identifies data binding. 

When created, a data item is mapped to a data source field, and is then assigned to a specific 

dashboard item's data section. As a result, the dashboard item is bound to the data source field. 

 Learn more about data items in the data sections, see Creating dashboard items. 

This section consists of the following topics. 

Binding dashboard items to data in the designer 

To bind dashboard items to data in the Dashboard Designer, use the Data Items pane. 
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This pane displays data sections of the selected dashboard item and can be used to add, rearrange 

and remove data items. 

Specific data sections display options buttons for each data item. Use these buttons to invoke a 

dialog that allows you to customize the settings of this data item. 

 

To bind a dashboard item to data, select the dashboard item. Then choose the required data member 

from the Data Source Browser and drop it onto the appropriate section in the DATA ITEMS pane. 
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Hidden data items 

The Hidden data items area was designed to perform data shaping operations by measures or 

dimensions that do not directly take part in the visual representation of data. 

 

The Dimension class represents a data item whose values are not intended to be summarized. The 

dashboard would not summarize the dimension values but process each one individually.This means 

that dimension values are eligible for sorting or grouping.  

The Measure class represents a data item whose values are summarized before they are used in the 

dashboard. The dashboard will calculate an appropriate summary function against measure values. 

For instance, measures are used to provide data for the chart's Y-axis. 

Assume that you have a dashboard containing a chart that shows the planned resource costs in a 

company by department. 

Now imagine that you need to sort departments by the team members. To do this, you will need to 

add the First team member measure to the Chart so that its data is not displayed, but only used for 

sorting. 

Drag-and-drop the First team member data field onto the Measures section in the Hidden data 

items area. This will create the First team member (Count) measure, which will be available in 

the Sort by menu. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/dashboard-view/designing-dashboards/binding-dashboard-items-to-data/hidden-data-items/
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Note that the Hidden data items area is divided into two sections: Dimensions and Measures. 

 

• Hidden dimensions appear in the Filter Editor dialog, allowing you to create filter 

criteria based on their values. For more information see Filtering. 

• Hidden measures appear in the Sort by submenu (to sort dimension values by them), and in 

the Top N Values dialog (to use them in Top N conditions). 

 

Binding dashboard items to data in OLAP mode 

In OLAP mode, the cube schema is fetched automatically, and the Data Source Browser displays the 

entire OLAP cube structure. 

To visualize data, drag-and-drop measures, attributes or hierarchies to the appropriate data sections 

in the DATA ITEMS area, as described in the Binding dashboard items to data in the designer topic. 

Note that OLAP measures can only be placed in the Values section, while dimension attributes and 

hierarchies can be placed within other data sections. 

OLAP hierarchies allow you to customize each of their levels separately. To access hierarchy level 

options, invoke the data item menu for the hierarchy and then use the submenu that corresponds to 

the desired level. 

 To learn about the limitations of binding to an OLAP cube, see the Providing data in the 

dashboard designer topic. 

 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/data-shaping/filtering/
https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/data-shaping/sorting/
https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/dashboard-views-inloox-9-for-outlook/design-dashboards-inloox-9-for-outlook/data-shaping/top-n/
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Data shaping 
This section describes how to perform various data shaping operations (such as grouping, sorting and 

filtering) in the Dashboard Designer. 

The section contains the following topics. 

Summarization 

To obtain numeric values that should be displayed within a dashboard item, Dashboard calculates a 

summary function against the specified measure. 

This topic describes how to specify which summary function should be calculated against a particular 

measure. 

Summary function types 

The following summary functions are available. 

Count The number of values (excluding Null and DBNull values). 

This is the only summary type that can be calculated against non-numeric data. 

Sum The sum of the values. 

 

Min The smallest value. 

Max The largest value. 

Average The average of the values. 

 

StdDev An estimate of the standard deviation of a population, where the sample is a subset of 

the entire population. 

 

StdDevP The standard deviation of a population, where the population is the entire data to be 

summarized. 
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Var An estimate of the variance of a population, where the sample is a subset of the entire 

population. 

 

VarP The variance of a population, where the population is the entire data to be 

summarized. 

 

Changing summary type 

By default, Dashboard calculates Sum for numeric measures and Count for measures that contain 

another type of data. 

You can change the summary function type for numeric measures. To do this in the Designer, invoke 

the data item menu and select the desired summary type. Less common summary types are 

organized in the More submenu. 

 

 

Grouping 

Dashboard allows you to group dimension values and display summaries for entire groups rather than 

individual values. 

You can arrange dimension values in groups of different sizes by specifying the appropriate group 

interval. For instance, date-time values can be grouped by years, months, quarters, etc. 

This topic lists the supported text and date-time group intervals, and describes how to change the 

group interval. 

The following sections are available. 

 

Text group intervals 

String values support the following grouping intervals. 
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No grouping Each value is displayed "as is". 

Alphabetical Values are grouped alphabetically. Example: A, B, C, ... Z 

 

Date-time group intervals 

Date-time values support the following group intervals. 

Year Values are grouped by the year. Example: 2012, 2013, 2014 

Quarter Values are grouped by the quarter. Example: Q1, Q2, Q3, Q4 

Month Values are grouped by the month. Example: January, February, March, ... 

December 

Day Values are grouped by the day of the month. Example: 1, 2, 3, ... 31 

Hour Values are grouped by the hour. Example: 0, 1, 2, ... 23 

Minute Values are grouped by the minute. Example: 0, 1, 2, ... 59 

Second Values are grouped by the second. Example: 0, 1, 2, ... 59 

Day of the 

Year 

Values are grouped by the day of the year. Example: 1, 2, 3, ... 365 (366 in a leap 

year) 

Day of the 

Week 

Values are grouped by the day of the week. Example: Sunday, Monday, Tuesday, ... 

Saturday 

Week of the 

Month 

Values are grouped by the week of the month. Example: 1, 2, 3, 4, 5 

Month-Year Values are grouped by the year and month. Example: January 2012, February 

2012, ... December 2012, January 2013, ... 

Quarter-Year Values are grouped by the year and quarter. 

Example: Q3 2013, Q4 2013, Q1 2014, Q2 2014, ... 
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Day-Month-

Year 

Values are grouped by date. Example: 3/4/2014, 3/5/2014, 3/6/2014, ... 

Date-Hour Values are grouped by date with the hour value. Example: 3/4/2014 0:00 AM, 

3/4/2014 1:00 AM, 3/4/2014 2:00 AM, ... 

Date-Hour-

Minute 

Values are grouped by date with the hour and minute values. Example: 3/4/2014 

0:00 AM, 3/4/2014 0:01 AM, 3/4/2014 0:02 AM, ... 

Date-Hour-

Minute-

Second 

Values are grouped by date with the hour, minute and second values. 

Example: 3/4/2014 0:00:00 AM, 3/4/2014 0:00:01 AM, 3/4/2014 0:00:02 AM, ... 

 

Changing group interval 

To specify the group interval in the Designer, invoke the data item menu and select the desired group 

interval. Less common group intervals are organized in the More submenus. 

 

 

Sorting 

The Dashboard allows you to easily change the sort order of values within a dashboard item. You can 

also enable sorting by parameter values. 

Changing Sort Order 

The sort order of dimension values is indicated with an arrow. 

 

To change the sort order in the Designer, click the data item. You can also toggle sorting from the data 

item menu. 
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Sorting by Parameter Values 

Dashboard allows you to sort dimension values by a specific parameter represented by a measure. 

To enable sorting by measure in the Designer, use the Sort by submenu in the dimension's menu. 

 You can also sort dimension values by values of hidden measures, see Hidden data items. 

 

Filtering 

Dashboard allows you to apply filtering to each individual data-aware dashboard item. 

This topic describes how to enable and reset filtering. 

 

Apply filtering 

To configure filtering in the Designer, select the target dashboard item and do one of the following. 

• Click the Edit Filter button in the Data tab. 

• Right-click on a dashboard item and select Edit Filter from its context menu. 

This will invoke the Filter Editor dialog. Use this dialog to build filter criteria with a convenient tree-

like interface. 
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• You can use hidden dimensions within the Filter Editor dialog, allowing you to filter data 

based on their values. For more information see Hidden data items. 

• To learn how to work with the Filter Editor, see Search and find projects, in the Use filters 

section. 

 

Clear filtering 

To clear filtering in the Designer, select the target dashboard item and do one of the following. 

• Click the Clear button in the Data tab. 

• Right-click on a dashboard item and select Clear from its context menu. 

 

OLAP filtering specifics 

You cannot apply filtering by building complex filter criteria in OLAP mode. Instead, you can filter 

dimension attributes and hierarchies by manually selecting the values you wish (or do not wish) to 

include in the dashboard. 

For dimension attributes, the Filter Editor contains a list of all values. You can select the values that 

you wish to display. 

For hierarchies, a tree is displayed instead, allowing you to filter individual values at any hierarchy 

level. 

 

Top N 

The Top N feature allows you to display only a limited number of values that correspond to the 

highest or lowest values of a particular parameter. 

1. To display the top values in a dimension, select Top N from the data item menu. 

 

2. In the Top N Values dialog, check the Enabled check box and specify the following settings. 

  

Mode Specifies whether top or bottom values should be displayed. 
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Count The number of values to be displayed. 

Measure The parameter according to which the top or bottom values will be 

determined. 

Show "Others" 

value 

If enabled, all values that are not the top/bottom ones are consolidated 

in the "Others" value. 

 You can use the hidden measure as a parameter according to which the top or bottom values will 

be determined. See Hidden data items. 

 

Formatting data 

Dashboard allows you to customize various data format settings for numeric and date-time values. 

Formatting numeric values 

1. To specify a format for numeric values, select Format in the data item menu. 

 
 This invokes the Numeric Format window. 

2. In the Format type field, select the required format type. 

3. Other format settings are only in effect for specific format types. 

1. Unit  The unit to which values should be converted. 

2. Precision  The number of fractional digits that should be displayed. 

3. Currency  Defines the currency sign and format settings that should be used to 

display currency values. 

To learn about currency formatting specifics, see the Currency formatting 

specifics section below of this document. 

4. Currency culture  For currencies used in a region with several cultures, specifies the 

culture that defines format settings. 

5. Include group separator  Specifies whether or not separators should be inserted 

between digit groups. 

 

Formatting date-time values 
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To specify a format for date-time values, use the Format submenu in the data item menu. This 

submenu lists the available format types that depend on the selected group interval. 

 For details on group intervals, see the Grouping topic. 

 

Currency formatting specifics 

The Dashboard allows you to specify currency format at two levels: for individual data items and for 

the entire dashboard. 

1. Data Item Currency 

• To specify which currency to use for a particular data item, select Format from the 

data item menu. 

• In the Numeric Format dialog, select Currency in the Format type field and use 

the Currency combo box to select the required currency. 

• For regions with several cultures, you can also select the culture that will be used to 

format currency values. 

• You can also apply the default dashboard currency by selecting Use dashboard 

settings in the Currency field. 

2. Dashboard Currency 

 You can also specify the default currency for the dashboard. This setting will be applied to 

dashboard items that have no currency defined. 

• To set the dashboard currency, click the Currency button in the Ribbon. 

• This invokes the Dashboard Currency window. In this window, select the required 

currency using the Currency combo box. 

• For regions with several cultures, you can also select the culture that will be used to 

format currency values. 

• You can also specify the client culture that should be used for the dashboard by 

selecting the Use client system settings item. 

 

Interactivity 
This section describes features that enable interaction between various dashboard items. These 

features include Master Filtering and Drill-Down. 

The section consists of the following topics. 

Master filtering 

The Dashboard allows you to use any data-aware dashboard item as a filter for the entire dashboard 

(Master Filter). End-users can select elements in a Master Filter item (chart bars, pie segments, grid 

records, etc.) to filter data in the rest of the dashboard by the selected values. 

 

Master filtering modes 
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The Master Filter item supports two selection modes. 

• Multiple   Allows you to select multiple elements in the Master Filter item. To enable this 

mode, use the Multiple Master Filter button in the Data tab. 

 To clear the selection in the Master Filter item, use the Clear Master Filter button in the 

dashboard item caption. 

• Single  Allows you to select only one element in the Master Filter item. When this mode is 

enabled, the default selection will be set to a Master Filter element. You can change this 

selection, but cannot clear it. To enable this mode, use the Single Master Filter button in 

the Data Ribbon tab. 

 

Filtering across data sources 

When different items in a dashboard are bound to different data sources, you can specify that a 

particular Master Filter should be applied across data sources. This means that it will apply filtering to 

fields with matching names in all data sources. 

 Fields are matched by their full names. For fields in other data sources to be affected by 

Master Filtering, their names must match the name of the field in the current data source, and they 

must belong to the same hierarchy level so that their full names also match. For 

instance, Customer.City and Customer.Address.City will not be treated as matching fields. 

To enable filtering across data sources, use the Cross-Data-Source Filtering button in the Data tab. 

 

Preventing items from being filtered 

You can prevent specific dashboard items from being affected by Master Filters, so that Master 

Filtering will never be applied to them. To do this, use the Ignore Master Filters button  in 

the Data tab. 

 

Drill-down 

Dashboard provides the drill-down feature, which allows end-users to change the detail level of data 

displayed in a dashboard item. This feature enables users to drill down to display the details, or drill 

up to view more general information. 

To enable drill-down, use the Drill-Down button in the Data tab. 

 If the selected dashboard item contains several types of elements that can be used for drill-

down, the Ribbon will provide the appropriate buttons to switch between these types 

(e.g., Arguments and Series buttons for the Chart). 

To return to the previous detail level (drill up), use the Drill Up button  in the dashboard item's 

caption or in the context menu. 

 

Dashboard layout 
This section describes the features related to the dashboard layout. 
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The section consists of the following topics. 

Dashboard title 

The Dashboard Title is located in the Dashboard Title Area, which is displayed at the top of the 

Dashboard. The dashboard title can contain text or image content. 

 

1. To change the title settings click the Title button on the Home tab. 

2. This invokes the Dashboard Title dialog, which allows you to change the text within the 

dashboard title, add an image, etc. 

 If you add an image to the dashboard title using the Load button, the dashboard XML file will 

contain the URL to access the image. If you add the image using the Import button, the dashboard 

XML file will contain an image as a byte array. 

The dashboard title area can contain command buttons. 

• Print button  allows end-users to print/export the dashboard. 

• Parameters button  allows end-users to modify dashboard parameter values. To learn more 

about parameters, see the Using dashboard parameters topic. 

 

Dashboard items layout 

The Dashboard Designer provides the capability to arrange and resize dashboard items in various 

ways, using simple drag-and-drop operations. You can also arrange and resize dashboard items using 

an API provided by the Dashboard. 

Item Resizing: You can resize individual items within a specific layout group (or an entire group) by 

dragging their edges. 

Item Positioning: You can change the position of a dashboard item via drag-and-drop, using one of 

the following approaches. 

• If the caption of the dashboard item is visible, click it and hold down the left mouse button 

while dragging the item. 

• If the caption of the dashboard item is not visible, click the  icon in the top left corner, 

and hold down the left mouse button while dragging the item. 

Depending on the required dashboard item position, a new layout group is created (if required) to 

maintain the arrangement of items. Thus, the dashboard item can be inserted to the desired area of a 

new or existing dashboard layout group. 

The drag-and-drop indicator shows possible positions for the dashboard item... 
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...and sequentially displays areas that can be occupied by the dashboard item. The image below 

illustrates how a dashboard item is dragged. 

 You cannot move the layout group to a position within its own subtree. 

 

Dashboard item caption 

Each dashboard item has a caption that is displayed at the top of this item. The caption contains static 

text along with other information, as well as command buttons. 

 

• To show or hide the caption of a dashboard item, click the Show Caption button in 

the Design tab. 

• Or right-click the item when designing the dashboard, and click the Show Caption menu 

item. 

The caption of the Dashboard item contains the following information and buttons, depending on the 

dashboard item type. 

Names • Dashboard Item Name - represents the static text within a dashboard 

item's caption. 

• Data Item Container Name - represents the name of the data item 

container. To learn more about data item containers, see the Data 

Sections topic for the corresponding dashboard item. 

You can change default names using the Edit Names dialog. To invoke this dialog, 

right-click the item when designing the dashboard, and click the Edit 

Names... menu item. 

Interactivity 

Information 

• Drill-Down Level - shows the current detail level of data displayed in a 

dashboard item. 

To learn more, see the Drill-down topic. 

Command 

Buttons 

• Export to button - allows you to print or export a dashboard item. To learn 

how to print individual dashboard items, see Print the project list. 

• Values button - invokes a drop-down menu that allows you to switch 

between provided values (in the pie, card, gauge and maps dashboard 
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items). To learn more, see the Data Sections topic in the Providing 

Data section for the corresponding dashboard item. 

• Clear Master Filter button - allows you to reset filtering when a dashboard 

item acts as the Master Filter. To learn more, see the Master Filtering topic 

in the Interactivity section for the corresponding dashboard item. 

• Drill Up button - allows you to return to the previous detail level when the 

drill-down capability is enabled for this item. To learn more, see the Drill-

Down topic in the Interactivity section for the corresponding dashboard 

item. 

 

Documents 

Organize personal and project-independent documents 
With InLoox you can sort project-independent documents into folders – directly in InLoox. You can 

also add personal documents and manage them together with your project and department 

documents all in one place. You don’t even need to open a specific project. 

The project-independent document section offers the same features as the document section in the 

different projects. For more information on the features in the document section please see 

the Organize project-related documents chapter.   

  

How to organize project-independent documents: 

1. Click on Documents in the InLoox PM or InLoox now tab. 

2. The Documents area opens. Here you´ll find a folder tree structure on the left. There, click 

on Private Links. 

• You can store all your personal and project-independent documents in the Private 

Links folder. 

• Additionally, the tree structure allows you to access all documents of your projects. Therefor 

click on the project folder in the tree structure. 
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3. Now click on New Private Link in the Start tab, to create a new link to a personal document.    

 

4. Now select the regarding document from your computer or your file server. The document is now 

linked to InLoox PM without having to have a relation to an InLoox project. Other InLoox users cannot 

access the document. If you use InLoox for Outlook in combination with InLoox now! you can also 

upload documents. Just follow the same steps as if you were to create a personal link in InLoox PM. 

5. If you want to assign the document to a project later on, please select a document from the 

document list and click on Assign Project on the Start tab.  

 

 

Organize project-related documents 

Add and edit project documents 
Work with file links to save storage space and avoid duplicates. File links don’t occupy storage space, 

as documents aren’t saved directly in Microsoft Outlook or on the Exchange Server. 

Please note: The access permissions of the original document still exist in InLoox equally whether you 

upload the document or you work with file links. If you add a file from a protected network folder or 

SharePoint store to the InLoox storage, still only authorized users can read and update it. Therefor 

always take the access permissions of the original document into consideration, when uploading it to 

the InLoox storage. 
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How to add a document 

1. Open an existing project and click on Documents in the Start tab. 

2. Click on the Edit tab and then on the arrow icon below New.  

 

Choose between: 

• New File: By using this feature, you can upload a document to the InLoox storage and save it 

to the project folder. When the Windows Explorer opens, select the document and click 

on Open. 

• New File Link: By using this feature, you can create a link to the storage place of a document. 

The document isn’t uploaded and doesn’t occupy any storage space. When the Windows 

Explorer opens, select the document and click on Open. 

• New Link: By using this feature, you can leave for example web addresses. After you have 

clicked on New Link, a side panel opens on the right side. In the path field you can save the 

web address.   

3. Afterwards the new document is displayed in the document list of your project.  

 

 How to edit a document 

1. Choose the document you want to edit from the document list. 

2. Open the Edit tab and click on Edit. A side panel opens on the right side. Here you can enter 

important information regarding the document.  
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3. Add information in the General area. 

• In the Path fieldyou can see the storage place of the document. You can’t edit this field. 

• The Status field allows you to leave notes about the processing status like in 

progress or completed. 

• In the Note field you can save all important information regarding the document. InLoox 

provides you with the various formatting features. For more information see 7. in How to 

create a new project. 

  

4. You can create links to other project elements (like mind maps, tasks …) in the Links area. 

• Click on New Link… and choose a project element you want to link to the document. 

• Click on Add and on OK. InLoox displays the document as a paper clip on the page of the 

project element you have chosen. You can also open the document on this page. 

• To delete the link, click on the delete icon  next to it. 

  

5. In the Notifications area you can inform other persons, like the project manager, about new 

documents or changes in already existing documents. 

• Click on this icon , to select a resource. 

• In the address book double-click on the name of the person you want to inform and then 

on OK. 

• The selected resource will be notified via e-mail when you save and close the project. 

  

6. When you have finished editing the document, close the side panel on the right side next to 

the General area. Your changes will be saved automatically.  

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/create-a-new-project/
https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/create-a-new-project/
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The document list in a project 
You can drop all important documents regarding your project in the document list. How to open the 

document list of a project: 

1. Click on the InLoox PM or InLoox now tab and then click on Projects. 

2. Double-click to open an existing project. 

3. To open the document list, click on Documents in the Start tab.  

 

Preview of internet URLs 

In addition to file types such as Word, PowerPoint or Excel, stored web page URLs can now also be 

previewed in InLoox. You can even browse the website directly in InLoox - no need to open an extra 

browser window. 
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Features on the Edit tab 
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For more information on user permissions browse the articles how to set user permissions and user 

permission options.  

Features in the View tab 

 

 

Features on the Settings tab 

The Settings tab in InLoox now! has a different design than in InLoox PM. Reason for this are the 

different storage places. In InLoox PM your documents are saved on your file or SharePoint server, 

whereas in InLoox now! the documents are stored in the cloud. 

In InLoox PM 
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For more information on the document folder path, see Save and edit the document folder 

path (Only for InLoox PM). 

  

In InLoox now! 

The Settings tab in InLoox now! only displays the occupied storage capacity in the cloud as a 

percentage. 

 

  

Features in the context menu 

The context menu provides you with all important core features that are also included in the Ribbon. 

To open the context menu right-click on any point in the document list.  

 

  

Information rules 

Document folder view 

• The entry All documents displays all documents which are saved within the project. 

• The entry Favorites displays all documents which have been marked in the ribbon as 

Favorites. 

• The entry Project folder displays all the documents of the project file store excluding 

subfolder content. The Project folder can contain subentries by the means of a tree structure, 

representing the physical structure of the file store or the SharePoint system. 
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Preview area 

• Choose a document from the document list in order to see it in the preview area. The 

preview area allows you to see the whole document with several pages. 

• In the preview area you can directly use Copy and Paste features in the document. 

 

• Use the filter feature to quickly find needed data. For more information, see Search and filter 

in a project 

• If a lock icon is displayed in the document list, you have no reading permission. In this case no 

document will be displayed in the list.  

 

Clean up the document list in InLoox PM 
You can directly upload documents to the InLoox storage space or you can create a file link.  If you 

have created a file link and the original document is deleted from the document folder, the document 

can’t be opened in InLoox anymore. To delete such unnecessary data, proceed as follows: 

1. Open an existing project and click on Documents in the Start tab, to open the document list. 

 2. Choose All Documents or just a subfolder from the folder structure on the left side. 

3. Open the Settings tab and click on Clean Up Document List. 

4. Click on Yes in the new window, to permanently delete redundant or unnecessary data.  

 

 

Create the document folder path in InLoox PM 
InLoox PM organizes your file or SharePoint server. In every project you have access to all related 

documents. Using the document folder path you can easily link a folder that is stored on your server 

to InLoox. Afterwards you can read in and update stored documents from that folder with just one 

click. 

The document folder path is only relevant for InLoox PM users, as documents of InLoox now! users 

are saved on the cloud. 

  

How to create the document folder path in InLoox PM 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/create-a-new-project/search-and-filter-project-information/
https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/create-a-new-project/search-and-filter-project-information/
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1. Open an existing project. Open the Start tab and select Documents. The document list of your 

project will open. 

2. Open the Settings tab in the document list and click on the folder icon. 

3. A new dialog box will open. There you can select the folder, which contains all important 

documents of your project: 

• In the Type area choose File server/ Local Computer, when the folder is stored on your 

computer or on a file server.  

 

  

In the Type area choose SharePoint store, when you are working with a SharePoint server. Therefor 

the SharePoint needs to be defined as the default storage place for documents in the InLoox Options. 

If the SharePoint is already defined as the default storage place for documents, all information about 

the location will be automatically displayed in the Location area. You just need to click on OK. For 

further information see Change the document folder path.  
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4. Open the Settings tab and click on Update Document List to read in all documents from the 

document folder. In the tree structure on the left side, the folder structure of the selected folder will 

be automatically displayed.  

 

Getting started 
Welcome to InLoox for Outlook! We compiled information that helps you get started with your first 

InLoox project. 

1. First, open Microsoft Outlook in your Windows start menu: 
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 ... or from your taskbar 

 

2. InLoox fully integrates with Microsoft Outlook and is always available with one click. 

 

Open InLoox for Outlook by clicking on the INLOOX PM or INLOOX NOW tab in the Microsoft Outlook 

Ribbon. 

3. To create your first task with InLoox, click on Tasks in the Views group on the InLoox Ribbon. 

 

4. Click on New Task in the New group to create a new task. 

 

5. Use the side panel on the right to enter all the details regarding your task.  

 

Congratulations, you have just created your first task with InLoox PM! 

1. To create your first project with InLoox, please click on the INLOOX PM or INLOOX NOW tab, 

then click on Projects on the Ribbon in the Views group. 
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2. By clicking on New Project in the Ribbon on the Start tab in the New group, you will get to 

the management form. 

 

3. Please enter all basic data regarding your project in the management form. 

 

 

Global task view 
Warning As of version 9, work packages were renamed tasks. 

The task view outside of the projects is particularly useful for heads of project teams and other team 

leaders to gain an overview of all tasks across all projects. Team members can use it to work on 

project-related tasks and personal tasks from their daily business in one place. 

In InLoox, tasks don’t have to be necessarily related to a project, they can be created and edited 

without any reference to a specific project. To get to the task list, click on the InLoox PM or InLoox 

now! tab and on the Tasks button in the Ribbon. 
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Content of the global task view 
In the global task view, you see all tasks you have a reading permission for. The task list shows both 

project-related and personal tasks. The InLoox Administrator can set and change permissions in 

the InLoox options. 

Tasks that are overdue appear in red. 

 

Create, edit and delete tasks 

Create and edit tasks 

To create a new task, click in the Ribbon on the Home tab on New task. You will be automatically the 

responsible resource for this task. 

  

 
To further edit this task, click in the Ribbon on the Home tab on Edit. 

1. In the side panel on the right, you can now rename the task and add a description of the task. 
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2. You can also set the estimated effort required for the task. A working day equals 8 hours by 

default. With the arrow next to working days, you can set whether you want to display the 

effort in working days, hours or minutes. 

3. A personal task, i.e. a task unrelated to a specific project, has to be assigned to a resource. If 

you aren’t in charge of the task yourself, you can assign the task to another resource. A click 

on the little arrow offers you a quick selection of frequently used resources, a click on the 

three dots opens the global address book. A task can only be assigned to one resource to 

guarantee clear responsibilities. 

4. You can set the time frame for the task (i.e. the start and end date), but you don’t have to. 

5. Click on New link… in the Documents area to add a document to the task. You will then see 

an overview of all documents that have been added to InLoox and that you have reading 

permissions for. You can also add a new document by clicking on New. Now you can select a 

new document from your computer or your file server.  

 

Assign a task to a project 
Tasks that you create in the cross-project task list are personal tasks by default and are not related to 

a specific project. If you want to change that, please follow these steps: 

1. Click on the task in the task list that you want to assign to a project. The task is not supposed 

to be assigned to any other project yet. 

2. Click in the Ribbon on the Home tab on Assign Project. 

 

3. You will see a list of all projects that you have reading permissions for. Please select the 

regarding project and confirm with OK. 
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Alternatively, you can also find this command in the context menu. Right-click on the task that you 

want to assign. You will find Assign Project there, too. 

 

As soon as a task has been assigned to a project, there will be a note in the side panel on the right 

regarding the project. You can click onto the project name to get directly to the project. If the task has 

been assigned to a specific activity in the Gantt chart, the time frame of the activity will determine 

the start and end date of the task. You can change that manually, as long as task is performed within 

the time frame of the activity.  
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Notifications and notes 
Every InLoox user can determine in the user settings how and when he or she wants to be notified 

about upcoming tasks. 

1. In Outlook, click on the File tab, then under InLoox, select Options. 

2. In the Options dialog, click in the navigation pane on the left on User Settings, More Options. 

3. Now you can set how and if you want to be notified before the start and/or the end of your 

tasks.  

 

You can specify persons that you want to notify about new notes on the task. If a task is related to a 

project, you can notify other persons about changes on the task. 

Important The resource in charge of the task will be notified automatically if there are changes made 

to the task. 

The notification field is meant to notify other people such as the project manager. The arrow leads 

you to a quick selection of frequently used resourses, whereas clicking on the three dots opens the 

global address book. 

If you want to add additional information on the task, you can add notes. At the bottom of the editing 

side panel, click on the Notes tab: 

 

You can enter persons that you want to notify about new notes on the task. 
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1. Enter your project note. 

2. If you want to inform someone about it, click on the small arrow right to Notification for a 

quick selection of frequently used resources or click on Notification to open the global 

address book. 

3. Then click on Post Note. 

You can also add notes with notifications to tasks that are unrelated to a specific project. 

The InLoox Administrator can determine in the options how InLoox users are notified. 

 

Mark tasks as done 
You can mark finished tasks as done directly in the task list. You have several options: 

• If you have added the Done column to your task list (the column with a green check), you can 

mark a task as done by activating the check box for this task in this column. 

• Alternatively, you can also right-click on the task in the task list and select Mark As Done in 

the context menu. If the task is related to a project, you can determine whether you only 

want to mark the task as done or whether you want to also mark the activity in the project 

plan as done to which the task belongs. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/inloox-9-options/
https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/inloox-9-options/
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• You’ll find the same feature in the Ribbon on the Home tab. Click on the respective task and 

click on Mark as Done in the Ribbon 

Marking a task as done has several effects: 

 

• When you mark a task as done it will disappear from your task list if you have activated the 

filters Today, Overdue or Open and will be shown as a completed task. 

• If the task is related to a specific project the completion of the task is reported back into the 

project and is taken into account in the calculation of the project progress. 

• If you have activated notifications for the task the person/-s are notified about the 

completion of the task. 

• If you as a project manager mark the task as done and you are not in charge of carrying out 

the task yourself, the resource assigned to task will be informed automatically. 
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Delete a task 
You can delete tasks by clicking on the task you want to delete in the list and then click in the Ribbon 

on the Home tab on the Delete button. You’ll also find this command in the context menu. You get to 

the context menu by right-clicking on the task that you want to delete. 

If you delete a task, the people for which you have added notifications will be informed about it. If 

you as a project manager delete a task for which another resource is in charge of, the resource will be 

informed. 

Warning Deleted tasks are removed permanently – you are not able to restore them. 

Tip If you want to delete several tasks at the same time, you can use Multi-Select. Press and hold 

the CTRL key on your keyboard and click on the tasks that you want to delete at the same time. Now 

select the Delete button in the Ribbon. 

 

Filter options 
In order to work with the task list more efficiently and to get a better overview of a multitude of 

tasks, InLoox offers you several filter options. 

On the Home tab in the Display group, you can filter the list by the form of your participation and by 

the due date of the task: 

 

By participation: 

• My: Shows all tasks that have been assigned to you, i.e. the tasks you are supposed to carry 

out. 

• Project Participation: Shows all tasks from projects that you participate in whatever role (e.g. 

as project manager, team member, customer…). You can determine who participates in a 

project on the Management page of the project. 

• All: Shows all tasks for which you have a reading permission. 

By due date: 

• Today: Shows all tasks that are due today. 

• Overdue: Shows all tasks that were due in the past. 

• Open: Shows all tasks that have not been completed yet including tasks that are due today 

and overdue tasks. 

• Completed: Shows tasks that have already been marked as done. 

 

Analytical filter 

In addition to the filter options above, you can also use advanced filter options by applying the 

analytical filter. You’ll find the Filter button on the Home tab in the Current View group. 
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Customize the list view 
To customize the list view according to your needs you have several options: 

Add and remove fields 

You’ll find a multitude of information in the task list that you can add to or remove from the list in the 

form of table columns: 



 121 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 

 

Right-click on the task list and choose Select Fields in the context menu. If you want to add one of the 

fields to your list, drag it with the mouse into the column header.   

 

To remove a field from the task list, drag it with your mouse back into the Select fields dialog. 

Group 

In order to group tasks by certain criteria, drag the field that you want to group by into the Group 

field above the column headers. 



 122 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 

 

When you click on the little arrow next to the group criterion, you can decide whether you want to 

sort the tasks in ascending or descending order. 

Here, you have again the option to filter the task list: Move the cursor over the group criterion to 

show a little filter symbol. Click on the filter symbol to narrow down the group criterion. 

 

Sort 

You can also sort the task list by clicking onto the column header that you want to sort by. Click again 

to change the collation. 

Conditional formatting 

You can also format the task list according to rules that you define by using Conditional Formatting. 

You’ll find this feature in the Ribbon on the Home tab in the Current View group. Please read 

the Conditional Formatting chapter to learn how to work best with conditional formatting. 

 

Save and re-use views 
When you have customized your task list in a way that suits you best, you can save this view in the 

database and make it available to other InLoox users on the same database. 

Click on the Home tab in the Ribbon on Save, Save Current View… Now you can name the current 

view. You can also choose whether this view is supposed to be available to all InLoox users or only to 

yourself. 
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You can access the saved view in the Outlook folder pane on the left below tasks. 

 

The changes you make to your default task list are saved automatically locally on your computer and 

are available automatically, as soon as you open the task list the next time. 

 

Track time efforts 
You can also track working times directly out of the task list. Click on the task on which you spent the 

working time. Then click in the Ribbon on the Home tab on the Track Time button. 

Learn more about tracking working times in the chapter Time Tracking. 

 

Refreshing tasks 
If there are many projects in the InLoox database, team members constantly add new tasks, change 

or delete existing tasks. 

 

You can stay on top of your tasks by refreshing the task list manually. Click on the Refresh button in 

the Ribbon on the Home tab. 
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The InLoox Administrator can set a fixed interval to refresh the task list automatically in the InLoox 

options. You’ll find the settings when you click on the File tab, InLoox options, General options, More 

options. You can set the update interval in minutes on the bottom right side (administrator 

permissions necessary). 

 

Task list in the side panel 
To gain an even better overview of your InLoox tasks while you are working in Outlook or in the global 

sections of InLoox, you can also open the global task list in a side panel next to any Outlook view. 

 

To open the side panel click on the InLoox PM or InLoox now! tab, then on Task List. To close the task 

you can go the same way or click on the little cross in the top right corner of the side panel. 

 

 

Click on any spot in the side panel to activate the Tasks tab where you’ll find all commands that you 

know from the global task list in the full-screen mode. 

 

Please read the chapter Global task view to learn how you can use these features and how you can 

customize the contents of the taks list. 
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Here you can find InLoox in Outlook 
InLoox on the home tab 

You work with Microsoft Outlook most of the day, this is why we want to make sure that you can 

easily access InLoox directly from within Microsoft Outlook. Therefore your Microsoft Outlook home 

tab is supplemented by additional InLoox options: 

 

InLoox in the side panel 

The InLoox folder structure is also included in the Outlook side panel on the left of the window. You 

can find the InLoox folder directly below your Inbox. The navigation menu is extended, too.  
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InLoox PM or InLoox now options 

 

 

History 
Track the changes of all projects 

The project history allows you to chronologically track all changes of all projects you are involved (you 

need to have reading permission). Every change that is made by the project staff is documented in 

the global project history after the person has saved and closed the project. 

Staff stands for all persons that are mentioned in a project in the area Staff as project manager, team, 

customer, partner or others. Additionally staff members need the appropriate permissions, to not 

only being able to read project information, but rather being allowed to change it. (Permissions can 

be edited in the InLoox options by InLoox admins) 

 

How to open the history 

1. Open the InLoox PM or InLoox now tab and click on History. Another option is to select the history 

from the tree structure on the left side. Therefore click on InLoox PM or InLoox now in the tree 

structure directly below your Outlook folders and open the section Projects. Now you can select 

the History. 

2. The global project history opens and shows all changes of all projects you are involved.   

View and features in the history 
The project history chronologically shows all changes of all projects.  

http://www.inloox.com/support/knowledge-base/online-help/inloox-for-outlook/9-0/all-support-articles/security-and-privacy/set-user-permissions/


 127 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 

 

• Blue contents highlight the person that has made the change. 

• Purple contents show the project information that has been changed.   

• Red contents display the new value of the changed project information. 

  

Selected features in the history 

1. You can open highlighted projects, notes, project information or staff members from the history. 

How to get more information on each element of the change note: 

• Click on the project name to open the project. 

• Click on the staff member (blue) to open their entry in the address book. 

• By clicking on the changed project information (purple) you open this element in its 

respective project. 

2. To delete change notes from the history, click on the cross directly next to the information. 

3. Sometimes the change note can be too long and can’t be showed as a whole in the history. To 

receive all information about the change, slowly guide your mouse pointer over the change and the 

whole change will be showed.  

 

How to organize the view and use filters 
The Start tab provides you with several features to further structure and filter the project history.  
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Define a period of time 

Define the period of time for that you want to see the changes. Therefore you can choose between 

today, yesterday, day before yesterday and custom. 

 

Display changes of selected project elements 

By using the blue buttons you can filter the changes by specific project elements like Management, 

Planning, Time, Documents or Budget. This is very useful, when you only want to see changes of a 

specific area of all projects. You can combine several project elements. If a button is blue, the 

respective project element is selected and all changes of that area are viewed in the history. In the 

screenshot: All changes of all project elements are viewed, as all buttons are selected and blue. 

 

Project Filter 

You can use the project filter to limit the history to the changes of a specific project. Additionally, you 

can combine the project filter with the display of selected project elements and the contact filter. 

 

Contact Filter 

You can use the contact filter to limit the changes to the changes a specific staff member has made.  

  

Example on how to organize the view and use filters 

You want to reproduce the changes that have been made by the staff member “Rita Meyer” in the 

project “Product Brochure” yesterday. To customize the view corresponding to your needs, proceed 

as follows: 

1. Click on the arrow next to the button Go To Date and choose the needed date (here: yesterday) 

from the drop-down-list. 
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2. In the Display area, click on all project elements until only the needed button(s) (here: Planning) 

are highlighted blue and are selected thereby. 

3. Define the Project Filter and choose the needed project (here: Product Brochure). 

4. For the Contact Filter choose the staff member (here: Rita Meyer). 

Now you can see only those changes that have been made yesterday by the selected staff member in 

the planning of your selected project. 

This example illustrates the amount of options that are provided by the project history. You can 

customize the global project history by using and combining several filters.  

 

InLoox options 
You can customize and configure most of the InLoox features within the InLoox options. 

User permissions 

To change global settings in the InLoox options you will need specific user permissions. For more 

information on permissions browse the articles: How to set user permissions and User permission 

options.  

How to open the InLoox options 

Click on File in the upper left corner. On the side panel click on the InLoox options 

button . 

Adjust the customer number 
The InLoox options provide various possibilities to edit the customer number. In the customer 

number area you also can define the rules for the number format. 

Adjust a customer number 
1. Open the InLoox options by clicking on File in the left corner. Afterwards click on the InLoox options 

button  

2. Select General Options, click on Customers and then on Customer Number. 
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3. Individually edit the customer number: 

• Prefix = Project number is displayed as a preceding character string. 

• Sequence number = Project number is automatically continued. 

• Suffix = Project number is displayed as a following character string. 

For the number setting you need a least a prefix or a sequence number. You can combine a prefix or a 

suffix with a sequence number. 

4. Click on OK or Apply to save your changes.  

 

Mode description for prefix and suffix 

Mode Data type and significance 

Any text Any changeable character string of any length. 

Fix text Any character string of any length, which cannot be changed, e.g. the 

word project. 

Regular 

expression 

To define the format of the customer number insert a Regular expression and 

a Default.  
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Mode Data type and significance 

Please note the format rules, for more information see: Change the number 

format. 

 

Examples of common formats 

Example Configuration 

Four-digit year combined with sequence number (e.g. "2016-

008") 

  

components: 

• "2016-" (fixed prefix with year). 

• "Sequence number" (maximum 3 digits with leading 

zeroes). 

Prefix: 

• Rule: ^\d{4}-$ 

• Default: 2016- or 2015- 

Sequence number: Digits: 3 

  

Suffix: none 

Sequence number with country code 

  

components: 

• "Sequence number" (maximum 5 digits with leading 

zeroes). 

• Country code (-DE, -AT, -FR, ...). 

Prefix: none 

  

Sequence number: Digits: 5 

  

Suffix: 

  

• Regular expression: ^-

\w{2}$ 

  

• Default: -DE 

Simple sequence number 

• "Sequence number" (maximum 6 digits with leading 

zeroes). 

Prefix: none 

  

Sequence number: Digits : 6 

  

Suffix: none 

Free format Prefix: any text 
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Example Configuration 

  

Sequence number: none 

  

Suffix: none 

    

 Effects of changing the number format: 

• New projects are created automatically with numbers in the new format. 

• Existing projects retain their old numbers. 

• A once assigned sequence number cannot be used again. 

 

Adjust the division structure 
InLoox provides its own division structure that is independent of the division structure in Outlook. 

The InLoox division structure is only available within the InLoox PM Enterprise Edition. 

The division structure can be subdivided into as many levels as needed. You can assign whole division 

to a project. Additionally, the division structure supports you in assigning tasks to resources. 

  

Create a new division 
1. Open the InLoox options by clicking on File in the upper left corner. Afterwards click on the InLoox 

options button  

2. Select General Options and click on Divisions.  
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3. To save your changes click on OK or Apply. 

  

Edit and Delete already existing divisions 
• Choose a division and click on Edit to customize the chosen division. 
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• Click on Delate to remove a chosen division from the division list. 

  

Effects of creating, editing and deleting a division 
• The renaming of a division immediately affects all relevant projects. 

• The deletion of a division immediately affects all relevant projects. 

• A new division is visible on the management and tasks page when adding a resource. 

 

Adjust the project number 
Within the InLoox options you can individually edit the project number.  

 The options define the project number format. For more information see Change the number 

format. 

Edit the project number 
1. Open the InLoox options by clicking on File in the left corner. Afterwards click on the InLoox options 

button  

2. Select General Options and click on Project Number. 

 

  

3. Individually edit the project number by using one of the three options or combining them. 

• Prefix = Project number is displayed as a preceding character string. 
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• Sequence number = Project number is automatically continued. 

• Suffix = Project number is displayed as a following character string. 

4. Click on OK or Apply to save your changes.  

Mode description for prefix and suffix 

Mode Data type and significance 

Custom text Any changeable character string of any length. 

Fixed text Any character string of any length, which cannot be changed, e.g. the word project-. 

Regular expression To define the format of the project number insert a Regular expression and a Default. 

Please note the format rules, for more information see Change the number format. 

Examples of common formats 

Example Configuration 

Four-digit year combined with sequence number (e.g. "2016-

008") 

  

components: 

• "2016-" (fixed prefix with year). 

• "Sequence number" (maximum 3 digits with leading 

zeroes). 

Prefix: 

• Rule: ^\d{4}-$ 

• Default: 2015- or 2016- 

Sequence number: Digits: 3 

  

Suffix: none 

Sequence number with country code 

  

components: 

• "Sequence number" (maximum 5 digits with leading 

zeroes). 

• Country code (-DE, -AT, -FR, ...). 

Prefix: none 

  

Sequence number: Digits: 5 

  

Suffix: 

  

• Rule: ^-\w{2}$ 

• Default: -DE 

Simple sequence number Prefix: none 

  

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/inloox-9-options/change-the-number-format-in-inloox-9/
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Example Configuration 

• "Sequence number" (maximum 6 digits with leading 

zeroes). 

Sequence number: Digits : 6 

  

Suffix: none 

Free format Prefix: any text 

  

Sequence number: none 

  

Suffix: none 

    

 Effects of changing the number format: 

• New projects are created automatically with project numbers in the new format. 

• Existing projects retain their old numbers. 

• Once assigned sequence numbers cannot be used again. 

 

Budgets 

Manage budget and budget item templates 
Templates allow you to quickly re-create a budget or budget item, instead of having to create a new 

one from scratch. You can create, edit and delete budget items and budget templates in the InLoox 

Options. To get there, click on File in the upper left hand corner of Microsoft Outlook and then 

navigate to InLoox Options >> Budgets >> Templates.  

Budget items 

Creating budget item templates allows you to use the template if you want to bill the same activity 

again. This will save you time as you won’t have to create a new budget item.  

 

To create a new budget item template follow these steps: 
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1. Go to InLoox Options and then in the panel on the left navigate to Budgets >> Templates >> Budget 

Items 

2. Click on New to create a new budget item template.  

3. You can edit the information of your new budget item template in the new dialog window: 

 

• Section Budget Item 

• Name and Description – Give your budget item a clearly distinguishable name so you 

will be able to identify it easily later on. Add a description with additional comments 

or information if necessary. 

• Quantity - Define the quantity of an item, e.g. if you want to bill 90 minutes as a 

consulting hour, then specify “1.5”. 

• Section Pricing 

• Defining the purchase and sales prices for the budget item enables you to save time 

as this information will be filled in automatically when you create a new budget item 

from a template. You can create, edit or delete already defined pricing units.  

• Section Groups  

• Specify to which groups you want to assign the budget item template. You can 

choose more than one. It’s important to choose at least one group, otherwise you 

won’t see the template when you create a new budget item in Budgets.  

4.Click OK to save your new budget item template.  
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Budget templates 

You can create templates of a complete budget including budget items. If you want to create a budget 

template out of an existing budget, you can do so in the respective Project Budgets directly. You can 

also create a budget template from scratch in the InLoox Options. There you can also edit and delete 

existing budget templates.  

 

Follow the following steps to create a new budget template:  

1. Go to the InLoox Options and in the folder structure on the left navigate to Budgets >> Templates 

>> Budget Templates 

2. Click on New to create a new budget template. 

3. Edit your template in the new dialog window:  
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• Type – Choose between the four budget types Expense (plan), Expense (actual), Revenue 

(plan) and Revenue (actual) 

• Visible for all users – By default, the budget is only visible to yourself, but you can mark it as 

visible for all users. 

• Name – Give your budget template a clearly distinguishable name so you and your team 

members can easily find it later. 

• New - To create a new budget item click on New. A window will open in which you can edit 

the information of your budget item 

• Edit and Delete - Mark the budget item which you want to edit or delete, and click on Edit or 

Delete respectively.  

• Order of budget items - Change the order of the budget items in the list by marking a budget 

item and move it up or down by clicking on the arrows.  

4. Click on OK to save your new budget template.  

 

Manage the budget statuses 
The standard statuses that are in the InLoox Options by default are Rejected, Approved and Open. 

You can also create individual budget statuses, or edit and delete the existing ones. 

 

Follow these steps to create a new budget status: 

1. In Outlook, click on File in the upper left hand corner and click on InLoox Options. 

2. Navigate to Budgets >> Budget status in the folder structure. 

3. Click on New to create a new budget status. 

4. Edit your new budget status in the dialog window. You can also decide whether budgets with that 

status are budget neutral or budget relevant.  
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5. Click on OK to save your new budget status.  

 

Change the language of InLoox 
InLoox is a multilingual system. The operating language adjusts automatically to the Region and 

Language Options in the Windows Control Panel. The language can be changed manually during the 

operation of InLoox at any time without the need to restart. 

Proceed as follows to change the operating language of InLoox: 

1. We start from the Outlook inbox. 

2. Click on File and afterwards on InLoox PM options or InLoox now options.  

3. In the tree structure on the left of the InLoox options and select User Settings and Language. 

4. Now you can switch the operating language (Auto, English, German, French, Italian, Spanish).  

5. To save your changes click on Apply. Now you can close the InLoox options, the operating language 

will be changed immediately without a re-start of Microsoft Outlook. 

 

Change the number format 
Within the InLoox options in the area Project Number and Customer Number you can define the 

format rules for project numbers and customer numbers. Please note the following possible effects of 

changing the format settings: 

• New projects/customers are created automatically with the new number format. 

• Existing projects/customers retain their old numbers. 

• Once assigned sequence numbers cannot be used again. 

Format rules 
 

Character Data type and significance 

. Any single character. 

\d{COUNT} Any numeric (0-9) with COUNT digits. COUNT stands for any positive integer, e.g. 5. 

\w{COUNT} Any character string (A-Z, a-z, 0-9, underscore "_") with COUNT characters. COUNT 

stands for any positive integer, e.g. 5. 

\D{COUNT} Any character string (A-Z, a-z, special characters, umlauts, spaces) with COUNT 

characters. Numerics are not allowed. 

\W Single special character. (A-Z, a-z) or numeric (0-9) are not allowed. 
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Character Data type and significance 

STRING STRING stands for a fixed character string specified by the user, 

e.g. project, department_A, PID. 

^STRING$ Expressions placed between ^ and $ must not be empty and must be of the defined 

length. The only permissible input in this example is STRING. 

Without ^ and $, STRING1234 or an empty text is also a valid input. 

 

Sample formats 

Format Examples 

.._\d{4} right: Ab_1234, ?!_0000 

  

wrong: 12-1234, ab-abcd 

SAMPLE... right: SAMPLE1234, SAMPLEABCD, SAMPLEab12, SAMPLE 

  

wrong: SAPMLE1234, 1234SAMPLE 

\w{2}-\d{2} right: ab-12, AB-12, 01-12, a1-99 

  

wrong: 12-ab, öö-12, ??-12 

\W{2}SEPERATOR\D{2} right: !!SEPERATOR12, 12SEPERATOR12, abSEPERATOR!? 

  

wrong: !!TRENNab, 12SEPERATORab, abSEPERATOR12 

 

Create an InLoox PM user account 
To logon to the InLoox PM project management platform you can use Windows or InLoox PM 

Authentication. With an InLoox PM Authentication, external team members, project partners or 

stakeholder without their own Windows user account in the corporate network are able to log into 

InLoox PM directly with user name and password. 

 Only users with administrative permissions can create an InLoox PM account. 

InLoox PM authentication 
Please follow these steps to create an InLoox PM account: 
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1. Activate first the InLoox PM contact management. 

 For more information, see Activate the contact management. 

2. Create a new contact in the InLoox PM Contacts. 

 For more information, see Add a contact. 

3. Open the InLoox PM Options dialog box. 

 For more information on how to open the InLoox PM options, please see Open the 

InLoox PM options. 

4. Under Permissions click Permissions. 

5. In the User-based permissions section, click New. 

 

6. In the Permissions dialog box, please follow these steps: 

1. Click the Arrow  and choose from the drop-down list InLoox PM user. 

2. In the Select Contact dialog box, select InLoox PM address book from the drop-down 

list Address book. Choose a name from the list and click OK. 

The contact name is now displayed in the User name box, in 

the Authentication section, under InLoox PM Authentication. 

3. You can change the name in the User name field. 

4. In the Password field, type a new password for the InLoox PM authentication. 

5. Enter this password again in the Retype password box to confirm it. 
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6. Activate one of the following check boxes: 

• Activate the Change the password on the next logon check box to allow the 

InLoox PM user to change his or her password. See Change InLoox PM 

password below. 

• Activate the Logon inactive check box to deactivate the authentication. 

7. Select the permissions from the Permissions list for the InLoox PM user. 

8. Click OK. 

7. Click OK or Apply to save the changes. 

 Now, the InLoox PM user can logon to InLoox PM. For more information see Log on as 

InLoox PM user. 

 

Change the InLoox PM password 
Please follow these steps to change the InLoox PM password 

1. Open the InLoox PM Options.   

 For more information on how to open the InLoox PM options, see Open the InLoox PM 

options. 

2. Under User settings click User Login. 

3. In the User Login section, choose InLoox PM Authentication and click the Change 

Password button. 

You can also change your user name in the User name field.  

4. In the InLoox PM Authentication dialog box, type your current password in the Current 

password field. 

5. Type the new password in the Password field. 

6. Type the new password again in the Retype new password field. 

7. Click OK. 

Now, you can use your new password for the InLoox PM Authentication. 

 For more information on how to log on, see Log on as InLoox PM user. 

 

Create and Assign Skills 
Define the skills of your team members in InLoox, such as language skills, special industry knowledge 

or certifications. This enables you to easily identify employees with the required skills inside your 

company, contact them directly and accurately allocate them according to their skills. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/7-0/online-help-inloox-pm-7/security-and-privacy-settings-in-inloox-pm-7/how-to-log-on-with-the-inloox-pm-7-user-credentials/
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You can create, edit and delete skills in the InLoox Options, as well as assign or re-assign these skills to 

the respective resources.  
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Create a new skill 
Follow these steps to create a new skill: 

1. Navigate to File >> InLoox Options >> Contacts >> Skills 

 

  

2. Click on New to create a new skill. 

3. A new editing dialog opens in which you can give the new skill a name and add a description.  

 

  

4. Confirm with OK.  

 

Assign a skill to a resource 
Follow these steps to assign one or more skills to a resource: 
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1. Navigate to File >> InLoox Options >> Contacts >> Assignment 

 

  

2. Click on New to assign skills to a resource 

3. A new editing dialog opens. Click on […] to open the address book. Choose the contact you 

want to assign skills to. Confirm your choice with OK.  

4. Select all skills you want to assign to the contact. 

 

  

 

Create and edit groups 
Groups are a good way to sort tasks and budget items into specific categories with pre-defined 

purchasing and sales prices. This enables you to keep an overview of your expenses and revenues 
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across different groups, i.e. types of work or services (see Budget Overview). It’s important to create 

distinct groups that cover distinct activities, such as Production, Design, Maintenance, or Consulting. 

The automatically created budgets Expenses (Plan, Resources) and Expenses (Actual, Time 

Tracking) use the purchase and sales prices specified for each group to bill a task. 

You can add, edit and delete groups in the InLoox Options. To get there navigate to the InLoox 

Options >> General Options >> Groups.  

 

Creating a new group 

To create a new group, take the following steps: 

1. Go to InLoox Options and navigate to General Options >> Groups 

2. Click on New and an edit window will open 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/budget-overview-inloox-9-for-outlook/
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3. Edit the group information 

• Name - Give your group a clearly distinguishable name. This will make it easier to 

assign your budget items to the right group. 

• Purchase and Sales price – Define the standard purchase and sales price for the 

group 

4. ClickOKto confirm 

  

Important Effects of creating, editing or deleting a group, or changing the currency:  

• Creating a new group does not affect your existing budget items and tasks. 

• The purchase and sales prices of your existing budget items will remain the same, even if you 

edit the purchase and sales prices of a group. The pricing will automatically change 

to Custom when you change the prices for a group in the InLoox Options. If you want to apply 

the newly defined prices, select Standard. 
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 Already billed expenses from time tracking entries will not change when you edit purchase and sales 

prices.  

• If you delete a group, all tasks and budget items that have been assigned to this group will 

automatically be assigned to another group. You will have to re-assign these tasks to the 

appropriate group. 

• Changing the currency symbol does not automatically convert prices. Prices in InLoox will 

remain the same (“currency rate” = 1:1), and only the currency symbol changes.   

 

Create and manage customers 
The InLoox options support you with a central customer management. You can create a new 

customer system-wide within the options as well as directly within a project. 

Create a new customer 

1. Open the InLoox options by clicking on File in the upper left corner. Afterwards click on the InLoox 

options button  

2. Select General Options and click on Customer then on Customers.  
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3. To save your changes click on OK or Apply. 

  

Edit and delete already existing customer 

• Choose a customer and click on Edit to customize the chosen customer. 

• Click on Delate to remove a chosen customer from the customer list. 

  

Effects of editing or deleting a customer 

• The renaming of a customer immediately affects all relevant projects. 

• The deletion of a customer immediately affects all relevant projects. 

 

Documents 
If you are the admin, you can edit the settings for the document folder path and the document folder 

structure in the InLoox Options  . As of InLoox version 9.0.12 admins can also set rules 

for the creation of document folders. 

Change the document folder path 
In the InLoox PM options you can define the rules for the document storage feature. To change the 

document folder path in the InLoox options, proceed as follows: 

1. Open the InLoox PM options by clicking on File and afterwards directly below InLoox PM on 

options. 

2. The dialog box Options opens.Click on Documents on the right side of the box and afterwards 

on Document Store.  
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3. Select the Automatically update document list on project startup check box to automatically 

refresh the document list when opening a project. This feature slows down the opening progress of a 

project, but ensures that the document list displays the latest status of the document folder. 

4. Choose between File Server and SharePoint Server site as default document store. 

4.1 When you manage your documents on your own computer or on a file server, choose File Server. 

Afterwards click on  to select a folder and then click on OK.  

• In the Rules field you can define the folder structure. To define a rule you can use the 

following fields: Project Name, Project Number, Company Name, Company Number, and 

Division. 

• The default setting for the rule <PROJECT_NUMBER><PROJECT_NAME> leads to the following 

folder structure: <BASEPATH>\2016-001 Project 1 

4.2 When you manage your documents on a SharePoint server, choose SharePoint Server site. 

• Enter the path to your SharePoint server, like http://company/web or Http://www.my-

sharepoint.com/site_intern/, in the first field. 

• Document library rule and Sub-folder rule (optional): Here you can define the structure for 

the SharePoint document library and – if needed – for sub-folders. You can enter any text 

(and use one library for all projects) or use fields to define a rule (see Rules in the file server 

section). The advantage of using a rule and creating one document library for every project is 

that you can individually control the access permissions of the different project libraries.   

   

Effects of changing the storage type, base path or rules: 



 152 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
• If there haven’t been any projects yet, changing the settings has no effects. New projects will 

be created on base of the new settings. 

• If you have existing projects and you change the settings, all new projects will be created on 

base of the changed settings. All existing projects will be continued with the former settings, 

unless you change it manually in the project. 

 

Edit the document folder structure 
The InLoox PM options allow you to individually define the folder structure for the document area. 

Thereby, you can automatically create subfolders in every document folder. You can create as many 

subfolders as needed. 

For example, when you create a new subfolder (e.g. marketing) in the InLoox PM options. This new 

subfolder is created in every project document folder.   

  

How to create a new subfolder 

1. Open the InLoox PM options by clicking on File in the left corner. Afterwards click 

on Options below InLoox PM in the side panel. 

2. Click on Documents and then on Folder structure. On the right side you will see the Folder 

structure area.  

 

3. Click on OK or Apply, to save your changes. 

  

 Effects of changing the document folder structure: 

• Existing subfolders are not deleted or renamed, when the subfolder structure is changed. 

• The new structure is applied to already existing projects, when new documents are added.  
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Set rules for document folder structure 
In order to use this feature, you have to download InLoox version 9.0.12 or higher. 

1. In Outlook, click on File and open the InLoox Options. 

2. In the side panel, click on Documents and then on Folder structure. 

3. Click on New to create a new folder. 

4. If you want to set a rule for this folder, activate Create if. 

5. Click on Fields, to select which field needs to have a certain value. Select, e.g., Division. 

In this example, we want to create the subfolder “Product Development\Beta” only if it is a project of 

the division IT-Beta Team. 

 

IMPORTANT The regular expression must exactly match the value used in the field. If the division is 

called “IT-Beta Team”, the rule will not apply if you enter „it-beta team“.   

If you create a new project and click on New in the Documents section, the new folder structure is 

automatically created based on the newly set rules. 
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Regular expressions for more complex rules 

If you are familiar with regular expressions, you can use them to set more complex rules. Here are 

some examples: 

 

• Folder 1 is only created if the project number starts with „2017-„ (the year followed by a 

minus). 

• Folder 2 is only created if the division „IT-Team Beta“ is selected for the project. 

• Folder 3 is only created if the project name starts with the letters „Intern“ followed by a 

space (e.g. „Intern digitalization project“ or „Intern revision 2016“). 

PLEASE NOTE New rules are not applied to existing projects. They only apply for newly created 

projects. 

PLEASE NOTE If a value for the regular expression does not exist, InLoox warns you with an x next to 

the field. The value for the regular expression must exactly match the value used in the field.  

 



 155 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
OR-rules for a document folder 

You can set several OR-rules for one folder. Simply create each rule for the same folder. InLoox will 

then create the folder if one of the rules applies. 

In this example, the Folder 3 will be created if the project name is „Intern“ followed by a space or if 

the customer in the project is „Intern“. 

 

PLEASE NOTE You cannot create AND-rules.  

 

Edit or delete rules 

If you want to edit a rule, mark it and click on Edit or double-click on the rule. Now you can change 

the values for the rule. Click on Apply or click on OK to apply the changes an close the InLoox 

Options. 

If you want to delete a rule, mark the rule and click on Delete. InLoox will ask you, if you really want 

to delete the rule. Confirm by clicking on Yes. 

PLEASE NOTE If you delete a rule, this will not affect existing folder structures. The rule will only no 

longer be applied for newly created project document folders.  

 

Edit the project statuses 
The status defines different project conditions and degrees of completion. You can edit the status of a 

project on the Management page. 

In the InLoox options you can define as many project statuses as needed. Each status is connected to 

the project progress as a percentage. 

  

Create a new project status 

1. Open the InLoox options by clicking on File in the upper left corner. Afterwards click on the InLoox 

options button  
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2. Select General Options and click on Project Statuses.  

 

3. To save your changes click on OK or Apply. 

  

Edit and delete already existing statuses 

• Choose a status from the list and click on Edit to customize the chosen status. 

• Click on Delete to remove a chosen status from the project status list. 

  

Effects of creating, editing and deleting a project status 

• Adding a new status won’t affect existing projects. 

• Changing the sequence in the status list has no effects on existing projects. 

• Editing a status (e.g. name, progress in %) immediately affects all relevant projects. 
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• Deleting a status affects all projects that used it. Those stay without a status until the user 

manually chooses another status in the project. 

 

Lock and unlock project access 
InLoox enables you to lock a project if you want to avoid further changes to a project. You can delete 

a project lock anytime. To be able to lock a project or to delete a project lock you have to have the 

permission to Lock projects. 

Please follow these steps to lock a project: 

1. Open an existing project or create a new one. 

  For more information on how to create a project see Create a project. 

2. On the Management page, on the Edit tab, in the Status group, click Lock project. 

3. On the Start tab in the Actions group click Save and close. 

 

Manage e-mail templates 
InLoox offers four different default e-mail templates (project request, project launch, project status 

and project conclusion). Those default templates can be edited by an InLoox admin in the InLoox 

options. The admin can also create individual templates (administrator permission needed!). 

1. Click on File and then on InLoox Now Options or InLoox PM Options to open the InLoox 

options. 

2. A new window will open. In the navigation area on the left click on Email Templates >> 

Templates. An overview to the already existing templates will open.  

 

In the overview you can (1) create a new e-mail template, (2) edit existing templates, (3) design e-

mail templates, (4) delete existing templates, (5) export templates or (6) import templates.  

  

(1) Create a new e-mail template 

1. To create a new e-mail template click on New. 

2. A new window will open. Here you can add information about the new template: 
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• Name the e-mail template. 

• Define rules for the e-mail fields Recipient, CC Recipient, BCC Recipient and Subject. 

Therefore, click on Fields and select a field from the dropdown-list like PROJECT_MANAGER. 

3. Afterwards click on OK to close the dialogue and save the new template. 

4. Now a new window will open (InLoox Report Designer), where you can edit the template 

individually. How to work with the InLoox Report Designer is explained in the chapter The InLoox 

Report Designer (The InLoox Report designer features are restricted for e-mail templates and not as 

extensive as for InLoox reports). When you have finished, click on Apply in the InLoox options to save 

your changes. 

  

(2) Edit e-mail templates 

For changing the general details (Name, rules) of an e-mail template select the template from the 

overview and click on Edit. A new window will open, where you can edit the general settings. When 

you have finished click on OK to close the window. Back in the InLoox options click on Apply to save 

your changes. 

  

(3) Design e-mail templates 

For changing the content of an already existing e-mail template select the template from the 

overview and click on Design. A new window will open (InLoox Report Designer), where you can edit 

the template content individually. How to work with the InLoox Report Designer is explained in the 

chapter The InLoox Report Designer (The InLoox Report designer features are restricted for e-mail 

templates and not as extensive as for InLoox reports). When you have finished, click on Apply in the 

InLoox options to save your changes. 

  

(4) Delete e-mail templates 

To permanently delete an e-mail template, select the template from the overview and click on Delete. 

Afterwards click on Apply in the InLoox options, to save your changes. 

  

(5) Export e-mail templates 

For saving e-mail templates on your computer locally, select a template from the overview and click 

on Export. Afterwards select the storage location and click on Save. When you have finished, click 

on Apply to save your changes. 

  

(6) Import e-mail templates 

For importing e-mail templates that are saved locally on your computer, click on Import. A new 

window will open where you select the template and click on Open. When you have finished, click 

on Apply to save your changes.  
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Manage mind map templates 
In the InLoox options you can edit mind map templates that you have created in the projects. For 

managing the mind map templates you need specific user permissions.  

 For more information on how to create a mind map template see: Export a mind map template 

  

1. Open the InLoox options by clicking on File in the upper left corner.  

2. Click on Mind Map and then click on Templates. On the right side you can see the area mind map 

templates: 

 

3. Click on OK or Apply to save your changes in the InLoox options.  

 

Manage notification templates (InLoox PM) 

Customize/Design notification templates 
You can individually customize the default notification templates. Therefore, you can use several 

fields. A field can be described as a placeholder for specific project information. You can edit the 

template by deleting or adding fields. 

To customize a template, proceed as follows: 
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1. Open the InLoox PM options and the notification templates area via the tree structure on the left 

(File >> InLoox PM options >> Notifications >> Templates). 

2. Select a template from the overview and click on Design, to open the notification designer. 

3. In the notification designer on the right, you will see the list of variables. Click on Variables, to see 

all available fields. 

  

The following fields are available to customize notification templates: 

Field name Description Content 

DisplayName Display name Name of tasks, planning elements, documents and 

project notes. 

Description Description Multiple-line description of planning elements. 

EndDate End planning 

element 

End date of the planning element. 

Flag Flag Highlighting for planning elements (none, green, yellow, 

red). 

GroupName Group Indicates the group of the planning element. The group 

can be a sort criterion or project cost center.  

IsProjectEndDateFixed Fixed 

deadline 

project 

Specifies whether the project has a fixed completion 

deadline. 

Link Linked 

documents 

Document paths (text-only) of the planning item. 

Location Location Free text field. States where the planning element is to 

be carried out. 

PlannerName Name of 

planner 

The name of the project planner, as stored in Outlook, 

e.g. Rita Meyer. 

Progress % completed Completion degree of a planning element in percent. 

Numeric value between 0 and 100. 
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Field name Description Content 

ProjectCategory Project 

category 

Category to which the project belongs. 

ProjectCompany Project 

company 

Free text field of the customer's name in the project. 

ProjectEnd Project end End date of the project. 

ProjectName Projekt 

Name 

Short, free description of the project. The project name 

can be used several times. 

ProjectNote Project name Multiple-line text for important project information.  

ProjectNumber Project 

number 

Unique number to identify the project. 

ProjectPriority Project 

priority 

Priority of the project. 

ProjectStart Projekt Start Start of the respective project. 

Projectstate Project 

status 

Specifies the state of project development 

PSPCode PSP code PSP code = Work Breakdown Structure code. Free text 

field for identification of phases and milestones in large 

projects. 

ResourceName Name of 

resource 

The name of the resource or recipient of the message, as 

stored in Outlook, e.g. Max Schiller. 

ResourceList Resources List of all involved resources of a planning element, 

including email address 

StartDate Start 

planning 

element 

Start date of the planning element. 
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Field name Description Content 

WorkAmount Work 

amount 

Work amount, which is done by the recipient resource of 

the planning element. 

 

Default notification templates 
InLoox PM provides you with various default notification templates that can be managed in the 

InLoox options (File >> InLoox PM options >> Notifications >> Templates). 

You can use the following InLoox PM default notification templates: 

Notification  Purpose 

Task - done InLoox PM sends this notification as soon as a task is marked as done.  

Task note - added This notification is created when a new task note is added to a task.  

Task - added This notification is created when a new task is added to one of the 

following project areas: Tasks, Mind Map or Planning.  

Task - resource 

added 

As soon as a resource is added to a specific task, this notification will be 

sent.  

Task - modified InLoox PM creates this notification as soon as a task is modified.  

Task  - resource 

removed 

InLoox informs you when a resource is removed from a task.  

Task - deleted This notification is created as soon as a task is deleted.  

Task note - deleted InLoox PM creates this message as soon as a task note is deleted.  

Document - added InLoox PM informs you about new project documents.  

Document - deleted InLoox PM informs you when a project document is deleted.  

Document - 

modified 

This notifications is created to notify about modified documents.  

Activity - 

Predecessor done 

You receive this notification when a planning element - that is a 

predecessor - is marked as done in the project plan.  
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Notification  Purpose 

Activity - added This notification informs about new activities in project plan.  

Activity - done As soon as an activity is marked as done in the project plan you receive this 

notification.  

Activity - modified This notifications informs about changes to activities in the project plan.  

Activity - deleted InLoox PM creates this message as soon as an activity is deleted from the 

project plan. 

Milestone - 

Predessecor done 

InLoox PM creates this message when a milestone - that is a predessecor - 

is marked as completed in the project plan.  

Milestone - done As soon as a milestone is marked as done in the project plan, you receive 

this notification.  

Milestone - added When new milestones are added to the project plan, this notification is 

created.  

Milestone - 

modified 

This notification informs about modified milestones.  

Milestone - deleted This notification informs about deleted milestones.  

Project note - added This message informs about new project notes.  

Project note  - 

removed 

You receive this notification as soon as a project note is removed.  

 

Define notification type 
Like we have already mentioned in the introduction chapter, you can define for each notification 

template different notification types. You can choose between: 1 E-Mail, 2 Task-Request and 3 

Meeting-Request.  

https://www.inloox.com/support/knowledge-base/online-help/inloox-for-outlook/9-0/all-support-articles/inloox-options/manage-notification-templates-inloox-pm/introduction-to-notification-templates/
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You can choose only one notification type as well as several notification types at the same time: 

1 E-Mail 

By selecting E-Mail as the notification type, the resource will be notified via e-mail. 

2 Task-Request 

By selecting Task-Request as the notification type, the resource will receive a task-request as 

notification. 

3 Meeting-Request 

By selecting Meeting-Request as the notification type, the resource will receive a meeting-request as 

notification.  

 

Introduction to notification templates 
To manage InLoox PM notification templates, open the InLoox options: 

1. We start from your Outlook inbox. Click on File in the left corner and afterwards on InLoox PM 

options. 

2. The InLoox PM options will open in a separate window. In this window select Notifications >> 

Templates in the tree structure on the left, to get to the notification template overview.  
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3. In the overview you can see all notification templates structured into tasks, documents and 

planning. Additionally, you can define the notification type for each template by using the three icons 

on the right side (see screenshot). 

4. Furthermore, you have the possibility to design, export and download notification templates: 

 

Design notification templates 

To edit the content of an InLoox notification template, select the template from the overview and 

click on Design. A new window will open, where you individually design the template. How to work 

with the InLoox notification designer, will be explained in the next chapter: Customize notification 

templates 

When you have finished, save your changes by clicking on Apply in the InLoox options. 

 

Export notification templates 

To save a notification template locally on your computer, select the template from the overview and 

click on Export. Afterwards select the storage place in the new window and click on Save. When you 

have finished, save your changes by clicking on Apply in the InLoox options. 

 

Download notification templates 

To download notification templates from the InLoox website, click on Download. You will we 

transferred to the InLoox website, where you select the language (German/English) for your 

notification templates.  

 

Manage project categories 
To manage InLoox PM notification templates, open the InLoox options: 

1. We start from your Outlook inbox. Click on File in the left corner and afterwards on InLoox PM 

options. 

2. The InLoox PM options will open in a separate window. In this window select Notifications >> 

Templates in the tree structure on the left, to get to the notification template overview.  

https://www.inloox.com/support/knowledge-base/online-help/inloox-for-outlook/9-0/all-support-articles/inloox-options/manage-notification-templates-inloox-pm/customize-notification-templates/
https://www.inloox.com/support/knowledge-base/online-help/inloox-for-outlook/9-0/all-support-articles/inloox-options/manage-notification-templates-inloox-pm/customize-notification-templates/
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3. In the overview you can see all notification templates structured into tasks, documents and 

planning. Additionally, you can define the notification type for each template by using the three icons 

on the right side (see screenshot). 

4. Furthermore, you have the possibility to design, export and download notification templates: 

 

Design notification templates 

To edit the content of an InLoox notification template, select the template from the overview and 

click on Design. A new window will open, where you individually design the template. How to work 

with the InLoox notification designer, will be explained in the next chapter: Customize notification 

templates 

When you have finished, save your changes by clicking on Apply in the InLoox options. 

 

Export notification templates 

To save a notification template locally on your computer, select the template from the overview and 

click on Export. Afterwards select the storage place in the new window and click on Save. When you 

have finished, save your changes by clicking on Apply in the InLoox options. 

 

Download notification templates 

To download notification templates from the InLoox website, click on Download. You will we 

transferred to the InLoox website, where you select the language (German/English) for your 

notification templates.  
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Manage report templates 
Attention: To administrate report templates you should be InLoox admin or you will need the 

permission “Create and edit report templates”. For more information on user permissions see also 

“Set user permissions”.  

Generally, report templates can be managed in the InLoox options: 

1. Open Outlook and click on Home in the upper left corner. Select InLoox PM Options from the 

list. 

2. A new window will open. Select Reports >> Templates on the left side of the window. An 

overview of the report templates will be shown.  

 

  

(1) Create a new report template 

1. To create a new report template, open the InLoox options and click on Reports >> Templates.  

2. Click on New and another window is going to open. 
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3. In this window you can define all important aspects of the new report: 

• Name the report. 

• Choose between Inloox 9 and older InLoox versions. InLoox 9 provides you with a new 

version of the report designer. You can still create and edit reports from InLoox 6, 7, 8 but this 

is going to change in future InLoox versions. 

• Define from which areas of a project you want to have access to this report template.  

4. Afterwards click on OK to close the window and to save your settings.  

5. Now the report designer is going to open. There you can design the new template individually. For 

more information on how to use the report designer, see “InLoox report designer”. When you have 

finished, click on Apply in the InLoox options, to save your changes. 

   

(2) Edit report templates 

If you want to change the general settings of a template (like name or visibility), select the template 

in the overview and click on Edit. A new window is going to open. There you can edit all important 

settings:  

• You can change the name of the template. 

• Choose between InLoox 9 and older InLoox versions. InLoox 9 provides you with a new 

version of the report designer. You can still create and edit reports from InLoox 6, 7, 8 but this 

is going to change in future InLoox versions. 

• Define from which areas of a project you want to have access to this report template.  
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When you have finished, click on OK and the window is going to close. Back to the InLoox options 

click on Apply to save your changes. 

  

(3) Design report templates 

To change the content of an already existing report template, select the template in the overview and 

click on Design. The InLoox report designer is going to open. For more information on how to use the 

report designer, see “InLoox report designer”. When you have finished, click on Apply in the InLoox 

options, to save your changes. 

  

(4) Delete report templates 

To delete a report template, select the template in the overview and click on Delete.  

  

(5) Export report templates 

To save a report template on your computer, select the template in the overview and click on Export. 

Afterwards, you can choose the storage location and then click on Save. When you have finished, click 

on Apply in the InLoox options, to save your changes.  

  

(6) Import report templates 

To import a report templates which is saved on your computer, click on Import and select the 

template from your computer. Afterwards, click on Open. When you have finished, click on Apply in 

the InLoox options, to save your changes.  

  

(7) Download report templates 

On the InLoox website you can download several standard report templates: 

1. Click on Download in the InLoox options and the InLoox website is going to open. 

2. There click on Templates and select the English version of the report templates. 

3. A zip-file will be downloaded and saved on your computer in the download folder. 

4. Open this folder by using the windows explorer and double-click on the zip-file to open it. 

Copy the templates and save them to another place on your computer. 

5. Return to the InLoox options >> Reports >> Templates and click on Import. 

6. Select one of the saved templates from your computer and click on Save. 

7. Proceed like this for all other templates. 

8. When you have finished, click on Apply in the InLoox options, to save your changes. 
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Open the InLoox options 
In the InLoox PM options, you can make changes to the basic parameters and you can set up 

permissions in InLoox PM. 

The administrator opens the InLoox PM Options as follows: 

1. Click the File tab. 

2. Click InLoox PM Options in the navigation pane. 

 

 Users require administrator permissions to change global settings. For more information, see Set 

up permissions. User settings can be changed by any user. 

 

Set user permissions 
In InLoox PM, you can configure finely structured and freely definable permissions. So, you can clearly 

define responsibilities and make sure that only authorized users gain access to sensitive data. 

You can set permissions in InLoox PM Workgroup and Enterprise Server in the InLoox PM options. 

 InLoox PM is delivered without permissions being set. So, every user can see and change all 

permissions. This might be a security risk. 

Overview of role and account-based security architecture 
In InLoox PM, you can select role-based and user-based permissions. 

Role permissions are defined according to the function carried out by each person involved in the 

project, be it as project manager, team member, customer, partner or any other activity. InLoox PM 

then assigns the correct permission to each person assuming a given role. 

 User account oriented permissions apply to all projects. This allows, for example, 

company management to look at all current and concluded projects, whereas practical responsibility 

remains in the hands of the project manager and team. 

User account oriented permissions require a Windows Server with Active Directory or InLoox PM 

contacts. Role permissions additionally require Exchange Server. 

To open the permissions please follow these steps: 
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1. Open the dialog box InLoox PM Options. 

 For more information on how to open the InLoox PM options, please see Open the 

InLoox PM options. 

2. Under Permissions, click Permissions. On the right side, you see the Permissions section. 

 

Permission 

Mode Remarks 

User-based 

permissions 

• Permissions based on Windows and InLoox user accounts. Active 

directory accounts (in domain mode) and local Windows and InLoox user 

accounts (in workgroup mode) are supported. 

• Apply across all projects and on the entire database. 

 InLoox PM does not support Windows groups at this time. 

Role-based 

permissions 

• Users acquire permissions by assuming a role in a project. Project 

members are all persons who are listed in the project on the 

Management page as "In Charge". 

• Possible roles: Project manager, Team member, Customer, Partner, Other. 

• Microsoft Exchange Server or InLoox contacts are required. 

 Persons are identified by their Windows or InLoox Security 
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Permission 

Mode Remarks 

Identifier, or SID, and the Windows X400 address, or Exchange address. 

Persons with the same X400 address have the same role-based 

permissions in InLoox PM. If this is not what you want, please deactivate 

the role-based permissions entirely by removing all permissions for all 

roles. 

Examples InLoox PM combines role-based and user-based permissions. The permission 

records of both modes are added. The example below illustrates a common 

configuration: 

• The role "team" may "read projects " and "read budgets". 

All other roles are ignored for the sake of clarity. 

• The user account "Gordon Newman" is authorized to "edit projects " and 

"edit budgets". 

For more information about permissions, see List of permissions. 

• "Gordon Newman" is part of the "team" in the project "Product 

Development" 

• There are three other projects in which "Gordon Newman" is not involved 

and therefore does not have the role "team" 

 Consequently, these permissions apply to Gordon Newman: 

• He may read and edit the project "Product Development". He may also 

read and edit budgets in this project. Gordon Newman has these 

permissions in all projects in which he is in the team role. 

• "Gordon Newman" cannot see any projects in which he is not a team 

member. He does not have the permission to "read projects", which is a 

prerequisite for all other permissions. Thus, Gordon Newman has no 

permissions for any other projects. 

The following permissions apply to all other team members involved in the 

project "Product Development": 

• They may read the project "Product Development" and read, but not edit 

budgets. They do not have the permission record of the account "Gordon 

Newman". 

• Persons who are team members in other projects than "Product 

Development" can see, in contrast to Gordon Newman, a number of 

projects, but may not edit any of them. 

InLoox PM permissions are very flexible and allow a wide variety of scenarios to 

be covered without high administration effort. 
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Set user-based permissions 
Set user-based permissions: 

• Set permissions for a user  In the User-based permissions section, click New. 

1. In the Permissions dialog box, click the Arrow  to select the user. 

2. Choose from the drop-down list between Active Directory user, Exchange 

user or InLoox PM user.  

• Active Directory user     

• In the Select User dialog box, click Object Types. 

 You can also use this button  to open the Select 

User dialog box. 

• In the From this Location box, click Locations and select Entire 

Network. Click OK. 

• Type the required user name into the Enter the object name to 

select field. 

• Click Check name. A user name that has been recognized by 

Windows is shown underlined. 

• Click Advanced..., if you need to search for a user name. 

• Click OK. 

• Exchange user  

In the Select Contact dialog box, select an address book and then the respective name from the list. 

Click OK. 

 In the Select Contact dialog box, use the feature Search by Skill. For more information, 

see Assign skills to resources. 

• InLoox PM user   

 In the Select Contact dialog box, select an InLoox PM address book and then 

the respective name from the list. Click OK. 

 For more information on how to create an InLoox PM account, 

see Create an InLoox PM account. 

3. Select the permissions for the respective user from the Permissions list. 

 For more information about permissions, see List of permissions. 

4. Click OK. 

• Edit user permissions  Choose one user from the list and click Edit. Click OK after you have 

made all changes you want. 

• Remove user permissions  Choose one user from the list and click Delete. 

 

Set role-based permissions 
Please follow these steps to set role-based permissions:   
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  Role-based permissions are only active if there is at least one user-based administrator 

permission. 

1. In the Options dialog box, in the Role-based permissions section, click Edit to change the 

selected role-based permission. 

2. Select the permissions for the role from the Permissions list. 

 For more information about permissions, see List of permissions. 

3. Click OK. 

 

Task settings 
In the InLoox options, the InLoox administrator can change the structure of the Kanban board for the 

entire project platform, manage task templates and set the update interval in InLoox. 

Customize the Kanban board 
The InLoox Administrator can change the structure and the appearance of the Kanban board in the 

InLoox options. 

Please follow these steps to do this: 

1. Click in Outlook on the File tab in the upper left corner, then on  

2. This will open the Options dialog. Click in the navigation pane on the left on Tasks, Task 

Statuses. 

3. In the section on the right, you’ll see all the names and the assigned colors of the current 

columns of the Kanban board that apply to all of your projects in your database. By default, 

your Kanban board contains three columns with the statuses To Do, In Progress, Done. 

 

4. You can now edit the existing columns by changing their name, assigning another color or 

changing the order of the columns on the board. Click on the status that you want to edit. 

5. To change the order of the Kanban columns, move the column to the desired position by 

using the arrow buttons  (dthe top status equals the column on the far left, the bottom 

status equals the column on the far right). 
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6. To change to assigned color or the name of the column, click on the status that you want to 

change, then click on Edit. 

 
 Make all of your changes, then click on OK. 

7. To create a new status click on the New button. You will see the same dialog as shown in 

paragraph 6. Now, name the new status, assign a color and confirm with OK. Use the arrow 

buttons     to position the status on your Kanban board. 

8. When you have made all of your changes to the Kanban board, click on OK in the Options 

dialog. The changes now apply to the entire project platform. 

 

Manage task templates 
You can create, save and export task templates in every project. The InLoox Administrator can 

rename, delete, export and import existing templates in the InLoox options for the entire project 

platform. 

Please follow these steps to administrate task templates: 

1. In Outlook, click on the File tab, then on Options under InLoox. 

2. This will open the Options dialog. Click in the navigation pane on the left on Tasks, Templates. 

3. Now you will see all task templates that are currently available on your InLoox database in 

the section on the right. 

4. To rename a task template, click on the name of the template, then on Rename. 
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You can enter a new name and confirm with OK. 

5. To remove a task template permanently from the database and from all InLoox projects, mark 

the template, then click on Delete. 

6. To export an existing template in order to save it on your computer or file server, mark the 

template and click on Export. Now you can save the template. 

7. You can also import task templates from your computer or your file server. After importing 

them in in the InLoox options, they are available to all users on the project platform. 

8. Click on Download to load and use pre-made templates from the InLoox website. 

9. When you are done editing your task templates, click on OK in the Options dialog. The 

changes now apply to the entire project platform. 

 

Set the update interval 
1. Open the InLoox options by clicking on the File tab in the upper left corner, then on the 

InLoox options in the navigation pane on the left. 

2. In the InLoox options, click in the navigation pane on the left on General Options, More 

Options. 
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3. On the bottom right, you can set the update interval in InLoox in minutes for the entire 

project platform. 

4. Confirm with OK. 

 

User permission options 
The following permissions apply to the multi-user versions of InLoox PM. Permissions for the actions 

listed can be assigned to users or roles. 

Description Permission 

Restriction or 

Prerequisite 

Create 

projects 

User has the right to create new projects. Only available with 

user-based permissions 

Create project 

request 

With this permission the user can add a new project 

request for the release, in case he does not have 

project permissions. 

Prerequisites: InLoox 

PM Enterprise Server, 

no project permissions 

Release 

project 

request 

Right to release the created project requests. Prerequisites: InLoox 

PM Enterprise Server, 

project permissions 

Read projects • Project visible in the InLoox PM project list.  

• Project can be opened. 

None 
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Description Permission 

Restriction or 

Prerequisite 

• Project can be exported if the right to use 

existing reports is granted. 

Access list Right to read the list of a project. Prerequisite: Read 

projects 

Access mind 

maps 

Right to read all mind maps of a project. Prerequisite: Read 

projects 

Access work 

packages 

Right to read all work packages in the project Prerequisite: Read 

projects 

Access 

planning 

Right to read all planning elements of a project. Prerequisite: Read 

projects 

Access time 

tracking 

Right to read all time tracking entries of a project Prerequisite: Read 

projects 

Access own 

time tracking 

entries 

Right to read all own time tracking entries of a project. Prerequisite: Read 

projects 

Access 

documents 

Right to open and read all documents of a project. Prerequisite: Read 

projects 

Access 

budgets 

Right to read all budgets, budget positions and the 

budget overview of a project. 

Prerequisite: Read 

projects 

Edit projects Project can be changed. This right is a prerequisite for 

all actions which allow users or roles to modify data. 

Prerequisite: Read 

projects 

Edit 

management 

Right to change the project master data on the 

Management page. 

Prerequisite: Edit 

projects 

Edit project 

contacts 

Project contacts can be added, changed or deleted. It 

allows the user to control the roles of persons in a 

project. 
 

Prerequisites: 

• Edit projects 

• Edit 

Management 
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Description Permission 

Restriction or 

Prerequisite 

Add project 

notes 

Allows you to create and change project comments on 

the Management page.  

Prerequisites: 

• Edit projects 

• Edit 

Management 

Access project 

notes 

Right to read other team members' project notes on 

the Management page.  

Prerequisite: 

• Read project 

Delete own 

project notes 

Allows you to remove your own project comments on 

the Management page, but not to remove other users' 

project comments.  

Prerequisites: 

• Edit projects 

• Edit 

Management 

Lock projects Project can be locked for other users. Users without 

the respective permission may not edit locked projects 

and cannot remove the lock. 

Prerequisites: 

• Edit projects 

• Edit 

Management 

Edit list Right to modify the entries in the list of one project. Prerequisite: Read 

projects 

Edit mind 

maps 

Allows adding, changing and deletion of all mind maps 

of a project. 

Prerequisite: Edit 

projects 

Edit work 

packages 

This permission allows you to add, modify and remvoe 

work packages. 

Prerequisite: Edit 

projects 

Edit planning Allows adding, changing and deletion of all planning 

elements of a project. 

Prerequisite: Edit 

projects 

Edit time 

tracking 

Allows adding, changing and deletion of all time 

tracking entries of a project. 

Prerequisite: Edit 

projects 

Edit own time 

tracking 

entries 

Allows adding, changing and deletion of own time 

tracking entries of a project. 

Prerequisite: Edit 

projects 
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Description Permission 

Restriction or 

Prerequisite 

Edit 

documents 

Allows adding, changing and deletion of all documents 

in the document list of a project. 

Prerequisite: Edit 

projects 

Edit budgets Allows adding, changing and deletion of all budgets 

and budget assets of a project. 

Prerequisite: Edit 

projects 

Delete 

projects 

Delete a project. None 

Create 

address books 

User has the right to create new address book. None 

Read address 

books 

Access all address books. None 

Edit address 

books 

Allows modifying address books. Prerequisite: Read 

address books 

Read own 

address books 

Access own address books Prerequisite: Create 

adderss books 

Edit own 

address books 

Right to change own address books Prerequisites: 

• Create address 

books 

• Read own 

address books 

Delete own 

address books 

Allows to remove own address books and other users' 

address books. 

Prerequisites: 

• Create address 

books 

• Read own 

address books 

Use existing 

reports 

All reports can be used. The InLoox PM report 

generator filters the data for which the user does not 

have permission out of the report (e.g. if no right to 

read budgets has been granted, no budget data will be 

included in the exported reports.) 

None 
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Description Permission 

Restriction or 

Prerequisite 

Create and 

edit report 

templates 

Allows the creation, changing and deletion of report 

templates. 

Only available for user-

based permissions 

Administrator Controls access to master data maintenance and 

administrator functions. These include the following 

menu commands in the InLoox PM Ribbon (in Outlook 

2007 InLoox PM Toolbar) and Options: 

• Edit planning templates  Right to rename and 

delete InLoox PM planning templates. 

• Edit budget assets  Right to create, change 

and delete InLoox PM budget assets. 

• Edit budget state  Right to create, change and 

delete InLoox PM budget states. 

• Edit notifications  Right to change Notification 

templates. 

• Edit categories  Right to create, change and 

delete InLoox PM categories. 

• Edit custom fields  Right to create, change and 

delete custom fields. 

• Remove project locks  Right to remove data 

record locks. 

• Recycle projects  Right to restore or 

permanently remove deleted projects. 

• Licenses  Right to add and delete InLoox PM 

license keys. 

• Options  Right to change the InLoox PM 

options. Incorporates the right to change 

permissions. 

Only available for user-

based permissions 

 

Interaction between InLoox and Outlook 
You don’t need to open InLoox via the InLoox now or InLoox PM tab, to use several important InLoox 

features. Because of the integration in Microsoft Outlook you can directly access some features from 

your Outlook inbox. Furthermore you can synchronize InLoox with your Outlook calendar, tasks and 

address book. InLoox and Outlook combine all relevant project management tasks on one central 

platform to efficiently support your daily work routine.  
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How to use e-mails in InLoox 
While you are working in Outlook you can access some selected InLoox features via the Start tab. This 

allows you to further use specific Outlook elements in InLoox. The following InLoox icons are always 

available on the start tab regardless if you are working in your Outlook inbox, calendar or address-

book. 

 

By using those icons you can: 

1. Create either a personal or project-related task from a selected e-mail 

2. Book a time tracking entry for the selected item 

3. Attach the e-mail as a document to a project 

  

1. Create a task from an e-mail 

You can either create a personal or a project-related task from an e-mail. To create an InLoox task 

from an e-mail, proceed as follows: 

1. Select an e-mail from your Outlook inbox. 

2. In the Ribbon on the Home tab click on the Create task button. Afterwards select a project from 

the dropdown-list (create project related-task) or select Create free task (personal task).  

 

3. A new window is going to open. There you can enter all important information regarding the task. 

By default the subject of the e-mail is used as the task name and the e-mail content is used in the 

description. Both can be changed in the Task Details. Here you proceed as usual when creating a new 

task in InLoox: 

• Name: By default the subject of the e-mail used for the task name. If wished, you can rename 

the task. 

• Description: By default this area contains the original e-mail content. You can change the 

description, add important information or format the text for a better clarity. 

• Effort: Here you enter the estimated effort in work days, hours or minutes. 

• Resource: By clicking on the small arrow you can add one of the recent used resources. By 

clicking on the three points next to the arrow you can choose a resource from your contacts. 

• Start and End: Add start and end date and time for the task. 

• Documents (only personal tasks): If you are creating a free (personal task) you can link to 

already existing documents or you can add a new item. 
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• Add document to project (only project-related tasks): If you are creating a project-related 

task you can decide in the operation area whether you want to add documents to your 

project or not. Therefore, you can choose from the following options: Do not add element, 

Element including attachments, Element without attachments, Attachments only or Element 

and attachments separately. In the Sub Folder area you can add the document(s) to an 

already existing sub folder or create a new one.     

• Notifications (only project-related tasks): If you are creating a project-related task you have 

to possibility to notify one or more resources via e-mail about the new task.  
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4. Additionally, you can switch to the Comments tab where you can add further information. After 

adding all important information to the task, click on OK to save the task. A small note at your e-mail 

will indicate that you are using this e-mail as an InLoox element.  

  

2. Book a time tracking entry for an e-mail 

You can also book a time tracking entry directly from your inbox. Therefore, proceed as follows: 

1. Select an e-mail from your Outlook inbox. 

2. Click on Track Time in the Start tab. In the dropdown-list select the project where you want to 

store the time tracking entry.  
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3. A new window will open. Here you can add all important information regarding the time tracking 

entry: 

 

Moreover you can decide whether you want to assign the time tracking entry to a specific task or 

activity of the project (use the small arrow next to task for changing between task and activity). You 

can also select a group (design, production, consulting) for the entry. Groups can be created in 

the InLoox options by any InLoox admin. 

  

3. Attach the e-mail as a document to a project 

InLoox allows you to quickly assign e-mails to the document storage of a project – directly from your 

Outlook inbox. A reference will indicate to which project the e-mail has been assigned. 
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1. Select the e-mail in your Outlook inbox. 

2. In the ribbon on the Home tab click on Save Email. Afterwards select from the dropdown-list the 

project where you want to save the e-mail. 

 

3. A new window will open. There you can change several settings regarding the document. Those 

settings can be viewed and changed later (Right click on the document in the project >> Edit). The 

following settings are available: 

• Operation: Decide how you want to save the e-mail as a document: Element including 

attachments, Element without attachments, Attachments only or Element and attachments 

separately. 

• Subfolder: You can save the e-mail in a subfolder of your project. If there is no suitable 

subfolder for the e-mail yet, you can create a new subfolder directly in the dialog. 

• Status: You can also assign a status to the e-mail or add a new note for other team members. 

• Links: Create a link to a project element in the mind maps, tasks, planning or time tracking 

section. 

 

4. When you have finished click on OK and the e-mail will be saved a document of the selected 

project. Double click on the e-mail in your inbox and a reference will indicate that it has been 

assigned to a project. If the assigned email was addressed to several recipients, each of them sees to 

which project this email has been assigned. This prevents duplicating the email as a project-

document. For this to work, the recipients have to be working on the same InLoox database.  
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The following table gives an overview to the benefits and drawbacks of the different operation 

possibilities: 

Method Action Pros & cons 

Element with 

attachment 

InLoox PM assigns the email and 

the attachment in file form to a 

project. (Outlook does the same). 

 Email and attachment are stored 

together. 

 The document list shows whether the 

element is carrying an attachment but no 

details of the attachment, such as name or 

type. 

Element 

without 

attachment 

InLoox assigns only the email to 

the project. All attachments will 

be removed. 

 Saves storage space. 

Attachments can neither be displayed 

nor saved in InLoox PM. 

Attachment 

only 

InLoox PM assigns only the 

attachment to the project. The 

email is discarded. 

 Removes superfluous correspondence. 

 Correspondence (including notes) can 

neither be read nor saved in InLoox PM. 

Element and 

attachment 

separately 

InLoox PM assigns the email and 

attachment to the project 

separately 

 Correspondence is kept. Attachments 

can be seen in the document list with name 

and type. 

 Relationship between correspondence 

and attachments is lost. 
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Synchronization between InLoox and Outlook 
Synchronization of InLoox planning elements with Outlook calendar or Outlook task list  

In the InLoox planning you can synchronize single planning elements with your Outlook calendar or 

the Outlook task list. As a huge benefit of this feature, any changes to your project plan are 

automatically synchronized with Outlook. 

1. We start from your Outlook inbox. Open the InLoox now or InLoox PM tab and click on Projects to 

open the project overview. Double click on a project to open it. 

2. Now click on Planning in the Home tab. 

3. Select the planning element (milestone, activity, task) – that you want to synchronize with Outlook 

– from your project plan. Then open the Edit tab and click on Synchronize With. 

4. Here you can choose between two options: 

• Outlook Task List: A new task is created for the selected planning element in your Outlook 

task list. 

• Outlook Calendar: A new entry in the Outlook calendar is created for the selected planning 

element. 

All changes that you make to the project plan and affect the synchronized element are automatically 

synchronized with Outlook after saving. 

  

Synchronization of InLoox tasks with Outlook calendar or Outlook task list 

In the InLoox task overview you can synchronize single tasks with the Outlook calendar or the 

Outlook task list. As a huge benefit of this feature, any changes to your tasks are automatically 

synchronized with Outlook. 

1. We start from your Outlook inbox. Open the InLoox now or InLoox PM tab and click on Tasks to 

open the task overview. 

2. Select the task– that you want to synchronize with Outlook – from the task overview. Then open 

the Start tab and click on Synchronize With. 

3. Here you can choose between two options: 

• Outlook Task List: A new task for the selected InLoox task is created in your Outlook task list. 

• Outlook Calendar: A new entry in the Outlook calendar is created for the selected task. 

All changes that you make to your tasks and affect the synchronized Outlook element are 

automatically synchronized with Outlook after saving.  

 

InLoox email templates 
Using pre-defined InLoox text elements for your e-mails speeds up your project communication. 

InLoox e-mail templates provide pre-defined and project-related information for different e-mails. 

You can add new e-mail templates as well as modify the default templates in the InLoox options.  
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Work with E-mail templates 
Proceed as follows to use the InLoox e-mail templates: 

1. Open a new email. 

2. Click on Email Templates on the Message tab. Select an e-mail template from the 

dropwdown-list. 

3. The text template will be added to your email. In the template defined recipients will be 

inserted. 

4. Now you can edit recipients or the e-mail content. When you have finished click on Send. 

 

Manage E-mail templates 
InLoox offers four different default e-mail templates (project request, project launch, project status 

and project conclusion). Those default templates can be edited by an InLoox admin in the InLoox 

options. The admin can also create individual templates (administrator permission needed!). 

1. Click on File and then on InLoox Now Options or InLoox PM Options to open the InLoox 

options. 

2. A new window will open. In the navigation area on the left click on Email Templates >> 

Templates. An overview to the already existing templates will open.  

 

In the overview you can (1) create a new e-mail template, (2) edit existing templates, (3) design e-

mail templates, (4) delete existing templates, (5) export templates or (6) import templates.  

  

(1) Create a new e-mail template 

1. To create a new e-mail template click on New. 

2. A new window will open. Here you can add information about the new template: 

• Name the e-mail template. 

• Define rules for the e-mail fields Recipient, CC Recipient, BCC Recipient and Subject. 

Therefore, click on Fields and select a field from the dropdown-list like PROJECT_MANAGER. 

3. Afterwards click on OK to close the dialogue and save the new template. 
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4. Now a new window will open (InLoox Report Designer), where you can edit the template 

individually. How to work with the InLoox Report Designer is explained in the chapter The InLoox 

Report Designer (The InLoox Report designer features are restricted for e-mail templates and not as 

extensive as for InLoox reports). When you have finished, click on Apply in the InLoox options to save 

your changes. 

  

(2) Edit e-mail templates 

For changing the general details (Name, rules) of an e-mail template select the template from the 

overview and click on Edit. A new window will open, where you can edit the general settings. When 

you have finished click on OK to close the window. Back in the InLoox options click on Apply to save 

your changes. 

  

(3) Design e-mail templates 

For changing the content of an already existing e-mail template select the template from the 

overview and click on Design. A new window will open (InLoox Report Designer), where you can edit 

the template content individually. How to work with the InLoox Report Designer is explained in the 

chapter The InLoox Report Designer (The InLoox Report designer features are restricted for e-mail 

templates and not as extensive as for InLoox reports). When you have finished, click on Apply in the 

InLoox options to save your changes. 

  

(4) Delete e-mail templates 

To permanently delete an e-mail template select the template from the overview and click on Delete. 

Afterwards click on Apply in the InLoox options, to save your changes. 

  

(5) Export e-mail templates 

For saving e-mail templates on your computer locally, select a template from the overview and click 

on Export. Afterwards select the storage location and click on Save. When you have finished, click 

on Apply to save your changes. 

  

(6) Import e-mail templates 

For importing e-mail templates that are saved locally on your computer, click on Import. A new 

window will open where you select the template and click on Open. When you have finished, click 

on Apply to save your changes.  
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Lists 

Create and edit a to-do list 
With the list feature, you can create check lists and to do lists for your project and structure project 

information in a very early stage of your project, without having to create tasks or a timed project 

plan. 

You can only create project-related lists, i.e. lists that belong to an InLoox project. 

This is how you create a new list for your project:  

1. Open the project to which you want to add a new list. 

2. In the project, on the Start tab, click on Lists in the Ribbon. 

 

3. On the Edit tab, click on New list. 

4. In the side panel on the right, you can name your list. 

 

5. If you want to create a personal check list with your own to-dos, then activate the Visible 

only to me checkbox. When you have activated the checkbox, other team members aren't 

able to see this check list. 

6. In the Fields area, you can now build your list out of different field types. You can use the 

following field types: 

• Text 

• Date 
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• Integer 

• Decimal number 

• Checkbox 

7. Click on New field to add more fields to your list and name them however you like. 

8. Use the arrows to change the order of the fields in your list, use the cross to delete a field 

from your list. 

9. Click on New link in the right side panel if you want to link your list to one of the following 

elements of your project: 

 

• Mind map nodes 

• Tasks 

• Planning elements in the Gantt chart 

• Time tracking entries 

• Documents 

• Budgets 

• Budget positions 

With a click on the regarding link, you can navigate directly to the corresponding element in the 

project, e.g. to the mind map node the list belongs to. 

10. Now, add more entries to your list. Click on the Edit tab on New entry. You can type the text 

directly in the list into the line. 

Example: Classic check list with checkbox and text 
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Create a classic check list to tick boxes with the field types checkbox and text. 

Example: List with dates 

 

Create a list with dates with the field types date and text. Click on the little arrow in the date area of 

the list to select a date for each list entry. 

On the View tab, you can change between a card an a list view. These views only have an impact on 

what your list looks like, they do not alter the content. 

On the tabs on the bottom left, you see all lists that have already been added to your project. You can 

add as many lists to your project as you like and navigate from list to list there. Click on the right 

mouse button to open a context menu with which you can create new lists and edit or delete existing 

lists. 

 

In the Ribbon, on the Edit tab, click Edit list to also change the list you are currently on. 

 

Create a list template 
You can set up list templates for checklists that are relevant for all your various projects. 

Create a checklist first, that you would like to use in a project of your choice. 

 To learn how to create a new list see Create a new list. 
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Do the following: 

1. Save the list as usual. To export the list as a template, click on the Export Template button on 

the Templates tab. You can save the list for further use as an InLoox list template file or as a 

CSV- or XML-file on your computer or your file server. 

2. To use the list in another project, please open the project in which you want to use the list, 

then click on the Lists button on the Start tab, then click on the Templates tab. 

3. Click on the Import Templates button and select the regarding list template from your 

computer or your file server. 

4. Alternatively, you can save the list template directly in InLoox PM for Outlook. To do so, 

please open the list that you want to save as a template and click on the Templates tab on 

the Save Template button in the Ribbon. 

Now, the list template is available directly in InLoox PM for Outlook in the Lists section in the project 

on the Templates tab. 

 

Mind Maps 

Create a mind map 
Visually collect and organize your ideas in mind maps. Thereby you get an overview over all ideas, 

concepts and drafts. When creating a mind map we differentiate between two approaches: 

• Plan-based approach: The main nodes of the mind map correspond with the project phases 

(Top-Down). 

• Task-based approach: The main nodes of the mind map correspond with the tasks of the 

project (Bottom-Up). 

How to create a plan-based mind map 
Visually collect and organize your ideas in mind maps to you get an overview over all ideas, concepts 

and drafts. When you are using the plan-based approach, you should ensure that the main nodes of 

your mind map correspond with the project phases (Top-Down).  

1. Open an existing project or create a new one. 
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2. To create a new mind map click on Mind Maps on the Start tab. 

3. To name the mind map right-click somewhere in the mind map area and click on Edit Mind Map in 

the context menu. A new window will open. Type a name for your mind map in the Name field.  

 

4. Create as many nodes as needed. Following the plan-based approach, the main nodes correspond 

with the project phases. To create a node, right-click on the node in the middle and click on New 

Node in the context menu. 

5. By default a new node is created as a sub-node of the marked node. 

 

6. To create sub-nodes select a node and right-click to open the context menu. Click on New Node in 

the context menu. A sub-node that is directly connected to the selected node appears in the mind 

map. Name the sub-node and push enter.  
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7. To edit a node, right-click on it and choose Edit in the context menu. 

8. A side panel opens on the right side. Here you can save and edit additional information. 

 

9. Create as many nodes as needed and position them by drag-and-drop. 

10. Format the mind map and edit the background color of a node or add a symbol to it. For more 

information on formatting see Selected Mind Map features.  

 

11. When you are finished you can copy the mind map to the planning. Therefor see the following 

chapter: Copy a mind map to the planning 

 

Create another mind map 

To create another mind map in the same project click on the mind map symbol in the lower menu bar 

or use the keyboard shortcut Ctrl+M. 
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How to create a task-based mind map 
Visually collect and organize your ideas in mind maps to you get an overview over all ideas, concepts 

and drafts. When you are using the task-based approach, you should ensure that the main nodes of 

your mind map correspond with the tasks of the project.  

1. Open an existing project or create a new one. 

2. To create a new mind map click on Mind Maps on the Start tab. 

3. To name the mind map right-click somewhere in the mind map area and click on Edit Mind Map in 

the context menu. A new window will open. Type a name for your mind map in the Name field.  

 

4. Create as many nodes as needed. Following the task-based approach, the main nodes correspond 

with the tasks of the project. To create a node, right-click on the node in the middle and click on New 

Node in the context menu. 

5. By default a new node is created as a sub-node of the marked node. 

 

6. To create sub-nodes select a node and right-click to open the context menu. Click on New Node in 

the context menu. A sub-node that is directly connected to the selected node appears in the mind 

map. Name the sub-node and push enter.  
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7. To edit a node, right-click on it and choose Edit in the context menu. 

8. A side panel opens on the right side. Here you can save and edit additional information. 

 

9. Create as many nodes as needed and position them by drag-and-drop. 

10. Format the mind map and edit the background color of a node or add a symbol to it. For more 

information on formatting see Selected Mind Map features.  

 

11. When you are finished you can create tasks from the mind map. Therefor see the following 

chapter: Create tasks from a mind map. 

 

Create another mind map 

To create another mind map in the same project click on the mind map symbol in the lower menu bar 

or use the keyboard shortcut Ctrl+M. 
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Selected Mind Map features 

Open a project and click on Mind Maps   on the start tab to open the Mind Map page. InLoox 

offers you various features for creating and designing mind maps.  

  

1. Features on the Edit tab 

 

2. Features on the Templates tab 
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3. Features on the Format tab 

The Format tab allows you to customize font, background and frame color of selected nodes. 

Additionally, you can use further helpful features: 

 

 

Create tasks from a mind map 
You can create tasks from existing nodes of your mind map. This procedure is most suitable when you 

have created the mind map following the task-based approach. Which means the main nodes of your 

mind map correspond with the tasks of the project (Bottom-Up). 

For more information on the task-based approach see: How to create a task-based Mind Map 

Or watch our video tutorial on that topic: Task-based Mind Mapping 

  

Proceed as follows: 

1. Open an existing project or create a new one. 

2. To open an existing mind map click on Mind Maps on the Start tab. 
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• All Nodes: All nodes of the mind map including the main node are transformed into tasks. 

The tasks are automatically transferred to the task area of your project. 

• End Nodes: Only the end nodes of your mind map are transformed into tasks. Those can be 

accessed in the task area of your project later on. 

• Selected Nodes: First choose the nodes in the mind map, you want transform into tasks. 

Afterwards click on Create Tasks and then on Selected Nodes. 

• Include Nodes with Tasks: Select this option to once again create tasks from nodes, which 

have already been transformed.   

  

3. After you have selected an option the Task page with the new tasks automatically opens. The tasks 

that have been transferred from the mind map are marked with a mind map symbol. In the mind map 

all nodes that already have been transformed into tasks are marked with a task symbol.  

For more information, on how to add important information to tasks, see Create and edit tasks. 

 

Copy a mind map to the planning 
You can copy the structure of a mind map to the planning. Thereby each node will be transformed 

into an activity in the planning. This procedure is most suitable when you have created the mind map 

following the plan-based approach. Which means that the nodes of your mind map correspond to the 

project phases (Top-Down).  

Proceed as follows: 

1. Open an existing project or create a new one. 

2. To open an existing mind map click on Mind Maps on the Start tab. 

3. Click on Copy to Planning on the Edit tab. A new dialog box will open.  
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• Choose between Automatic calculation and Manual calculation to define the start date for 

the planning. For the manual calculation enter an individual start date. 

• Additionally, you can define the duration for each activity by using work days, hours and 

minutes. In general, the duration of activities that have been copied from a mind map is the 

same. You can customize the duration of activities in the planning. 

4. Click on OK and the planning will open. Each node of the mind map is displayed as an activity. For 

more information on planning see: Project planning 

 

Export a mind map template 
You can save mind maps as templates to re-use them for other projects. You can save the template on 

your computer as well as to the InLoox templates gallery view. 

 You can manage mind map templates in the InLoox options: Manage mind map templates 

  

How to save a mind map template to your computer 

1. Open an existing mind map. 

2. Click on Export Template on the Template tab, to save the mind map on your computer. Choose 

one of the following formats in the drop-down-list: 

• InLoox Mind Map File 

• MS Project XML File 

• Picture 

• Vectorgraphics: Use this format in any other file you want and edit it. With copy & paste you 

can easily export the mind map structure as a vectographic. 

 For more information on how to re-use the templates later on see: Import a mind map template 

  

How to save a mind map template to the InLoox templates gallery view 

1. Click on Save Template on the Templates tab. 
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2. Name the template in the new dialog box and click on OK. 

3. The saved template can be accessed on the Templates tab in the InLoox templates gallery view:  

 

Import a mind map template 
Mind map templates simplify the creation of mind maps. Templates contain predefined nodes and 

resource data.   

 For more information on how to create a mind map template, see Export a mind map template 

 You can manage mind map templates in the InLoox options: Manage mind map templates 

  

How to open a mind map template from your data 

1. Open an existing mind map. 

2. Click on Import Template on the Template tab, to load an existing mind map from your computer. 

Choose one of the following formats in the drop-down-list: 

• MS Project File 

• MS Project Exchange File 

• MindManager MMAP File 

• MindManager XML File 

• MS Project XML File 

• InLoox PM Mind Map File 

  

How to open a template from the InLoox gallery view 

1. Open an existing project or create a new one. 

2. To open an existing mind map click on Mind Maps on the Start tab. 

3. Open the Templates tab and click on a template in the gallery view: 
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People/ Contact management 
The InLoox contact feature is a global contact management tool. It can be used as an alternative to 

the exchange server. InLoox contacts (people) as well as address books are accessible for all InLoox 

database users. Additionally, the user can create own contacts and address books that are not visible 

for everyone. 

All InLoox now! users need the contact management for adding new users to InLoox now!. 

Important: This default setting is valid for all InLoox versions except InLoox Personal Edition and 

InLoox Personal Plus Edition.  Those versions don’t offer the InLoox contact feature. Therefore 

the People button is not visible in the ribbon. In the tree structure the People tab is visible, but the 

feature is deactivated.    

InLoox People in the ribbon: 

 

  

InLoox People in the tree structure:  

 

Create, edit and delete InLoox contacts 
Create a new contact 
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By using the InLoox contact management tool you can manage important contact information of 

customers, partners, colleagues etc. 

To create a new contact proceed as follows: 

1. Click on the People icon in the InLoox PM or InLoox now ribbon. Afterwards, choose an address 

book in the tree structure on the left below People. (If you haven’t created an address book yet, you 

can use the “InLoox Address List” address book.) 

 

2. Click on New Contact on the Start tab.  

 

3. A new window will open. Here you can enter all important contact information:  
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• (1)    General: Enter Title, First Name, Last Name as well as the company the person is 

working for. Additionally, you can add a picture by clicking on the grey default picture or 

on Image in the ribbon. Then you choose a picture and click on Open. 

• (2)    Contact details: Afterwards, you can add additional contact details in the areas Internet, 

Phone and Address. 

• (3)    Permissions & Licenses: InLoox Admins have access to special features in the 

permissions and licenses area. InLoox Admins can create a user account for InLoox PM or 

InLoow now for the new contact by clicking on Allow Login. The persons automatically 

receives a user license provided that this feature is activated in the InLoox options. 

Additionally, it is necessary that you have unused user licenses left. For more information 

see Create an InLoox user account. 

• (4)    More & Note: Finally, you add the birthday and if necessary a note. When you are 

clicking into the note area, the additional tab Format appears in the ribbon. The Format tab 

provides several features for formatting the note: 

 

  

The formatting features are oriented towards common word processing programs. For more detailed 

information on the formatting feature see bullet point 7. in How to create a new project. 

  

4. When you are finished, click on Save and Close in the Contact tab. The contact is added to your 

address book and appears in the contact overview.  

  

Edit a contact 

To edit a contact double-click on the contact in the address book. A new window will open and you 

can edit all contact details. When you are finished, click on Save and Close.  

  

Delete a contact 

To delete a contact you have to options: 

• Select the contact in the address book and click on Delete in the Start tab. 

• Right-click on the contact to open the context menu. Click on Delete in the context menu.  

 

Manage InLoox address books 
By using InLoox address books you can administrate your InLoox people (contacts). The address book 

“InLoox address list” is accessible for all users by default. It’s a global address list to which all users of 
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your database have access. Additionally, you can create as much address books as you need. You can 

determine the accessibility for each address book (exception: InLoox address list). 

Address book view 
You can access InLoox address books via the tree structure on the left. Click on People in the tree 

structure and you will see all existing address books below: 

 

Afterwards, click on an address book to open it.  

Alternatively, you can access the address books via the ribbon. Therefore click on the InLoox 

now or InLoox PM tab and then on People. The InLoox address list will open. To open another 

address book click on Address Book in the Start tab and choose an address book from the drop-

down-list.  

 

Below you can see the address book view:  
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Create, edit and delete address books  
1. Go to the InLoox contact management by clicking on People on the InLoox now or InLoox PM tab.  

2. To manage your address books click on the Address Book icon on the Start tab. In the drop-down-

list click on Manage Address Books. A new window will open: 

 

3. To save your changes, click on Save.  
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Features in the address book view 
Go to the InLoox contact management by clicking on People on the InLoox now or InLoox PM tab.  

The address book view provides some helpful features on the Start tab.  

 

  

Import contacts from Outlook 

By using this feature you can import contacts from your Outlook address book to your InLoox address 

book.  

1. Click on Import Contacts on the Start tab. 

2. Your Outlook address book pops-up and you can select the needed contacts by double-clicking.   

3. When you are finished, click on OK. 

4. All data that is connected to the selected contacts will be transferred automatically to InLoox. Now 

you can access the imported contacts from your InLoox address book.  

  

Filter contacts 

You can search your contacts by using individual filters. This is very helpful when you are searching for 

a specific contact without remembering the full name. Therefore click on the Filter icon in 

the Start ribbon. A new window will open where you can edit the filter.  

 

1. Click on the blue text (here „Display Name”), to filter by a specific criteria. You can use the 

following criteria: Display Address, Display Name, Email, Mobile, and Telephone. 
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2. Choose a condition by clicking on the green text (here „Begins with”). You can use many different 

conditions, like for example “Begins with”, “Equals”, “Contains” or “Ends with”. 

3. Enter a value for the chosen criteria (here “K”), by clicking on the grey text “<enter a value>”. 

4. For adding more filter criteria click on the plus icon next to the red „And“. Afterwards, edit the 

logical operator that is used for connecting several criteria, by clicking on the red “And”. Choose 

between: and, or, not and, not or. 

5. Afterwards, click on Ok to scan your contacts with your individual filter. The results will be shown. 

6. To edit the filter click on Edit filter below your results. To remove the filter click on the “X”-icon 

below your results.  

 

  

Search contacts 

In the right corner above your contacts you will find the feature Search contacts. With this feature 

you can easily search your contacts without creating a filter. Just enter some contact information to 

search for a specific person or e.g. for all contacts from San Francisco. 

1. Enter some contact information in the field Search contacts and press enter or click on the loupe 

icon. 

2. The results will be shown immediately. To exit the search click on the “X”-icon next to the search 

field.  

 

Manage InLoox users 
You can use the contact feature to add extern users like partners or freelancers to your InLoox 

database. Especially, when you are using InLoox now!, you need the InLoox contact management to 

add new users to InLoox. Furthermore we offer a new log on option to InLoox Web App for Office 365 

users.  

Add extern users to InLoox 
Extern users, who are not working via the Outlook-Login with InLoox, can be added to the database 

by using the InLoox contact feature. This features helps to give partners, customers or freelancer 

access to a specific InLoox project. 

You can add extern users to InLoox PM or InLoox now by creating a new contact and assigning an 

InLoox user license. 

Requirements: 

• You are InLoox Admin. 

• You have an unused InLoox user license. 

• You have activated the automatic assignment of user licenses in the InLoox options.  
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How to activate the automatic user license assignment 

1. Open the InLoox options to activate the automatic user license assignment. Therefore click 

on File and then on InLoox PM or InLoox now options. 

2. In the InLoox options click on License Key and then on User Licenses. This area provides an 

overview over all available user licenses: InLoox PM Outlook User, InLoox PM Web User, and InLoox 

PM Universal User.  

 

3. Put a check at the field Automatic user license assignment. 

4. Afterwards, click on Apply and OK to save your changes and to close the InLoox options.  

  

Assign InLoox user licenses to extern users 

To assign an InLoox user license to an extern user, you have to create a new InLoox contact or you just 

open the already existing InLoox contact. Go to the InLoox People area to create a new contact or to 

open the already existing contact. 

1. Open the InLoox now or InLoox PM tab and click on People. 

2. If the person is already in your InLoox address book, just double-click on the contact to open it. 

Otherwise click on New Contact to create a new contact. 

3. A new window opens. Here you enter all important contact details (see chapter Create a new 

contact). If the contact is already in your address book, you can skip this step. 

4. In the Licenses area in the ribbon you can see how many unused user licenses are left.  

 

5. Click on the button Allow Login to add the person to InLoox and to assign a user license. If the 

person should be allowed to create projects by themselves, activate the button Create Projects. If 

you want to assign all writing- and reading permissions to this contact, click on Administrator (the 

contact is now an InLoox administrator). 

6. To save your changes click on Save and Close. Now, the contact automatically receives its InLoox 

user license. Additionally, you can edit the persons’ user-based permissions in the InLoox options. For 

more information see Set user permissions.  

7. The following procedure differs between InLoox now and InLoox PM. 
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7.1 InLoox now: The user receives an invitation mail to InLoox now!. He clicks on the attached link 

and is forwarded to InLoox Web App. There he creates a password and logs-on to InLoox Web App. 

Afterwards, he can click on the button Outlook Client in the Web App to download the local InLoox 

client.  

 

7.2 InLoox PM: The new user won’t receive an invitation mail. You have to create an authentication 

for him in the InLoox options: 

• Therefore click on File and open the InLoox PM options. 

• Click on Permissions and select the new user in the user-based permissions. Then click 

on Edit. 

• A new window will open. In the Authentication area you can create the authentication for 

the new user. Afterwards you click on OK to close the window. To safe your changes and close 

the InLoox options click on Apply and OK.  

 

 

Additional log on option to InLoox Web App for Office 365 users 
Since InLoox 9 you don’t need a VPN for working with InLoox. Now you have the possibility to access 

the database via InLoox Web App with your local installed Outlook Client. 

Requirements: Outlook Client as well as InLoox Web App at least in version 9.0.10. If you’re using 

InLoox now! then InLoox Web App will automatically be up-to-date and you only need to check the 

current version of your Outlook client. 

So far, you had the following possibilities to log on to the InLoox Outlook Client and InLoox Web 

App:  
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If you use an Office 365 account in Outlook and log on to InLoox with “Outlook Login”, you won’t be 

able to use the login to log on to InLoox Web App. InLoox 9.0.9 offers you another authentication 

method to log on to InLoox Web App with an Office 365 account: You can add an additional InLoox 

authentication to your Office 365 user account. You can then use this authentication to log on to 

InLoox Web App. This enables you to use the same Office 365 user account for InLoox for Outlook and 

InLoox Web App. 
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Follow these steps to set up the authentication: 

1. Navigate to the InLoox Options: File >> InLoox Options 

2. Go to Permissions. 

3. Choose the Office 365 user from the list User-based permissions. You can also create a new user 

account if it does not exist yet: 

• Click on New. 

• Open the context menu and select Exchange User. 

 

• Select your Office 365 contact from your global address book, then close the address book 

with OK. 

4. Now select InLoox PM authentication in the permissions dialog and set a password. 
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5. Click on OK to confirm. 

6. Click on OK to save and close the InLoox Options. 

7. Now you can log on to InLoox Web App with your email address and the assigned password. 

 

Invite new users to InLoox now! 
Since InLoox 9 the contact management tool offers the possibility to directly invite new users to 

InLoox now!. Therefore, proceed as follows: (Start from your inbox) 

1.  Open the InLoox now tab and click on People. The InLoox address list opens and gives an overview 

over all contacts. 

2. Click on Invite Contacts on the Start tab.  

 



 216 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
3. A new window for selecting the contacts will open.   

 

4. The selected contact will receive an invitation mail for InLoox now!.   

 

Project list 
The project list provides you with a brief overview of all your projects. It includes various features 

that make project editing easier and faster. As a standard, you can see only those projects in the list 

that are accessible for you. 

Selected project list features 
To access the project list click on the InLoox PM or InLoox now tab. Click on Projects in the Outlook 

ribbon afterwards. 

1.  Features in the InLoox PM or InLoox now Ribbon 

On the Start tab, in the InLoox PM or InLoox now Ribbon you can find additional features that 

simplify your work within the project list:  
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Admins can individually define both, categories as well as different specifications of the status, in the 

InLoox options. 

  

2. How to open or create a project 

Open a project 

Double click on a project in the project list or right click on the project to open the context menu. 

Then choose Open Project from the menu. 

Create a project 

Double click on an empty space in the project list or right click to open the context menu. Then 

choose New Project from the menu. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/inloox-options/manage-project-categories/
https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/inloox-options/edit-the-project-statuses/
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3. The context menu and useful keyboard shortcuts 

The context menu provides you with almost all basic features that are also available on the InLoox 

Ribbon. To open the context menu right-click on the project list.   

 

For more information on how to structure the project list see Create and edit custom view. 

Useful keyboard shortcuts 

• F2 – Create a new project. 

• F4 – Refresh the project list. 

• CTRG+P – Print the project list. 

• CTRG+C – Copy a project into the clipboard. 

• CTRG+V – Paste a project from the clipboard to the project list. 

  

 

Conditional formatting as a warning system 
By applying the conditional formatting to your project list, you can quickly highlight project 

information that meets certain conditions. This feature can be very useful: 

• As a warning system for the project controlling of critical projects 

• To clearly structure the project list 

The conditional formatting dropdown-menu provides you with preconfigured formatting templates 

and your individual formatting drafts. To delate a draft choose the formatting in the dropdown-menu 

and click on Remove Formatting. 

  

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/customization/generate-personalized-views/
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Add Simple Formatting 
The simple formatting compares the value of a field with a pre-defined reference value. In the 

following example all projects whose actual expenses exceed a specified value will be marked red. 

1. Let’s start from the project list. Click on Conditional Formatting in the start tab. 

2. Select Add Simple Formatting in the dropdown-menu. A side panel will open on the right side. 

There you can define the formatting. 

3. Choose Total Expenses (Actual) in the Column field. 

4. Choose the argument Greater than in the Condition field.   

5. Enter the reference value 5,000 in the Value 1 field. 

6. Define the formatting in the Format area, e.g. BackColor red. Activate the check box Apply for 

cell in order to format the whole cell of the project in the project list. All projects whose total 

expenses exceed 5,000 will be marked with red in the project list.  

 

  

Add Extended Formatting 
Extended formatting allows the calculation of a value and compares it with a pre-defined reference 

value. For those calculations you can use more than one field as a variable. The following example will 

examine, if a projects’ actual expenses exceed the planned expenses. 

1. Let’s start from the project list. Click on Conditional Formatting in the start tab. 

2. Select Add Extended Formatting in the dropdown-menu. A side panel will open on the right side. 

There you can define the formatting. 



 220 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
3. Click on the following icon  on the side panel. Thereby you open the dialog box Expression 

editor for specifying the formula and calculating field values. 

4. Click on Fields in the left column. 

5. Select Total Expenses (Actual) in the middle column by double-clicking. 

6. Select the relational operator greater than >. 

7. Select Total Expenses (Plan) in the middle column by double-clicking. Afterwards click on Ok.  

 

8. You can define the formatting in the Format area in the same way as when using simple formatting. 

Activate the check box Apply for cell in order to format the whole cell of the project in the project 

list. 

9. All projects which meet the defined conditions will be marked in the project list.  

 

 

The tree structure in the project list 
When you are opening the project list you can find the tree structure on the left part of the window 

(required: Outlook folder structure on the left side is open). The tree structure provides you with 

additional views like Favorites, Project Requests, Archive and Recycle Bin.  
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In the following we will shortly introduce the Timeline and Trash view. 

  

Timeline 
The Timeline provides you with an overview of the chronological allocation of all your projects.  
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Those features are also available in the context menu. Right-click in the timeline to open the context 

menu. For more information about printing, see Print the project list.  

In the timeline projects can be differentiated by their color. The coloring scheme is predetermined 

and cannot be changed individually: 

 

  

  

Recycle Bin 
The Recycle Bin shows all projects that you have deleted in the project list.  

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/10-0/all-support-articles-inloox-10-for-outlook/project-list/print-the-project-list/
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How to duplicate a project 
You can duplicate entire projects from your project list. This is very useful, when you want to create a 

new project that is extremely similar to an already existing project. Below you can find our how-to 

instructions.  

1. Click on Projects in the InLoox PM or InLoox now tab to open the project list. 

2. Select the project you want to copy … 

 

Useful keyboard shortcuts 
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• CTRG+C – Copy the selected project from the project list. 

• CTRG+V – Paste the selected project to the project list. 

  

3. To edit the copied project you have to assign a new project number. Afterwards you can adapt the 

project information.  

 

Print the project list 
InLoox provides a print feature for every project view as well as for the project pages - all printing 

settings and features can be found in the dialog box print. You can use it to modify a document's print 

settings, or specify its watermark settings. 

Click on Print in the start tab to open the print preview. The following screenshot explains all 

important features that you can use to edit the print preview. To guarantee the ideal print of your 

document click on Scale and choose a suitable percentage from the drop-down menu. The scale 

feature enlarges or reduces the document in percentage to its current size.  

 

 

Search and filter projects 
The project list offers you several options to find a project you are looking for. This chapter shows 

how to use the search function and filters when searching a project. 

Search function 
1. To open the project list click on Projects in the InLoox PM or InLoox now tab. 

2. Click on the Search projects box above the project list.  



 225 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 

 

3. All projects that include the entered text are shown. The search results are accessible on a side 

panel, even when you are opening a project. 

4. When you are finished close the search function by clicking on the X next to the Search 

projects box. 

Quick filters  
With the new Excel-style quick filters, you can now refine your search in table views even more easily. 

Depending on the field type, extended text and date filters are available. For example, you can filter 

your project or task list by different date ranges: 

Click on the funnel icon, which will appear if you mouse-over a column header. Then select the Date 

Filters tab.  
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How to filter the project list [advanced] 
1. To open the project list click on Projects in the InLoox PM or InLoox now tab. 

2. Click on Filter in the start tab. 

3. Create a filter criteria.  

 

4. Click on Ok. InLoox shows all projects that meet your criteria. 

 

Project planning 
Creating a Project Plan with InLoox 

With InLoox, you create Gantt-Charts for your project planning. Such a Gantt-Chart consists of 

milestones, specific points in a project timeline, and activities, which are scheduled phases in a 

project with a specific start and end date.  Several activities can be combined to form a summary 
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activity. Activities usually comprise of one or more tasks that need to be done in order to complete 

the activity. 

Please, watch our video tutorial for an introduction into project planning with InLoox. 

This is how you can create a project plan with InLoox: 

1. Adopt planning elements from a project mind map. 

2. Import an InLoox planning template or a Microsoft Project ® planning template. 

3. Copy and paste planning elements from an Excel-file. 

4. Or create the project plan manually, described as follows. 

ATTENTION You can only create an InLoox project plan if you have the necessary permissions. You 

need to have permissions to Edit Projects and to Edit “Planning”. If you only have permission 

to Access Projects and Access “Planning”, you are unable to create a project plan. Learn more about 

permissions here. 

Create, edit, and delete new planning elements – activities and milestones 
The following steps guide you through creating a new project Gantt-Chart with InLoox. 

Create new activities and milestones 
1. Open Outlook and click on the tab InLoox PM or InLoox now. 

2. Click in the ribbon on the Start tab and click on Projects. Create a new project or select an 

existing project. 

3. Click on the tab Start and in the ribbon on Planning. 

The InLoox project plan consists of the planning list on the left, where you see the two 

fields Info and Name when you first open the InLoox planning, and the Gantt-Chart in the calendar 

view on the right.  

 

https://www.inloox.com/support/documentation/video-tutorials/inloox-9-for-outlook-how-to-create-a-project-plan/
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Click on the tab Edit. Then click on New Activity or New Milestone to create one of these new 

planning elements. You can also use the short cuts Ctrl+N (or Cmd+N) for a new activity or Ctrl+M (or 

Cmd+M) for a new milestone. 

 

The new planning elements are visualized in the Gantt-Chart. Activities are shown as bars and 

milestones are diamond shaped. If you want to create a new milestone: 

1. Click on the tab Edit, and then click on New Milestone or press Ctrl+M (or Cmd+M). 

2. You see the New Milestone in the planning list. Give it a new name, e.g. “Kick-off meeting”. 

Press ENTER to save.  

 

If you want to create a new activity, do the same, only click on New Activity in the ribbon or press 

Ctrl+N.  

ATTENTION If you do not schedule these newly created planning elements (i.e. you have not set a 

start and/or end date) right away, InLoox will use the creation date of the project for milestones. 

Activities will also start at the creation date of the project and will be given a duration of one day 

(with a default setting of 8 work hours). Your newly created project plan will then look e.g. like this: 
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Each planning element starts and ends at the same time. No dependencies have yet been established 

between the planning elements. As each planning element’s start date lies in the past, they are all 

highlighted in red and are marked as overdue by the symbol  in the info column.   

 

Create summary activities 
If you combine several activities which are logically connected and need to be finished within the 

same time frame, you create a summary activity. 

Proceed as follows:  

1. Create all those activities, that you want to combine, e.g. all marketing activities.  
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2. Mark each of the activities by pressing Ctrl and clicking on each planning element. In this example, 

“event marketing” is supposed to become the summary activity. 

 

3. Then click in the ribbon on Edit and click on the right arrow in the section Arrange. The individual 

activities are now indented.  

 

4. The summary activity “event marketing“ is visualized in the Gantt-chart as a summary bar. If you 

click on the arrow next to the summary event’s name you can collapse the subordinate activities.  

 

5. If you want to undo the creation of a summary activity, simply click on the undo icon in the upper 

left hand corner  or mark all the subordinate activities of the summary 

activity and click on the left arrow in the ribbon in the section Arrange.  
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ATTENTION The duration of the summary activity is calculated based on the start and end dates of 

the subordinate activities. I.e. that a summary activity starts on the start date of the earliest 

subordinate activity and ends on the end date of the latest subordinate activity. If you change the 

start and/or end dates of the subordinate activities, the duration of the summary activity is 

automatically adjusted. 

 

Delete planning elements 
If you want to delete a planning element that you have just created, simply click on the undo symbol 

in the upper left-hand corner of the Outlook toolbar. 

 

Otherwise, mark one or more planning elements you want to delete and click Delete in the tab Edit. 

 

InLoox will ask you again, if you a sure you want to delete the planning element. Confirm by 

clicking Yes. 

ATTENTION If you delete a summary activity, all subordinate activities are deleted as well.  

 

Change the order of the planning elements 
In order to change the order of the planning elements, proceed as follows: 

1. Click on the planning element that you want to move. 

2. Open the tab Edit and use the arrows in the section Arrange to move the planning element up or 

down the list.  

 

 

Convert planning elements: activity <-> milestone 
If you want to convert an existing activity into a milestone or vice versa, you do not have to delete it 

and create a new one. 
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Click on the planning element, you want to convert and then open the tab Edit and click 

on Convert in the section Action. 

 

ATTENTION Summary activities cannot be converted.  

 

Link planning elements automatically 
If you have created the planning elements in a chronological order, you can link them with just one 

click and create dependencies between the planning elements. That way, you create a project plan 

based on the waterfall model. 

1. Click on the planning elements you want to link. Use Ctrl+A to mark every planning element in your 

plan. 

2. Open the tab Edit and click on Link Automatically in the ribbon in the section Action.  

 

3. The marked planning elements are now linked. Proceed to edit the dependencies. 

 

4. If you want to undo the automatically created dependencies, mark the planning elements whose 

link you want to undo and click on Remove Dependency in the tab Edit in the section Action. 

 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/project-planning-inloox-9-for-outlook/dependencies-between-planning-elements-inloox-9-for-outlook/edit-dependencies/
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Or click on the undo symbol in the Outlook tool bar in the upper left-hand corner. 

  

 

Highlight planning elements 
You can highlight planning elements by assigning them a flag or color. Click on the planning element 

you want to highlight, open the tab Edit and click on Flag or Color in the section Highlight. 

 

TIPP In order to see flagged planning elements, display the field Flag  in the planning list.  

 

Dependencies between planning elements 
When you create dependencies, i.e. establish logical relationships between planning elements, you 

draw up a project schedule. To do that, you need to edit the planning elements and add details such 

as start and end date, duration, the type of dependency and, if necessary, set restrictions. 

You can edit the planning elements in the planning list as well as in the Gantt-chart. 

Create dependencies manually 
In order to create dependencies, you have to link the planning elements. Dependencies can be 

established between all planning elements (activities, summary activities, milestones). You can do 

that either automatically, or manually, in your Gantt-chart, described as follows:  

1. Move your mouse over the planning element until it turns into  . 

2. Now, click on the planning element and move the cursor to the other planning element to link 

them. 

 

3. Let go of the cursor. The two planning elements are now linked. In the example below, the 

relationship is a so called Finish-to-Start Dependency: the activity “event marketing” is only to start 

after the milestone “kick-off meeting” is finished. That means, you have created a Predecessor (kick-

off meeting) and a Successor (event marketing).  
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Edit dependencies 
To edit an existing dependency, double-click on the link between two planning elements in the Gantt-

chart. The window Edit Dependency opens and you can now change the type of dependency. 

Click on the field Type to select another type of dependency.  

 

 

Overview: Types of dependencies 
There are four different types of dependencies to link planning elements. 

Finish-to-Start Dependency: 

This type of dependency establishes a relationship between the end of the predecessor and the start 

of the successor.  You ensure that the successor can only start upon completion of the predecessor. 

Example: The activity “event marketing” can only start once the milestone “kick-off meeting“ has 

been successfully completed.   

 

Start-to-Start Dependency: 

This type of dependency restricts the start of the successor, as it can only start once the predecessor 

has started, too. 

Example: The successor activity “partner event program“ starts at the same time as the predecessor 

activity “customer event program“. That means that unless the predecessor has started, the successor 

cannot start.   

 

Finish-to-Finish Dependency: 
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This type of dependency restricts the end of the successor, as it can only end when, and if, the 

predecessor has been successfully completed. 

Example: The predecessor “customer event program“ has to be completed at the latest on the end 

date of the successor “partner event program“, as the two programs have to be finalized for the 

creation of the event website.  

 

Start-to-Finish Dependency 

This type of dependency is only useful if you create a work-back project plan (work-back schedule). 

When you create a Start-to-Finish Dependency you link the start of the predecessor with the end of 

the successor.  

Example: If a company plans to shut down a server on a certain date and move their data to a new 

datacenter to consolidate the hosting, they need to make sure that the new server is up and running 

before they can shut down the old server. Therefore, the predecessor “full-time operation new 

server” needs to be completed before the successor “shut off old server” can happen. 

 

 

Set the start date and duration of planning elements 
After having linked planning elements, you can set their start dates and duration. The end date of 

activities and summary activities is determined by when (date and time) they start and how long they 

take (duration). Milestones only have a start date – the date and time they happen. 

1. To edit the planning element, double-click on it or click on it once and click on Edit in the ribbon. 

 

2. In the side panel on the right you can now select the calendar, set the start date, and set the 

duration of the activity.  

https://www.inloox.com/project-management-glossary/work-back-project-plan/
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HINWEIS InLoox has three default calendars to select from: 24/7 (continuous 

operation), Standard (Monday-Friday, 8 AM-4 PM) and Weekend (Saturday and Sunday, 24h). InLoox 

will automatically use the Standard calendar. If you want to change the calendar settings, you can do 

that in the InLoox Options in the section Working Times. 

3. Select e.g. Start and set the start date by selecting On and choosing the date and time from the 

calendar. This way you establish a so-called constraint and set a time frame for the activity.  

 

4. Now, set the duration of the activity by clicking on the calendar symbol next to the 

field Duration and selecting the end date and time of the activity. Thereby, InLoox automatically 

calculates the duration of the activity. Alternatively, you can also type in the work days manually. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/project-planning-inloox-9-for-outlook/set-constraints-inloox-9-for-outlook/
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Instead of Work Days, you can also select Hours or Minutes as your preferred unit of duration.  

 

5. You can display the duration of your planning elements in the planning list. Click on Select Fields in 

the tab View, select the field Duration from the context menu and drag it into the planning list. 

 

 

Set the duration in the Gantt-chart 
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It is advisable to zoom in and enlarge the view to show the individual days, so that you can work 

comfortably in the Gantt-chart.  

1. Click on Zoom In or Zoom Out in the tab View to adjust the Gantt-chart to your needs. You can also 

use the short cuts Ctrl + Add (zoom in) or Ctrl + Subtract (zoom out). 

 

2. Move your cursor over the activity until it turns into . Click on the beginning or end of the 

activity bar and expand or contract it. A small window above the activity bar shows you the name of 

the activity, as well as the starting date and end date, and the starting time and end time.  

 

3. If you want to change the starting date/time or end date/time, without changing the duration of 

the activity, you can move the activity bar in the Gantt-chart. Click on the activity bar in the Gantt-

chart and move it right or left to the desired date. 

 

 

Delete dependencies 
If you want to delete a dependency, you can either: 

1.Click on the undo button in the Outlook tool bar in the upper left-hand 

corner  . 

Or: 

1. Press Ctrl and click on the planning elements that are linked by dependencies, which you want to 

delete. 



 239 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
2. Then open the tab Edit and click on Remove Dependency in the section Action. Alternatively, use 

the shortcut Ctrl+Alt+D. 

 

Or: 

1. Move the mouse over the predecessor until the cursor turns into  , click on the planning 

element and retrace the link with the mouse button held down. When you are hovering over the 

successor, let go of the mouse and the link is deleted. 

 

 

Set constraints 
When you set constraints in a project plan, you essentially set time restrictions. Constraints put 

project phases within a specific time frame and can be set for milestones, activities and summary 

activities. Constraints on planning elements limit the flexibility of the project plan: the project planner 

or project manager cannot move planning elements along the timeline freely but need to plan within 

the timely constraints. Learn more about constraints here. 

Before you set constraints, you should have established dependencies between your planning 

elements. 

Set constraints on activities and summary activities 
After you have created planning elements and established dependencies automatically or manually, 

follow these steps: 

1. Double-click the planning element you want to edit or click on the planning element once 

and then on Edit in the Ribbon.  

 

Now you can edit the planning element in the side panel on the right. 

1. In the section Time Frame you have the field Constraint where you can now set the 

restriction for this planning element. 

https://www.inloox.com/project-management-glossary/constraint/
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2. Select the type of constraint you want to set (e.g. Start on a certain date) and select the date 

and time in the calendar. The different types of constraints are explained above. 

 

 

Set constraints on milestones 
In contrast to activities, milestones do not have a duration; nevertheless, you can constrain a 

milestone’s start or end date and/or time. This is done the same way as with activities.  
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Overview: Types of constraints 
You can set different kinds of constraints on planning activities. 

• Start as soon as possible – Choose Start and click on As soon as possible. If you set this type 

of constraint, this planning element is set to start as soon as its predecessor is finished. This 

allows for maximum flexibility in your project plan. 

 



 242 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
• Start is on a specific date – If your planning element is supposed to start (activity) or happen 

(milestone) on a specific date, select Start and On. Then choose the date and time for the 

start of the planning activity. The activity will have to be started on this specific date, 

otherwise, you will be alerted to a constraint violation as you will see this symbol in your 

Gantt-chart.  

 

• Planning element must not start before a certain date – If you set this type of constraint, the 

planning element may only start on or after a certain date. Select Start and No earlier than. 

Then select the start date and time from the calendar. The planning element can be delayed 

into the future, but may not be moved up earlier along the time line.  

 

• Planning element must start no later than on a certain date – This type of constraint is 

useful, if a planning element must start before a certain date. The planning element then 

needs to start on this date at the latest. Select Start and No later than and then choose the 

date and time from the calendar.  
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• End date is as late as possible – Select Finish and click on As late as possible. This constraint 

is set when the latest possible end date for completion should be calculated from the end 

date of the whole project.  

  

• Planning element must be completed on a specific date – If a planning element needs to be 

finished on a specific date, select Finish and On. Then select the date and time from the 

calendar. This planning element may not be moved along the timeline and must not end 

earlier or later than on the set date.  
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• Planning element must not be completed before a certain date – If you set this constraint, 

this planning element may be finished on or later than the set date. It must not be completed 

sooner, though. Select Finish and Not earlier than and then select the earliest possible date 

and time from the calendar.  

 

• Planning element must be completed on a specific date at the latest – With this type of 

constraint, the planning element must be completed as soon as possible but no later than on 

the set date. Its completion must not be delayed at all. Select Finish and No later than, then 

choose the latest possible date and time for the completion from the calendar.  

 

HINWEIS Constraints on single planning elements influence the whole project plan. It may be that 

you are not able to move planning elements freely along the timeline, due to constraints set on 

planning elements. If this is the case, InLoox alerts you to possible constraint violations with the 

symbol “constraint violation”  in the planning list next to those planning elements that are 

affected. 

TIPP For better overview, it is advisable to show the field Constraint and/or the field with the 

symbol  in the planning list.  
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Remove constraint 
You can remove constraints by either:  

Clicking on the undo-symbol  in the tool bar, if you want to remove the 

constraint you have just created. 

Or: 

By clicking on the planning element the constraint of which you want to remove and then clicking 

on Remove Constraint in the ribbon in the tab Edit. Alternatively, you can also use the short cut 

CTRL+ALT+R.  

 

 

Add lag to planning elements 
In certain instances, you may want to include some buffer to account for delays or external factors 

that affect your project. In this case, you can add lag in your project plan. Lag times can also serve as 

a kind of time constraint between planning elements. 

  

1. Double-click on the link that connects two planning elements to open the window Edit 

Dependency. 

2. Add lag in work days or hours and minutes.  
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3. You can also add lead time. Click on Negativ when the successor can start before the predecessor is 

completed.  

 

 

Add tasks to your project plan 
We advise to only add tasks to your project plan once you have completed your project structure 

and established logical dependencies and added time constraints. As soon as you add tasks to your 

planning elements, you can no longer edit the planning element. You would have to remove the tasks 

again. 

You can add tasks to your project plan in two ways: 

1. Drag and drop existing project tasks to your Gantt-chart. 

2. Create project tasks manually in your Gantt-chart. 

Add new project tasks manually 

Follow the next steps to create new project tasks and add them to project elements in your Gantt-

chart. 

1. Click on the activity or milestone to which you want to assign a task. 

2. In the tab Edit, click on New Task.  
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3. The new task is created and is given the name of the activity or milestone to which it has been 

assigned.  

 

4. You can rename the task directly in the planning list.  

 

Or double-click on the newly created task to open the side panel where you can enter all the relevant 

information for the task. As with the name, the task’s start and end date, as well as the effort are the 

same as the activity or milestone it has been assigned to.  

5. After you have edited the new task, click on the close button in the upper right hand corner to 

close the side panel and save the edits.  

 

Project groups: Multi-project management with dependencies between projects 
When you need to manage multiple projects it is useful to combine their project plans in one by 

creating a project group. Such a project group consists of two or more sub-projects. They can either 

belong to one big project or the completion of some activities etc. in one project are the prerequisite 

to being able to complete activities etc. in the other one. It can also happen, that several different 

departments need to liaise on the same project. Then it can be useful to break the whole project 

down into smaller ones for each department and link these project plans to create a project group. 

NOTE In order to be able to create project groups, you need to have the permissions to edit 

projects and to edit planning, either in your user based permissions or in your role based 

permissions. If you only have reading permissions for projects, you cannot create project groups. You 

can change the user and role-based permission in the InLoox options  (requires admin permissions).  
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Create a project group 
1. Click in the tab Settings on Project Group.  

 

2. On the right hand side, select the project you want to add to your project from the side panel by 

clicking on the add-symbol . 

 

Or click on Add Selected Project in the tab Project group.  

 

Or drag the selected project from the list down into the grey box. 
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3. Now, you see the added sub-project in the Gantt-chart as well as in the grey box New Project 

Group in the side panel on the right.  

 

HINWEIS If you add a sub-project for which you do not have editing permissions, you will only see a 

bar with the sub-project’s name on it. You won’t be able to see the individual planning elements and 

cannot edit the sub-project! 

4. Now enter a new name for this project group. Either click on Rename Project Group in the ribbon,  
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Or click on the symbol  next to New Project Group in the side panel and enter the new name of 

the project group. 

 

5. Now, you establish the dependency between the two projects. The dependency between different 

projects in a project group is blue, so you can distinguish it from the dependencies within a project, 

which are grey.  

 

Now, you can edit your project plan as usual. Changes to each of the project group’s sub-project plans 

are adopted when you save and close the project plan.  

 

Change the order of the sub-projects in project groups 

Use the arrows next to the sub-projects in the project group in the side panel, and click e.g. on  to 

move it up. 
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Highlight sub-projects in different colors 
For better visual distinction, you can select different colors for individual projects in your project 

group. All planning elements of a project will then be highlight in the selected color. 

1. Click on the colored box next to the project in your project group in the side panel. Then 

choose a color from the drop-down menu. 

 

NOTE If you choose a color for your original project, then this color will be displayed when you open 

the Gantt-chart of the added project but not in the original project’s Gantt-chart. 

 

Display project groups in the project list and sort the list accordingly 
1. Click on Projects in the ribbon and then click on List in the tab Start. 

 

2. Now, add the column Project Group to your list. Right-click onto the project list and click on Select 

Fields in the context menu.   
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3. Drag the field Project Group into the project list wherever you want to place the column. 



 253 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 

 

4. If you want to sort the list according to project groups, drag the column Project Group up onto the 

area above the list. 

 

5. Now, you see the various project groups in the list. 
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Remove sub-projects from the project group 

1. In the side panel, click on  next to the project you want to remove. 

 

Or click on the sub-project you want to remove to mark it, then click on Remove Selected Project in 

the ribbon in the tab Project Group. 
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2. InLoox will ask you, if you are sure to remove the selected sub-project from the project group. 

Confirm by clicking Yes. 

 

HINWEIS Once you remove a sub-project from the project group, it is no longer available for selection 

in the project list in the side panel. If you want to add the removed project again, please close the 

project and reopen it. All projects are again available for selection in the side panel. 

WICHTIG If you remove the original project to which you have added sub-projects, InLoox will warn 

you that once you remove it, you will no longer be able to access the project group from this project. 
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Delete a project group 

If you want to delete the whole project group, simply click on  next to project group’s name in the 

side panel.  

 

Or click on Delete Project Group in the ribbon in the tab Project Group.  

 

InLoox will ask you again, if you really want to delete the whole project group. Confirm by 

clicking Yes. The project group will be removed and the sub-projects no longer belong to it.  

 

NOTE Each sub-project is still available. InLoox does not delete sub-projects when you delete a 

project group. 
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Publish planning elements in other project plans 
With the publication feature, you can use selected planning elements (i.e. activities and milestones) 

in other projects. 

Application examples: 

• There is a global annual department planning. The goal is to adopt activities from the global 

planning into other projects that take place during the year. If a change is made to the activity 

in the global plan this should be incorporated into the other projects. 

• You want to incorporate milestones from a corporate milestone plan into projects of different 

departments. 

TIP If you don’t want to use individual planning elements in other projects, but set dependencies 

between two or more projects, then we recommend to create a project group. 

Publish planning elements 
Please follow these steps to publish planning elements from a source project in a target project. 

1. Open the planning of the source project. Mark the activity or milestone in the Gantt plan that 

you want to use in another project. 

2. Click on the Edit tab onto the Edit button in the Ribbon or double-click onto the selected 

planning element. 

3. On the right side of your Gantt plan, a side panel opens where you can edit planning 

elements. In the Publications group, click on Select project… 

 

4. In the dialogue Add to Project you’ll find all projects that you have a reading permission for. 

Select the target project. You are only able to confirm your selection with OK if you also have 

the permission to edit the planning of the selected target project. 

https://www.inloox.com/support/documentation/online-help/inloox-for-outlook/9-0/all-support-articles-inloox-9-for-outlook/project-planning-inloox-9-for-outlook/basic-project-planning-and-scheduling-features-inloox-9-for-outlook/
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5. When the publication was successful, you will find a link to the target project in the side 

panel in the Publications group. If you want to delete the publication click on the black 

cross  right of the target project. 

 

In the Gantt plan, published planning elements are indicated by the following icon: 
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NOTE It is only possible to publish activities and milestones. The assigned work packages are only 

visible in the source project. Summary activities cannot be published. 

NOTE If an activity has already been published in another project, which the current user is not 

allowed to access, he or she will only see the remark “Project” in the Publications group. 

 

Necessary permissions 
A user needs the following permissions to be able to publish planning elements: 

• In the source project: Read planning 

• In the target project: Read planning & Edit planning 

 

Notifications 
As soon as an activity has been published, an automatic notification will be sent to the project 

managers of the target project – unless this feature has been deactivated in the source project. 

This is how you can deactivate notifications in the source project: 

In the Planning section, on the Settings tab, activate the button No Notifications. 

 

In the InLoox options, you’ll find the regarding notification templates which you can edit according to 

your needs. 

• Activity published 

• Milestone published 
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TIP Please see the section Notification Templates to find out how you can adjust notification 

templates according to your needs. 

 

How to use published elements in the target project 
You’ll find planning elements that have just been published in the target project at the end of the 

Gantt plan. Now you can move them manually to the place where you want to use them in the plan 

(by using the arrow buttons in the Ribbon on the Edit tab).   

 

Published elements are marked by the following symbol in the Gantt plan. 

 

Published elements can be used just like “normal“ planning elements in the Gantt plan, i.e. you can 

create dependencies between them and the other planning elements. 

Double-clicking onto the published planning element in the target project will open the side panel 

where you will find the notice that the regarding object is a published activity from another project 

and a link that leads you to the source project. 
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By clicking onto the link you’ll get directly to the source project (provided that you have reading 

permissions in the source project). Only there you can edit or delete the published element. 

IMPORTANT A published activity can only be edited in the source project and will not be displayed if 

you take a snapshot in the target project. A planning element can only be published from the original 

source project of the activity. Further publications into third projects are not possible. 

TIP Use the filter Current Project to blank published elements from the target project. 

 

Behavior in case of constraint violation 
In the course of project planning it is possible that team members edit a published activity in the 

source project. This might affect the planning of the target project. In this case, you will find a notice 

when you first open the planning after the change has been made. The planning can be adjusted 

automatically. Activities and milestones that depend on the published elements will be moved 

accordingly. The rest of the planning is not affected. 

 

Add columns to the planning list 
Modify the planning list by displaying different fields. By default, the Info and Name fields are 

displayed as columns when you open planning for the first time. 

Displaying fields as columns 
1. When you open a project plan, right-click into the planning list to open the context menu and click 

on Select Fields. 
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Or open the tab View and click on Select Fields in the ribbon. 

 

2. The window Customization with the available columns opens. Drag the fields from the window 

into the planning list. 
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3. Rearrange the columns by dragging the fields to another position. 

 

4. If you want to remove a column from the planning list, open the context menu first and click 

on Select Fields to open the window Customization again. Then drag the field you want to remove 

from the planning list into the window.  
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NOTE InLoox will remember your customized planning list and display the selected columns in the 

same order once you create another project plan.  

 

Overview of fields 
The following overview describes each of the fields that you can show in your planning list: 

 

 
Effort – 

shows the 

time that 

is 

allocated 

to the task 

and the 

accumulat

ed time 

for the 

planning 

element 

based on 

the 

 

  Work 

duration 

– 

available 

time for 

the 

completio

n of the 

planning 

element 

or task 
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assigned 

tasks 

 

  Timeline 

icon – 

marks the 

elements 

that are 

pinned to 

the 

timeline 

 

  Duration 

– shows 

the 

duration 

between 

start and 

end date 

of the 

planning 

element 

in days 

and hours 

 

  Constraint 

icon – 

shows 

that there 

is a 

constraint 

between 

planning 

elements 

 

  Constrain

t – shows 

the type 

of 

constraint 

between 

the 

planning 

elements, 

e.g. start-

to-finish 

 

  End – 

shows the 

end date 

of the 

planning 

element 

 

  Done 

date – 

shows the 

date the 

element 

was 

marked as 

done 

 

  Progress – 

shows the 

stage of 

completio

n in 

percent 

based on 

the tasks 

allocated 

to the 

 

  Info 

icon – 

shows if 

an 

element is 

done, 

overdue, 

locked, or 
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planning 

element 

violates a 

constraint 

 

  Calendar 

– shows 

which 

calendar is 

used for 

this Gantt-

chart 

 

  Flagged 

icon – 

shows 

which 

elements 

are 

marked 

with a flag 

 

  Critical – 

marks the 

planning 

elements 

along the 

critical 

chain as 

true or 

false 

 

  Successor

 – shows 

the 

succeedin

g planning 

element if 

a 

dependen

cy exists 

 

  Location – 

free text 

field for 

you to 

enter the 

location 

the 

planning 

element 

takes 

place at 

 

  WBSCode 

(calculate

d) – 

shows the 

automatic

ally 

calculated 

work 

breakdow

n 

structure 

code 

 

  WBSCode 

(manual) 

– free text 

field for 

your own 

work 

breakdow

n 

structure 

code 

 

  Resources

 – shows 

the name 

of the 

assigned 

resource 
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  Start – 

shows the 

start date 

of the 

planning 

element 

 

  Published 

icon – 

marks 

those 

elements 

that are 

used in 

other 

project 

plans 

 

  Predecess

or – shows 

the 

preceding 

planning 

element if 

a 

dependen

cy exists  

 

  Workload

 – time 

needed 

for the 

completio

n of the 

planning 

element 

or task 

 

Critical path, slack, and time line 
Especially when you have a complex project plan, details like the critical path or lag time between 

dependent planning elements can increase transparency and help you retain a good overview. 

Show critical path in Gantt chart 
The critical path marks those planning elements that are crucial in keeping your deadline. Delays 

along the critical path can lead to scope creeps and possibly derail your scheduled project deadline. 

If you want to show the critical path in your plan, you must already have planning elements that are 

connected with each other. 

1. Open the project and the Gantt-chart. 

2. Click on the tab View. 

3. Click on Show Critical Path. 

 

The planning elements along the critical path are marked in red in your Gantt-chart. 
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Snapshot Feature 
The snapshot function in InLoox Planning allows you to record the current status of your project plan. 

You will receive a backup of your planning which you can return to if you have made wrong changes 

in the planning. 

See our video tutorial: How to Use the Snapshot Feature (no audio) 

 

Use planning elements in other projects 
With the publication feature, you can use selected planning elements (i.e. activities and milestones) 

in other projects. 

Application examples: 

• There is a global annual department planning. The goal is to adopt activities from the global 

planning into other projects that take place during the year. If a change is made to the activity 

in the global plan this should be incorporated into the other projects. 

https://www.inloox.com/support/documentation/video-tutorials/inloox-10-for-outlook-planning-snapshot-no-audio/
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• You want to incorporate milestones from a corporate milestone plan into projects of different 

departments. 

TIP If you don’t want to use individual planning elements in other projects, but set dependencies 

between two or more projects, then we recommend to create a project group. 

Publish planning elements 
Please follow these steps to publish planning elements from a source project in a target project. 

1. Open the planning of the source project. Mark the activity or milestone in the Gantt plan that 

you want to use in another project. 

2. Click on the Edit tab onto the Edit button in the Ribbon or double-click onto the selected 

planning element. 

3. On the right side of your Gantt plan, a side panel opens where you can edit planning 

elements. In the Publications group, click on Select project… 

 

4. In the dialogue Add to Project you’ll find all projects that you have a reading permission for. 

Select the target project. You are only able to confirm your selection with OK if you also have 

the permission to edit the planning of the selected target project. 
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5. When the publication was successful, you will find a link to the target project in the side 

panel in the Publications group. If you want to delete the publication click on the black 

cross  right of the target project. 

 

In the Gantt plan, published planning elements are indicated by the following icon: 

 

NOTE It is only possible to publish activities and milestones. The assigned work packages are only 

visible in the source project. Summary activities cannot be published. 

NOTE If an activity has already been published in another project, which the current user is not 

allowed to access, he or she will only see the remark “Project” in the Publications group. 

 

Necessary permissions 
A user needs the following permissions to be able to publish planning elements: 

• In the source project: Read planning 

• In the target project: Read planning & Edit planning 

 

Notifications 
As soon as an activity has been published, an automatic notification will be sent to the project 

managers of the target project – unless this feature has been deactivated in the source project. 

This is how you can deactivate notifications in the source project: 

In the Planning section, on the Settings tab, activate the button No Notifications. 
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In the InLoox options, you’ll find the regarding notification templates which you can edit according to 

your needs. 

• Activity published 

• Milestone published 

 

  

TIP Please see the section Notification Templates to find out how you can adjust notification 

templates according to your needs. 

 

How to use published elements in the target project 
You’ll find planning elements that have just been published in the target project at the end of the 

Gantt plan. Now you can move them manually to the place where you want to use them in the plan 

(by using the arrow buttons in the Ribbon on the Edit tab).   
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Published elements are marked by the following symbol in the Gantt plan. 

 

Published elements can be used just like “normal“ planning elements in the Gantt plan, i.e. you can 

create dependencies between them and the other planning elements. 

Double-clicking onto the published planning element in the target project will open the side panel 

where you will find the notice that the regarding object is a published activity from another project 

and a link that leads you to the source project. 

 

By clicking onto the link you’ll get directly to the source project (provided that you have reading 

permissions in the source project). Only there you can edit or delete the published element. 

IMPORTANT A published activity can only be edited in the source project. A planning element can 

only be published from the original source project of the activity. Further publications into third 

projects are not possible. 

TIP Use the filter Current Project to blank published elements from the target project. 

 

Behavior in case of constraint violation 
In the course of project planning it is possible that team members edit a published activity in the 

source project. This might affect the planning of the target project. In this case, you will find a notice 

when you first open the planning after the change has been made. The planning can be adjusted 

automatically. Activities and milestones that depend on the published elements will be moved 

accordingly. The rest of the planning is not affected. 
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Fixed Deadline 
The 'Fixed Deadline' feature provides you with an additional option for visualizing delays that could 

have a negative effect on the finish date of your project. This feature is useful if the end date of your 

project marks a fixed deadline. Delayed milestones or activities that lie outside of the planning period 

are highlighted in an orange shaded field in the project plan. 

  

1. Start from the project overview: To create a new project click in the ribbon on the Start tab and 

on New Project. Or double click to open an already existing project.   

2. Activate the 'Fixed Deadline' feature  in the management view on the Edit tab. 

The feature highlights all activities that are delayed beyond the project end date (specified on the 

management page) in an orange shaded field in the planning. See at a glance whether the project can 

be completed on time or whether delays have negative effects on the deadline.  

 

3. You can activate or deactivate the feature at any time in the management view of your project. 

 

Print planning 

1. How to open the print preview 
Open a project >> Go to Planning >> Click on the View tab >> Click on Print 
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2. Overview of the print preview ribbon 
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3. Print preview features in detail  
(1) Print 

Edit the printer settings before printing. E.g., determine which pages you want to print or whether 

you want to print in landscape or portrait mode. 

(2) Print immediately 

Click on Print immediately to print your planning using the default printer settings. 

(3) Time frame 

If you only want to print the planning for a specific time frame, you can define it here. E.g., only print 

the planning elements for the next week for your weekly meeting – so you can keep track of the tasks 

and activities that have to be done during that week. 

 

(4) Table settings 

• You can set a specific width for your table by choosing 1-5 with 1 being the default setting. 

The bigger the width of your table, the more detailed will your print be and, of course, longer. 

• You can also customize your table via the table scaling. E.g., if you want to see the complete 

project plan on one page but your planning is so long that it doesn’t fit into one page. 

• You can also display the planning list (fields) on all pages – this allows you to quickly match a 

bar in the Gantt chart with its activity. 

(5) Timeline interval 

Determine whether you want the planning to be displayed in weeks, months or years. 

(6) Display more columns (fields) 

You can also display more columns, i.e. fields. The changes you make in the print preview won’t 

affect the view of your original project plan. 
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(7) Select printer 

Select a default printer – this setting will apply to all projects 

(8) Paper size 

Print your project plan in various sizes. 

(9) Page margins 

Customize the page margins of your print. Note: There’s a minimum margin of 4,32cm 

(10) Scaling 

Enlarge or reduce your planning view – without changing the printing range. 

(11) Navigation 

Quickly jump to the right page via the navigation. 

(12) Zoom 

Enlarge or reduce the print preview – this won’t affect the actual print, it’s merely an optical zoom. 

(13) Watermark 

Protect your print documents with a watermark. You can use a text or picture: 

• If you select “Text Watermark” then you can choose between a variety of preset texts or 

enter your own text. 

 

• You can also use an image as a watermark, e.g. your company’s logo. Just click on the tab 

“Picture Watermark“ and upload an image. 

TIP   We recommend using a .JPG file. 
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Select the position “In front“ and increase the transparency (e.g. 200) so that the watermark will be 

shown in the front but won’t be too overwhelming. 

(14) Export & Send as email 

You can export the print of your project plan or send it directly via email. 

• Export to PDF 

Click on the button “Export to” to export your print to PDF. Alternatively click on the arrow to 

open the dropdown menu and select “PDF file”. Then you’ll be able to define the PDF 

settings. E.g. protect your file with a password or add a digital signature. 

• Export to Image file 

Click on the arrow to open the dropdown menu and select “Image file” to export your print. 

You can save all pages of your project plan in one file or save each print page in an individual 

file. 

• Send as email 

You can also send your print via email. Click on the button „Email as”, to send the file as a 

PDF. Or click on the arrow to open the dropdown menu and select “Image file” to send the 

print as an image file. You can customize the PDF and image settings as described above. 

Before you can send the file via email, you’ll have to save it locally first. After you have 

selected a storage location, a new email window opens with the print file attached. 
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Project-related tasks 
Warning As of version 9, work packages have been renamed tasks. 

Project-related tasks are tasks that belong to a specific project. In InLoox, you can use the Kanban 

method to manage these tasks. 

Please watch our video tutorial for an introduction into the Kanban method. 

In project management, Kanban is a method to visualize tasks and to manage the flow of work. Tasks 

are divided into three categories that are displayed on a three-column board: To Do, In Progress, 

Done. The status of tasks and competences are always clear. In the classic Kanban method, tasks are 

not scheduled, but in InLoox you have the option to create tasks with and without a deadline.   

Create, edit and delete project tasks 
There are several ways to create project tasks in InLoox: 

• Copy tasks from a project mind map 

• Import tasks from a template 

• Create tasks manually 

You can also combine all three methods. In this chapter we look on the topic of manual task creation. 

Create tasks manually 
1. You are in your InLoox project for which you want to create a new task. 

https://www.inloox.com/support/documentation/video-tutorials/inloox-9-for-outlook-the-kanban-view/
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2. Click in the Ribbon on the Home tab on the Tasks button. 

3. Now, click in the Ribbon on the Edit tab on the New button. The new task will then be displayed in 

the left column of your Kanban board.  

 

Alternatively, you can click on the plus sign in the respective column to add the new task directly to 

this column. 

 

You can now also edit the task in the editing side panel on the right. 
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• Name and description: Enter a name for your task and describe the scope of the task. 

• Effort: Enter the estimated effort for the task. With a click on the little arrow, you can change 

the format from hours to working days (equals 8 hours by default). 

• Resource: You can assign a resource to the task, but you don’t have to. In classic Kanban, 

team members choose the task that they want to work on next themselves from the To Do 

column. For a quick selection of frequently used resources, click on the little arrow, for the 

global address list, click on the three dots next to the resource field. Now select the person 

who is supposed to be in charge of the task. You can only enter one resource per task. 

• Start/End: You can give you task a time frame, but you don’t have to. If you want to specify a 

certain start and/or end date, click on the arrow next to start or end and select a date and a 

time. When you add the task to an activity in the project schedule, the task will adopt the 

start and end date from this activity automatically. You are able to change that manually. 

Warning: In this case, we recommend to schedule the task within the time frame of the 

activity to which the task belongs. 
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• Documents: If certain documents are related to the task you can add them to the task by 

clicking on New link… in the documents section. You will get an overview of all project 

documents that have already been added to InLoox and for which you have a reading 

permission. If there aren’t any documents in your document library yet, you can upload a 

new document and add it to the task by clicking on New, selecting a document from your 

computer or from your file server and confirming with OK. 

Tip   If you want to link a document to a project element but you have a large number of 

project documents, you can search for the respective document in the document list. To do 

this, simply click on the column above the respective column heading in the document dialog 

and enter the search term. 

 

• Budget: You can assign the task to a certain budget group. In InLoox, there is an internal price 

per hour stored for each budget group. This price is used if the task is assigned to a budget 

group. The InLoox Administrator can set the budget groups in the InLoox options. The Billable 

check box is activated by default. This means that for the hours of work that go into the task, 

a planned expense for the resource costs is created in the project budget. Later, you can 

generate an actual revenue in the project budget for this expense. If you remove the check, it 

is not possible to bill the expense later. Activate the Individual check box to ignore group 

rates and specify the purchase price and the sales price for the individual hourly costs of the 

resource. 

• Notifications: The resource the task is assigned to receives a notification about the task 

automatically. In the notifications section, you can inform other people such as the project 

manager or a proxy about changes made to the task. Click on the little arrow to get a quick 

selection of frequently used resources or on the three dots to get to the global address book. 

The InLoox Administrator determines in the InLoox options if and when a resource gets 

notified. 

• Notes tab: Starting in version 10.2, task notes are now displayed in a new tab in the task side 

panel. 
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• Don’t forget to save your new task: Click on the File tab in the upper left corner and then 

either on Save when you want to save the task, but want to keep working on the project or 

on Save and Close when you want to save the task and leave the project. You’ll also find your 

project-related task in the global project list where it is visible for anyone who has reading 

permissions for the task. 

Edit tasks 
You can edit an already existing task by double-clicking the task or, alternatively, by clicking on 

the Edit tab on the Edit button in the Ribbon. This will open the side panel that you already know 

from creating a new task. You can now edit the task. 

Starting with version 10.2, you can quickly edit certain task information inline, such as task name, 

start date, effort or resource, depending on the size of the card.  
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If a task is done you can mark it as such by clicking on the Home tab on the Done button in the 

ribbon. You’ll find the same command in the context menu that you can open by right-clicking on the 

task, then select Done in the menu. 

 

When a resource marks a task as done, all persons who have been added to the notifications field will 

be informed about it. The task will be moved automatically to the Done column / the outer right 

column of the Kanban board. The completed task will be reported back into the project plan and is 

included in the calculation of the project progress. If the project manager marks the task as done, the 

resource in charge of the task and all the people in the notifications field will be informed 

automatically about it. 

Tip   When your project contains several similar tasks, you can copy tasks. Click on the task, then click 

on the Edit tab on the Copy button in the ribbon, then on the Paste button. 

Warning   If the original version of the copied task contains constraints from an activity in the project 

schedule, these constraints won’t be adopted into the copied task. Start and end dates that were set 

manually, however, will be adopted into the copied task. 

Delete tasks 
You can delete tasks by clicking on the task that you want to delete in the Kanban board, then on 

the Home tab on the Delete button in the Ribbon. You’ll also find this command in the context menu 

that you can open by right-clicking on the task that you want to delete. 
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When you delete a task, the people for which you have set up notifications will be informed about it. 

If you are the manager of the project and you delete another resource’s task, the person will be also 

informed Deleted tasks are removed permanently, you cannot restore them. 

Tip  When you want to delete several tasks at once, you can use multi-select. Keep the CTRL key on 

your keyboard pressed down while selecting the tasks that you want to delete with your mouse. Then 

select Delete in the ribbon. 

 

Team task management with Kanban 

How a Kanban board works 
Read the Kanban board from left to right: On the outer left side, there are always the tasks that yet 

need to be done, also known as the Backlog. On the outer right side, there are always the completed 

tasks.  

 

In each status column the hours of all tasks in the column are added up. This is useful if, for example, 

you only have a certain number of hours reserved for the project. This feature gives you a quick 

overview of the estimated workload of all tasks in the project without having to open the dashboard. 

As soon as you move a task to another column, the number of hours in the respective status column 

automatically adjusts. 

 

 

Edit or delete a status 
You can customize the names and the number of columns to suit your needs. Click on the Edit tab 

on Edit Status in the ribbon. This will open a side panel on the right: 

https://www.inloox.com/project-management-glossary/backlog/
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Click on New Status to add another column to the view. You can now name the new column and 

assign a color. Your Kanban board now would have four columns. 

You can also edit the already existing columns/status. In the side panel, click on the status that you 

want to edit and change the name and the color in the dialog. The color helps you to identify tasks 

with the same status. 

 

Use the arrows to change the order of the Kanban columns – the highest entry is the outer left 

column, the lowest entry is the outer right column. Click the cross to delete columns. 

New tasks always appear in the outer left column. You can drag them with your mouse in another 

column to change their status and their color. If for example a team member starts to work on a task, 

he or she can drag the task from the To Do column into the In Progress column. This helps the entire 

team to see who is currently working on which task. As soon as you drag the task into the outer right 

column, it is marked as done. 

Overdue tasks are displayed with a red start and/or end date. The following task should have already 

been started, but is still in the To Do column. 

Warning   No matter how you name and arrange the columns – in InLoox, the tasks in the outer left 

column are always filed as undone and the tasks in the outer right column are always filed as done. 

Note   Adjustments to the Kanban board are always visible for the entire project. If you want to 

determine a Kanban structure for the entire project platform (across projects), the InLoox 

Administrator has to change the settings in the InLoox options.  

 

Meaning of the icons on a Kanban card 
You can see directly on the task card, whether a task has been added from a mind map node and/or if 

it has been assigned to an activity in the project schedule. Click on the regarding icon to get directly 

to the mind map or to the related planning activity. You can also see from the icons how many lists, 

documents and notes a task has.  
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Customize the task view 

Sort tasks 
You can arrange the task cards on the Kanban board by different criteria. Click in the ribbon on 

the Edit tab on Arrange By and select the criterion by which you want to arrange the tasks. This 

arrangement is only visible to you, not project-wide or system-wide. 



 287 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 

 

If you arrange the tasks by due date, you have an overview of which tasks are due first. 

 

Color 
You can assign an individual color to each task which overwrites the color of the task status. This 

helps you to highlight individual tasks and to mark specific tasks that are important to you. Again, the 

coloring of the tasks is only visible to yourself and not to other users on the same project platform. 

Click on the task that you want to highlight. Then click in the ribbon on the Edit tab on Color and 

select a color. 

 

 

Show details 
You have always been able to collapse and expand the task cards. The new Kanban in Version 10.2 

allows you to adust the card size according to your information needs. Simply hold the CTRL key and 

scroll up and down simultaneously with your mouse to enlarge or reduce the size of the cards. You 

will see more or less information depending on the size of the card. 
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Filter 
You can use the full-text filter to select specific tasks. You can e.g. filter by the name of a resource to 

display only the tasks that this person is responsible for or you can filter by a certain keyword. Click in 

the ribbon on the View tab on the Filter button and enter the keyword in the text field by which you 

want to filter the tasks. 
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Assign tasks to resources 
To assign a task to a specific person, click on the task card on the image or alternatively on Select 

resource… and select a resource from the dropdown menu. You can also search for a specific 

resource via the search field. Click on the address book icon to open the global address book and 

select a resource from there. 

 

If you want to assign the task to another person, you can simply click on the image or resource 

name again and select the new resource from the list. To remove a resource, click Remove 

resource at the bottom of the resource list. 

Tip   You can filter the resources in the global address book by specific skills, e.g. when the task can 

only be completed by someone with English language skills. Please go to the chapter Skills to learn 

how to assign specific skills to a resource. 

 

Divisions and teams 

Warning   The division and team functionality is only available in InLoox 9 Enterprise Server or in 

InLoox now! Enterprise. 

If you are able to choose from a multitude of resources the divisions and teams view helps you to 

keep a better overview. 
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If you want to assign a task to a resource from a specific division, please follow these steps: 

1. Click in the tasks section of the project on the Edit tab and in the ribbon on the Divisions and 

Teams button. 

2. This will open the Divisions and Teams overview in the side panel on the right. 

3. The InLoox Administrator can set the division and team structure in the InLoox options. 

4. You can expand the division structure by clicking on the black arrow in front of the division 

icon to see all resources that belong to that division 

 

5. Now drag the respective resource on the task that you want to assign. 

6. The workload of the task will now be included in the calculation of the resource’s workload 

and in the workload of the division. 

Besides the divisions that the InLoox Administrator sets for the entire project platform, you can create 

your own teams in InLoox and track their workload. The team functionality helps you to put resources 

together across divisions. 

Please follow these steps to create a team in InLoox: 

1. In the tasks section of a project, click the Edit tab and in the ribbon on the Divisions and 

Teams button. 

2. In the Divisions and Teams side panel, click on the plus symbol left of Add Team. A new team 

will appear below. 
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3. Now you can drag and drop resources from your team onto the respective tasks. 

 

4. The workload of the task will now be included into the calculation of the resource capacity 

and in the calculation of the team capacity. 

Note   The new team is available in each of your InLoox projects, but it is not available system-wide – 

meaning that your colleagues won’t be able to use the team. Every user can create his or her own 

teams. 

 

Task templates 
If a certain task set plays a role in many of your projects, you can save them as a task template. This 

can for example consist of tasks that your project team has to do each time your company takes part 

in a trade fair or whenever you launch a new product. With task templates, you don’t have to create 

these tasks over and over again, but only make adjustments for your current project. 

Save and load task templates 
1. First, create the tasks that you want to use in your template in an InLoox project. Learn here 

how to create new tasks. 

2. To save a task template directly in InLoox in the gallery view, click in the project in the tasks 

section on the Templates tab and on the Save Template button in the ribbon. Name the 

template and confirm with OK. 
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3. The task template is now available in all of your InLoox projects in the gallery view in the 

ribbon. You’ll find the gallery view in the project in the tasks section on the left side of the 

ribbon on the Templates tab. 

 

4. To load a template from the gallery view into your project, you just have to click on the 

template you want to load in the gallery. If there aren’t any tasks in your project yet, you will 

then see the tasks from your template in the Kanban view which you can edit further there. If 

your project already contains some tasks, the tasks from the template will be added. 

5. The InLoox Administrator can re-name, delete, export and import task templates from the 

gallery view in the InLoox options. On the InLoox website in the Download area, we have 

prepared some ready-to-use templates that you can import into all of your projects. 

 

Export and import task templates 
If you don’t want to save a task template in InLoox, but on your own computer, you can export it. This 

is recommended if you want to import it into Microsoft Project or to use it in another InLoox 

database. 

1. Create a set of tasks in an InLoox project that you want to save in a template and re-use in 

another project. 

2. Now click in the tasks section of your project on the Templates tab on the Export 

Template button in the ribbon. You have now the option to export the file as an MS Project 

XML file (recommended if you want to re-use it in Microsoft Project) or as an InLoox PM task 

template file (recommended if you want to re-use it in InLoox). Please select one option 

 

3. Select the place on your computer or file server where you want to save the file, name and 

save the template. 

4. To import a task template, click in the project in the tasks section on the Templates tab on 

the Import Template button in the ribbon. You can import Microsoft Project files as well as 

InLoox task template files. Please select the file format and choose the regarding template 

from your computer or your file server. 

5. If there are already tasks in your project, the tasks from the template will be added. 

https://www.inloox.com/support/downloads/
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You can also send a task template directly out of InLoox via email. Click in the project in the tasks 

section on the Templates tab and then in the ribbon on Send Template By Email. This command 

opens an email which already contains the task template as an attachment (InLoox task file). 

 

Add tasks to the project schedule 
If a project schedule (Gantt plan) is a part of your project you can also assign project-related tasks to 

the regarding activity in the schedule. We recommend this if a task is supposed to be completed 

within the time frame of this activity and if its content is related to the content of the activity. You 

don’t, however, have to assign a task to an activity, you can also use it as a “free task” in your project. 

Please follow these steps to integrate a task into your project schedule: 

1. Go to the planning of your project. Therefore, open your project and click on the Home tab in 

the ribbon on Planning. 

2. Double-click on the activity, summary activity or milestone that you want to assign your task 

to. This will open the side panel on the right to edit planning elements. 

3. At the bottom of the side panel, select the Tasks tab. 

 

4. You will now see an overview of all the tasks in your project that have not been assigned to a 

planning element in the Gantt chart yet. 

5. Now drag the regarding task with the mouse from the side panel onto the respective activity 

or milestone. 

6. You have different options: 

- Drag the task onto activity or milestone so that the line of the element is highlighted. Then let 

go of the task. It will then be shown as a sub-task to this activity or milestone in the plan. 

 
 The task will then appear in your Gantt Chart. 
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- You can also convert a task into a planning element. Drag the task from the side panel onto 

the place in the planning list where you want to create the new activity. A black line will 

appear in the planning list. Then let go of the task. 

 
 You will see a new activity to which the task is assigned. 

 

- You can also drag the task from the side panel onto a summary activity. This creates an 

activity below the summary activity, which has the same name as the task. The task is 

assigned to this activity. 

When you want to remove a task from the Gantt chart, you mark the task in the planning list. Then 

click in the ribbon on the Edit tab on the Remove button. 

 

The task will then reappear in the side panel. 
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When you are done editing your project tasks, click on the File tab and then on the Save button if you 

want to keep editing other sections of your project or on the Save and Close button to leave the 

project. 

  

Add multiple tasks to the project schedule via drag and drop 

You can add one or more tasks to the project schedule at once using drag and drop. You can select 

multiple tasks by holding down the Shift key or CTRL key and simply drag the tasks into the project 

schedule. 

 

 

Reports 
By using InLoox reports you can structure project information and export it for people, who do not 

use InLoox themselves. Therefore, you can either use standard InLoox reports or, design individual 

project reports using the InLoox Reportdesigner.  

InLoox reports are accessible from the project overview (global reports with filters) and directly from 

within a specific project (project-related reports): 

• Global reports: InLoox PM or InLoox now tab >> Projects >> Start tab >> Reports 

• Project-related reports: Open a specific project from the project overview >> Report tab 

Tip: As reports and especially the Reportdesigner provide very extensive and complex features, we 

recommend an online where you will learn how to design report templates and where we will give 

you a broad knowledge about the functionality of the report designer. For more information on the 

online training and the booking process, click here. 

https://www.inloox.com/products/training/
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Create standard reports 
InLoox offers two possibilites for creating standard reports: in the project overview (global reports 

with filters) and within a specific project (project-related reports). Additionally, InLoox provides you 

with a set of standard reports included in the standard InLoox license. 

Create global project reports 
For global project reports you can use all data of all projects you have access to. However, you can 

select data from a specific project, too.  

1. Click on Projects in the Outlook navigation bar, to open the project overview. 

 

2.Afterwards, open the Start tab and click on Reports >> Create Report. 

 

3. A new window will open. Therein you determine the project/projects you want to include in your 

report. 

• All Projects: Data of all projects you have access to, will be included in the report. 

• Selected Projects: First, mark all projects you want to include in the project list and then click 

on Create Report. Now, you can choose Selected Projects in the new window and all projects 

you have marked before in the project list will be included. Tip: To select multiple projects at 

the same time, press the CTRL-Button on your keyboard and select the projects from the 

project list.  

• Only projects matching: Here you can include projects by filtering by criteria like project 

number, project name or customer. For example: If the project number includes the year and 

you only want to include projects from the year 2016 to you report, you enter “2016” in the 

field Number contains.  
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4. Moreover, you can include project requests by ticking the check-box Include project requests. In 

the case of project requests some of the default reports do not make sense, because usually project 

requests do not contain very much information expect information from the management page.  

5. Choose the template you want to use.  

>> Afterwards, you can create filters in the areas Tasks, Planning, Time and Budgets within this 

window.  

 

Create project-related reports 
To create a report with respect to a specific project, proceed as follows:  

1. Click on Projects in the Outlook navigation bar, to open the project overview. 
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2. In the project overview, double-click on the project you want to refer to in your report. The project 

will be opened.  

3. Afterwards, click on the Reports tab and then on Create Report in the ribbon. The report will refer 

to the project that is currently open.  

 

4. Choose the template you want to use.  

>> Afterwards, you can create filters in the areas Tasks, Planning, Time and Budgets within this 

window.  

 

Standard InLoox reports 
For both - global project reports and project-related reports – you can choose from report templates 

which are included in the InLoox standard license. (If the report templates are not installed on your 

computer yet, read here how you can download them.) 

Budget overview 

 

List of budget, expenses and revenues of the selected project(s) 

  

Document list 
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Overview of all documents of a project 

  

Expenses/Revenues 

 

Comparison of expenses and revenues of the selected project(s) 

  

Gantt planning overview (day, month or quarter) 
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Export of the planning overview and the Gantt-chart in different accuracy: varying from very detailed 

(day) to a rough overview (quarter). 

Tip: This template is only recommendable for project-related reports.  

  

Letter 

 

Plain letter regarding the project 

  

Meeting 

 

Template for the organisation of project meetings 

  

Memo 
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A note that includes all basic information of a project.  

  

Planning overview 

 

Overview of the project plan without Gantt-chart 

  

Planning overview Plan/Actual 

 

Overview of the project plan to compare plan status and actual status of the project 
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Project completion 

 

Final notification to the project 

  

Project kickoff 

 

Notification to the project start including all basic information related to the project 

  

Project status 
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Progress report of the current status of the project 

  

Time tracking 

 

Overview of all time tracking entries of a project 

 

How to filter report data 
For each report type you can choose, which data you want to include in the report. In addition to 

real-time filtering in reports, InLoox offers dynamic filtering of the most important project data. 

For global reports you can select, which projects you want to include in the report (= Project Filter). 

Whereas in project-related reports you have already chosen a specific project by opening it. 

The following filters can be used for both report types – global reports as well as project-related 

reports: 

• Project-related report: To use one of the following filters, open a project, click on 

the Reports tab, and then on Create Report. 

• Global report: Open the project overview, then open the Start tab. There click 

on Reports and Create Report. 

After both procedures a new window (the report dialog) will open. There you can adjust the filter 

settings. 

 

Overview of available filters 

Task filter 

In the report dialog open the Tasks tab.   
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You can include all tasks of the project(s) in you report or select: 

• Tasks matching a specific period of time 

• Tasks performed by a specific person 

• Tasks from a group 

• Tasks, which are billable 

• Tasks, which are not billable 

Furthermore, you can combine those task filters.  

  

Planning filter 

If you want to create a report regarding you project planning, you either include all planning 

elements (summary activities, activities, milestones) or just selected elements. 

Open the Planning tab in the report dialog, to adjust the planning filter: 
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 Additionally you can limit the data by setting a date. 

  

Time filter 

If you are including time tracking entries to your report, you can decide whether to use all entries or 

you can filter them.  

 

To set the Time filter, open the Time tab in the report dialog: 

• You can select time tracking entries of a specific period of time. 

• You can limit time tracking entries to those of a specific person. 

• You can choose entries of a specific group. 

• You can choose between billable and not billable time tracking entries. 
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Furthermore, you can combine those time filters.  

  

Budget filter 

For budget-related reports InLoox offers highly selection settings. You can choose either all budgets of 

the selected project(s) or define one or more budget filters. Therefore, open the Budgets tab in the 

report dialog. The following filter options are available:  

 

You can choose between different budget elements for your report: 

• Revenues (actual) 

• Expenses (actual, time-tracking) 

• Expenses (actual, other than time-tracking) 

• Revenues (plan) 

• Expenses (plan) 

• Expenses (plan, resources) 

In addition, InLoox provides you with the following filter options: 

• You can select a period of time. 

• You can choose a specific project status 

• You can filter specific budget items (billed, not yet billed, billable, not billable) 
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How to save filter settings permanently 
If you create reports on a regular base and mainly use the same filter combinations, you do not need 

to adjust the filter settings each time. You can save those filter settings and reuse them. For saving 

filter settings permanently you need to be InLoox admin and you should have the permission “Create 

and edit report templates”.    

  

1. Click on Projects in the Outlook navigation bar.  

 

2. Afterwards, open the Start tab and click on Reports >> Saved Reports… 

 

3. A new window will open. There you can see all currently saved reports.  

 

4. You can create a new report template, by clicking on New. 

5. The report dialog will open. Here you can determine: 

• the name of your template. 

• to which projects the report is referring to. 

• which report template you want to use. 

• which project data should be included (filters). 

• If you want to give all other InLoox users access to your saved report, you need to tick the 

checkbox Visible for all users.  
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6. Click on Save Report, to save your settings and to close the window.  

7. Now, the saved report appears in the overview:  

 

The saved report template is permanently available to you (and all other InLoox users, if you have 

ticked the checkbox) on the Start tab >> Reports >> Saved Reports…. There you also can edit or 

delete the report template. 
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To create a new global project-report using this template, click on Projects in the Outlook navigation 

bar.  Then click on the Start tab and on Reports. The new template appears in the drop-down-list and 

you just have to click on it, to create a new report using that template.  

 

 

InLoox report designer 
Generally, after creating a new report the InLoox report designer will open. The report designer issues 

your reports and you can adjust the report (e.g. format) there. For exporting the report you can 

choose between various file types.  

  

Output file types 

All InLoox reports can be downloaded in different file types. The following file types are available: 

 



 310 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
• PFD File (Adobe Portable Document Format) 

• HTML File (Web Page) 

• MHT File (Single File Web Page) 

• RTF File (Rich Text Format) 

• Excel File (Microsoft Excel 2000-2003 Workbook) 

• Excel 2007-File (Microsoft Excel 2007 Workbook) 

• CSV File (Comma-Separated Values Text) 

• Text File (Plain Text) 

• Image File (BMP, GIF, JPEG, PNG, TIFF, EMF, WMF) 

To choose a file type, firstly create a report and filter the report data regarding your needs. 

Subsequently, click on Create Report in the report dialog. A preview window will open. Click 

on Export To in the upper right corner and select the file type. 

If you do not want to save the report in a different file type, you can print it via the Print button in the 

upper left corner.  

 

How to manage report templates 
1. Note on report security in version 10.2 

Starting with version 10.2, script execution in the background is disabled by default. If you want to 

continue using older InLoox report templates or work with scripts in your own report templates, then 

you will have to activate the script execution in the background manually in the InLoox options. We 

do not recommend activation but would like to point out that deactivating the scipt execution in the 

background can pose a compatibility risk. 

Important   Script execution is always disabled in InLoox Web App and InLoox now!. 

Scripts allow you to perform automated calculations of certain report elements at certain events. 

However, script execution can also pose a security risk. In many older report templates there is still 

program code that is executed when the report is opened or executed, e.g. to calculate values for 

certain fields such as the sum of all tasks. 

InLoox standard reports and newly created reports no longer have any program code. You can now 

use expressions for calculations instead. Expressions make it possible to create data fields that 

contain a formula – just like in Excel.  For example, you can simply use the expression SUM(Field1) to 

specify that this field should be totaled for the entire report group. 

You can also convert older report templates with data bindings to expressions. This allows you to 

keep the script execution in the background deactivated, while still being able to use existing report 

templates. 

• For more information on the conversion, see: https://devexpress.github.io/dotnet-

eud/interface-elements-for-desktop/articles/report-designer/report-designer-for-

winforms/bind-to-data/data-binding-modes.html 

https://devexpress.github.io/dotnet-eud/interface-elements-for-desktop/articles/report-designer/report-designer-for-winforms/bind-to-data/data-binding-modes.html
https://devexpress.github.io/dotnet-eud/interface-elements-for-desktop/articles/report-designer/report-designer-for-winforms/bind-to-data/data-binding-modes.html
https://devexpress.github.io/dotnet-eud/interface-elements-for-desktop/articles/report-designer/report-designer-for-winforms/bind-to-data/data-binding-modes.html
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• Detailed information on the use of expressions can be found under the following 

link: https://docs.devexpress.com/XtraReports/120091/Detailed-Guide-to-DevExpress-

Reporting/Use-Expressions 

2. Manage report templates 

Attention   To administrate report templates you should be InLoox admin or you will need the 

permission “Create and edit report templates”. For more information on user permissions see also 

“Set user permissions”.  

Generally, report templates can be managed in the InLoox options: 

1. Open Outlook and click on Home in the upper left corner. Select InLoox Options from the list. 

2. A new window will open. Select General >> Report Templates on the left side of the window. 

An overview of the report templates will be shown.  

 

  

3. Create a new report template 

1. To create a new report template, open the InLoox options and click on General >> Report 

Templates.  

2. Click on New and another window is going to open.  

https://docs.devexpress.com/XtraReports/120091/Detailed-Guide-to-DevExpress-Reporting/Use-Expressions
https://docs.devexpress.com/XtraReports/120091/Detailed-Guide-to-DevExpress-Reporting/Use-Expressions
https://www.inloox.com/support/knowledge-base/online-help/inloox-for-outlook/9-0/all-support-articles/security-and-privacy/user-permission-options/
https://www.inloox.com/support/knowledge-base/online-help/inloox-for-outlook/9-0/all-support-articles/security-and-privacy/set-user-permissions/


 312 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 

 

3. In this window you can define all important aspects of the new report: 

• Name the report. 

• Choose between Inloox 9, 10 and older InLoox versions. InLoox 9, 10 provides you with a new 

version of the report designer. You can still create and edit reports from InLoox 6, 7, 8 but this 

is going to change in future InLoox versions. 

• Define from which areas of a project you want to have access to this report template.  

4. Afterwards click on OK to close the window and to save your settings.  

5. Now the report designer is going to open. There you can design the new template individually. For 

more information on how to use the report designer, see InLoox Report Designer. When you have 

finished, click on Apply in the InLoox options, to save your changes. 

  

4. Edit report templates 

If you want to change the general settings of a template (like name or visibility), select the template 

in the overview and click on Edit. A new window is going to open. There you can edit all important 

settings:  

• You can change the name of the template. 

• Choose between Inloox 9, 10 and older InLoox versions. InLoox 9, 10 provides you with a new 

version of the report designer. You can still create and edit reports from InLoox 6, 7, 8 but this 

is going to change in future InLoox versions. 

• Define from which areas of a project you want to have access to this report template.  

https://www.inloox.com/support/knowledge-base/online-help/inloox-for-outlook/9-0/all-support-articles/reports/inloox-report-designer/


 313 User Manual  InLoox 10 for Windows/Outlook 
Professionals 

 
When you have finished, click on OK and the window is going to close. Back to the InLoox options 

click on Apply to save your changes.  

  

5. Design report templates 

To change the content of an already existing report template, select the template in the overview and 

click on Design. The InLoox report designer is going to open. For more information on how to use the 

report designer, see InLoox Report Designer. When you have finished, click on Apply in the InLoox 

options, to save your changes. 

  

6. Delete report templates 

To delete a report template, select the template in the overview and click on Delete.  

  

7. Export report templates 

To save a report template on your computer, select the template in the overview and click on Export. 

Afterwards, you can choose the storage location and then click on Save. When you have finished, 

click on Apply in the InLoox options, to save your changes.  

  

8. Import report templates 

To import a report templates which is saved on your computer, click on Import and select the 

template from your computer. Afterwards, click on Open. When you have finished, click on Apply in 

the InLoox options, to save your changes.  

  

9. Download report templates 

On the InLoox website you can download several standard report templates: 

1. Click on Download in the InLoox options and the InLoox website is going to open. 

2. There click on Templates and select the English version of the report templates. 

3. A zip-file will be downloaded and saved on your computer in the download folder. 

4. Open this folder by using the windows explorer and double-click on the zip-file to open it. 

Copy the templates and save them to another place on your computer. 

5. Return to the InLoox options >> Reports >> Templates and click on Import. 

6. Select one of the saved templates from your computer and click on Save. 

7. Proceed like this for all other templates. 

8. When you have finished, click on Apply in the InLoox options, to save your changes.  
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InLoox Report Designer 
By using the InLoox report designer you can create individual report templates on your own. This 

chapter shortly introduces the main features of the report designer. However, it is not possible to 

explain everything in detail due to the immense range of features. 

You can access the InLoox report designer via the InLoox options (Home >> InLoox options >> 

Reports >> Templates):  

 

By clicking on New you can create a new report. By clicking on Design or double-clicking on an 

already existing report you can edit the report templates. In both cases the InLoox report designer is 

going to open.  
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Using the report designer you can individually create report templates. Using the report designer you 

determine font type, font size, positions and data. 

  

In the following some elements and features of the report designer are introduced: 

1 Report Explorer 

The report explorer shows the structure (margins) of a report. To open the report explorer, click 

on Windows in the ReportDesigner tab and select Report Explorer from the drop-down-list.  

 

  

2 Default Layout 

In the property grid you can determine the default layout for the template. To open the property grid, 

click on Windows in the ReportDesigner tab and select Property Grid from the drop-down-list.  
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3 Data Source 

The data source for the report can be determined in the property grid, too. To open the property grid, 

click on Windows in the ReportDesigner tab and select Property Grid from the drop-down-list. In the 

property grid scroll down to Data.   
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4 Zoom and Layout Features 

Zoom features are especially helpful to receive an overview to large reports. The zoom features are 

located in the ReportDesigner tab.  

 

You can switch between three different views: ReportDesigner, PrintReview and HTML View. You can 

access those views via the different tabs.  

 

  

5 Most important tools 

To open the tool overview click on Windows in the ReportDesigner tab and select Tool Box from the 

drop-down-list. 
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The report designer provides various tools. The most important ones are: 

• Label: e.g. for headlines, the company name or simple formatting 

• Rich Text: for InLoox description windows 

• Picture Box: for the logo 

• Line & Shape: for simple drawings 

• Chart & Gauge: for bar and pie charts 

 

  

6 Detail Reports 

You can select detail reports regarding specific project areas in the report. Therefore, right-click on 

the detail band in the report and select Insert Detail Report in the context menu. Now you can select 

a project area to create a report on it.  
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To edit the detail report, open the window Field List via ReportDesigner >> Windows >> Field List. 

Drag-and-Drop all fields you will need into the detail report.  
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7 Add Calculated Fields 

In addition to all available fields in the field list, you can use calculations, filters, transformations (e.g. 

from text to number) and conditions. Those features are available by using calculated fields. To create 

a new calculated field proceed as follows: 

1. Open the field list via ReportDesigner >> Windows >> Field List. 

2. Right-click in the window field list and select Add Calculated Fields in the context menu.  

 

3. A new calculated field will appear in the field list.   

  

 

4. Right-click on the calculated field and select Edit Expression. A new window is going to open. There 

you can edit the calculated field using for example if/else constructs.  
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8 Sort and Formatting 

Sort: The report data can be sorted in respect to every field. To sort the report proceed as 

follows: ReportDesigner >> Windows >> Group and Sort 

 

Formatting: Additionally, you can format data fields and the related formatting rules. To edit the 

formatting, click on the blue arrow right above the specific field and select Format String. 

The FormatString Editor is going to open. There you can edit the formatting rules.  
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Resources and Allocation 
Resources can be people, but also objects such as rooms, machines or financial assets. It is important 

to have the right resource working on a task or project for its efficient and successful completion. 

InLoox enables you to manage the capacities of staff, rooms or machines, as well as allocate tasks 

according to the resources’ capacities. The result is a more effective use of resources, which leads to 

an increase of your projects’ efficiency.  

Open the resources and workload allocation overview 
Open system wide resources and allocation overview 

Follow these steps to open the system wide, project-independent resources and allocation overview: 

Open Outlook and navigate to InLoox by clicking on Projects in the navigation bar and then 

select Allocation in the folder panel.  
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You can also open the allocation overview by clicking on the InLoox tab in Outlook and then 

selecting Workload in the ribbon.  

 

  

Open resources and allocation overview inside a project 

You can also find the resources and allocation overview inside individual projects. There you can 

display and manage the workload of the project team. You can display the workload overview in 

the Kanban view as well as the planning. 

Open workload in the Kanban view: 

1. Navigate to your projects InLoox >> Projects and open a project from the project list. 

2. Click on Tasks in the Start tab of the InLoox project window. 

3. To show the departments and teams side panel, click on Divisions and Teams in the Edit tab. 
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4. To open the workload overview of your project team, go to the View tab and click on Workload. 

The workload overview opens in a new window.  

 

  

Open workload in the Planning:  

Tip You can change the color scheme of the workload view in the planning in the InLoox Options.  

1. Go to your projects InLoox >> Projects and open a project in your project list 

2. Click on Planning in the Start tab of the InLoox window 

3. Click on Workload in the ribbon to open your workload overview 
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4. You can display the workload in all projects (All Projects) or only the workload of the project that is 

currently open (Only this Project).  

 

  

5. To display the workload, drag-and-drop one or more divisions and teams into the resource 

overview. If you want to hide the workload of a specific group, just drag-and-drop the group back into 

the side panel.  
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You can also see the capacity of resources next to each task in the planning, provided you have 

allocated a resource to the task. This enables you to see who in the project team still has capacities 

and who is over-allocated. In the latter cases, it is advisable to re-assign tasks to relieve a resource.  

 

  

Tip Project teams should never work to capacity (100%), because in most cases they do not work 

exclusively on the project. Usually, they also have to handle their daily workload. This means that 

when they are working to capacity in a project, they are actually over-allocated because you have to 

add 20% or 40% workload for daily tasks to the 100% project workload. 
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Selected allocation features 

 

• Add Resource – Add a new resource, e.g. from the global address book or the InLoox address 

book. 

• Edit and Delete – You can edit or delete elements (resources, tasks, but NOT projects) in the 

resource overview. 

Please note Deleting a task in the allocation overview also deletes the task in the project. 

• Recent Projects - Access your most recently opened projects directly from the workload 

overview. 

• Re-Assign Task – If you see that a resource is over-allocated, you can relieve them by re-

assigning the task to someone in the team who still has free capacities. 

• Exchange Calendar – You can show or hide the Free/Booked information from the Exchange 

Server. InLoox takes the Exchange calendar information into account when it calculates the 

workload. 

Please note The Free/Booked information is only available for internal resources, and only 

when you are online. The information is never available for external resources, neither online 

nor offline.  
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• Labels – You can decide whether you want to show or hide the percentage of the workload 

next to the bars in the overview. 

• Completed Items – You can show or hide tasks that have been marked as “Done”. By showing 

the completed tasks you will get an overview of the complete workload. If you just want to 

see the current and future workload, then hide the completed items. 

• Divisions and Teams – You can show or hide the Divisions and Teams side panel. The side 

panel displays all departments in your organizations and the resources who work in the 

individual departments. You can also create individual cross-department project teams. 
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Please note It is not possible to create new departments (Divisions) in the workload overview. You 

can create, edit and delete departments in the InLoox options, if you have the necessary 

administrator rights. You can also allocate resources to departments.  

• Date Range, Zoom In and Zoom Out – Decide for which time range you want to see the 

workload (hours, days, weeks, months, quarters, years). The view of the resources and 

workload chart changes depending on the date range. 

• Print Overview and Load Chart – Print the current view of the resources overview or the 

workload chart.  
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• Refresh – Click on refresh to apply all changes and to update the view.  

 

Show the workload in the resource overview 
Please note The workload overview only shows the workload and allocation of tasks that have a start 

and end date. 

The resource overview shows you a visual overview of the workload allocation during the specified 

date range. You can decide which resource’s workloads you want to see in the resources and 

workload allocation overview. The overview also shows, in addition to the project tasks, the 

Free/Booked information from the Exchange Server, if the option is selected. Your own, project-

independent tasks are also displayed in the workload overview.  

 

  

Follow these steps to show the workload in the resources and workload overview: 

1. Go to Allocation: InLoox >> Allocation 

2. Display the side panel, if it isn’t open already, by clicking on Divisions and Teams in the ribbon. 
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3. Select a group from the Divisions and Teams side panel for which you want to show the allocation. 

To do so click on the Display icon   next to the respective groups or you can also drag-and-drop 

the group into the list on the left. For example, drag the group Your Company into the list to show the 

workload allocation of your entire company.  

 

  

4. If you want to see how the workload is divided between the departments within your company, 

you can open the subordinate groups by expanding the group My Company. To do so just click on the 

arrow next to the group you want to expand, or expand the group by opening the context menu with 

a right click and expand it with Expand All Groups. 
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You can see that in the above example, the company as a whole isn’t over-allocated, but the 

department Management is over-allocated. It is also possible that it is not the whole department that 

is over-allocated, but only one of the resources is. In such cases it is advisable that you re-assign the 

tasks to relieve the over-allocated resource.  

 

Work with the resource overview 
The resources overview chart shows you the workload of your resources and whether they still have 

capacities or are over-allocated. It is possible to show or hide the workload all or selected 

departments. This enables you to get an overview of the workload of your whole organization, or just 

the workload of one or more departments or project teams.  

 

• The bars show the extent and duration of the allocation: 

• Blue bar: 1% - 100% 

• Pink bar: 101% - 149% 

• Red bar: > 149% 

• A blue vertical line marks the current date 

• If you hover over a bar, you can see the details of the allocation:  
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• The percentage shows you the extent of the allocation. Over 100% means that your 

resource is over-allocated. 

• The start and end date and the duration of the allocation  

• You can also edit the respective resources, projects or tasks directly in the workload 

overview:  

1. Open the respective detail window by double-clicking on an element. Or open the context 

menu with a right-click on an element in the resource list on the left hand side. Click on Show Details 

 

  

2. Depending on the type of the element you have marked, a different edit window opens: 

• For resources, the contact window opens where you can edit the contact 

details 

• For projects, the project window opens where you can change the project 

data, or go to the Kanban view or the Planning etc. 

• For tasks, the task window opens where you can edit the task and add task 

notes 
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Add a new team 
Please note The teams you create in the resources and allocation overview are only visible to 

yourself. Other InLoox users in your system cannot see the changes. So editing or deleting a team 

member has no effect on the resources and workload view of other InLoox users. 

You can create individual teams to see the workload of cross-department project teams. 

 

1. Open the Divisions and Teams side panel and click Add Team. 

2. Click on the Edit button and enter the name of the team. 
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3. Add team members by clicking on the Add Resource icon .  

Tip If a team member works on several projects, then you can just copy that member per drag-and-

drop.  

4. Show or hide Divisions and Teams in the resources and workload overview as needed. You can see 

that a team is not shown in the overview when the Display icon is gray . When it is blue  then 

it is shown in the overview. Alternatively, you can also drag-and-drop a team into the overview.   

  

Please note It is not possible to create new departments (Divisions) in the workload overview. You 

can create, edit and delete departments in the InLoox Options, if you have the necessary 

administrator rights. You can also allocate resources to departments.  

 

Add a new resource 
You can also add a resource without assigning it to a team from the outset:  

1. Go to InLoox >> Allocation 

2. Click on Add Resource in the Ribbon 

 

  

3. Select a resource from the address book, e.g. from the global address list or the InLoox address list 

 

  

If you need a resource who has specific skills, then you can filter your address book so it only shows 

the resources who have these skills. To do so, click on Search by Skills on the upper right-hand corner 

of the dialog window and select the skills you need. It is possible to select more than one skill.  
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Please note When you filter by skills, all resources which have at least one of the specified skills are 

shown, not just the ones that possess all of the selected skills. 

Please note You can define Skills in the InLoox Options and specify which resources in your company 

have which skills.  

4. Confirm with OK. The new team member is sorted into the automatically created Standard Team. 

Tip If a team member works on several projects, then you can just copy that member per drag-and-

drop.  

 

Re-Assign a task 
Follow these steps to re-assign a task, i.e. to allocate a task from one resource to another: 

1. Expand all groups until you reach the tasks. To do so click on the arrow next to a group, then 

expand the resource, then expand the project. Or you can expand groups via the context menu 

 

Note that this command only expands the next lower subordinate group, so you have to click 

on Expand All Groups until you get to the lowest level, the tasks.  
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2. Select the task you want to re-assign. 

3. Click on Re-Assign Task in the ribbon. 

 

  

4. Select the resource you want to assign the task to from the address book 

 

  

5. Click on OK to confirm.  

 

Change the date range 
The workload overview enables you to see the workload of your entire company, of a department or 

of an individual resource in a specific time frame. You can specify the date range as needed: Today, 

Week, Month, Year, or a Custom date range.  

1. To specify a time frame click on Date Range in the Ribbon 

2. Select the required date range. The view of the workload overview changes depending on the 

chosen date range: e.g. 

Week  
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Month  

 

  

Year 

 

  

Custom date range 
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The workload chart 
The workload chart below the resources overview shows you the cumulated workload data of your 

entire company, of a department, of a project team, or of an individual resource. It shows you a visual 

overview of the workload in the specified time range. The workload chart shows you the allocation of 

resources, depending on which group or resource you have selected from the resource list. This 

means that the workload chart is dependent on the resource overview. If you have not selected a 

group or resource from the resource list, then the workload chart won’t show any data. 

These rules apply to the workload chart:  

 

  

• A blue area shows that a resource is busy in the specified time frame, but not over-allocated. 

The height of the bars show how busy a resource is in percent. 

• A striped blue area shows that a resource is over-allocated in the specified time frame. The 

height of the bars show how busy – or over-allocated a resource is in percent. 

• You can immediately see when a resource is working to capacity from the horizontal blue 

line at the height of 100%. So if the bars go over that line that means that a resources is over-

allocated in that time frame. 

• The horizontal green line shows the average workload of a team or resource. We 

recommend an average workload of 60-70%, as resources often have to do day-to-day 

business tasks in addition to project work. This way you ensure that your team members are 

not overworked. 

• A vertical blue line displays the current day 

 

Time tracking 
With the time tracking feature in InLoox you can record time exposure for project-related tasks, 

document activities or track working hours for accounting. You can create time tracking entries either 

within an open project or in the time tracking overview. Both views allow you to create and edit time 

tracking entries or to create a reminder. 

• The time tracking overview is located outside of the projects and shows the time tracking 

entries of all projects you are allowed to access. 
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• Whereas the time tracking view within a project just shows the time tracking entries of that 

project.  

Create and edit time tracking entries 
This chapter explains how to track working time in InLoox. The system automatically assigns the effort 

to the project plan and stores a separate cost record. 

  

Create and edit time tracking entries within a project 
1. Open an already existing project. 

2. In the project open the Start tab and click on Time to open the time tracking view of your project. 

3. The time tracking view shows all time tracking entries of a specific project. To create a new time 

tracking entry, click on New. 

4. A side panel will open on the right side. Here you can add all important information regarding the 

new time tracking entry: 

• Date and Duration: Define start and end of your entry. Therefor you can use arguments like 

Start, End and Duration. Additionally, you can add a description of the activity you were 

working on.  

 

Allocation: Assign the time tracking entry to a specific task or an activity. If you assign it to an activity, 

the drop-down-list will represent the structure of the planning. Assign a cost group to the entry by 

editing the field Group.  

 

• Details: Mark the new time tracking entry with a green, yellow or red flag and choose the 

resource that performed the activity or task. 
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• Documents: Add additional documents, if needed. 

  

5. When you have added all important facts, close the side panel by clicking on X directly next to Date 

and Duration in the right corner. Your changes have been saved already. 

6. To edit an already existing time tracking entry, double-click on the entry in the time tracking view 

of your project. Alternatively, select the entry in the time tracking list and click on Edit on 

the Edit tab. The side panel will open on the right side and you can edit the information of the entry 

you have selected. Then close the side panel and your changes will be saved.  

  

Create and edit time tracking entries in the time tracking overview 
Even faster you can create time tracking entries in the time tracking overview over all projects: 

1. Open the InLoox now or InLoox PM tab and click on Time, to access the time tracking overview for 

all projects. 

2. This time tracking overview contains all time tracking entries of all projects.  

 

3. In the Start tab click on New Entry, to create a new time tracking entry. 

4. A dialog box will open. To assign the new entry to a project, select the project in the dialog box and 

click on OK. 
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5. Add all information in the dialog box New Item. Follow the procedure that is described above 

in Create and edit time tracking entries within a project in 4. 

6. When you have added all information, click on OK. 

7. To edit an already existing time tracking entry, double-click on the entry in the time tracking 

overview. Alternatively, you can select it in the list and click on Edit in the Start tab. The dialog 

box Edit Item will open and you edit the information of the entry. Afterwards click on OK. 

 

Create a reminder 
By using reminders you can create automatic follow-ups for tasks that are not finished yet. You can 

create reminders for every time tracking entry. Additionally, you have the possibility to create a 

reminder for other persons. Reminders can be created either in the time tracking view within a 

project or in the time tracking overview over all projects. 

  

How to create a reminder in the time tracking overview  
1. Click on the InLoox now or InLoox PM tab and then select Time. The time tracking overview over 

all projects opens and shows all time tracking entries of all projects you are allowed to access.   

2. Select a time tracking entry from the list. Afterwards click on Create Reminder in the Start tab.  

3. A new dialog box will open: 

• Define date and time of the reminder. 

• Activate the check box Also remind, to additionally create the reminder for another person. 

Click on , to select a resource from the address book. 

• Add additional information in the Details area. 

4. To save the reminder, click on OK.  
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How to create a reminder in the time tracking view within a project 
1. Open an already existing project and click on Time in the Start tab. The time tracking overview of 

your project opens and shows all time tracking entries of the project.   

2. Select a time tracking entry from the list. Afterwards click on Create Reminder in the Edit tab.  

3. A new dialog box will open: 

• Define date and time of the reminder. 

• Activate the check box Also remind, to additionally create the reminder for another person. 

Click on , to select a resource from the address book. 

• Add additional information in the Details area. 

4. To save the reminder, click on OK.  

 

Record working time with the InLoox stopwatch 
Record your personal working time to-the-minute with the InLoox stopwatch. Afterwards you can 

assign the recorded working time directly to a project. 

1. Open the InLoox now or InLoox PM tab and click on Stopwatch. 

2. The stopwatch will pop-up in a new window: 

 

• Click on Start, to start the recording. 

• Click on Pause, to pause the recording. 

• If you want to reset the stopwatch, click on Reset Timer. 

3. To assign the recorded working time to a project, click on Track Time. 

4. The dialog box Select Project will open. Select a project from the list and click on OK. 

5. After that a new time tracking entry will open. The entry already includes the recorded start and 

duration of your activity. You can also add more information. 

6. When you are finished click on OK.  
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Customize time tracking views 
The time tracking view within a specific project provides an overview over all time tracking entries of 

the project. Whereas the time tracking overview over all projects displays all time tracking entries 

of all projects. Both views can be individually customized regarding your personal needs. 

  

Analytical filter 
The analytical filter provides advanced options to easily find information and structure the time 

tracking view. To open the analytical filter click on … 

• … Filter on the Start tab. (time tracking overview over all projects) 

• … Edit Filter on the View tab. (time tracking view within a project) 

 

  

Select fields 
In the time tracking views you can add various additional information by adding more column 

headings. 

1. To add new column headings, right-click and choose Select fields in the context menu. 

2. A new dialog box that displays all available fields will open. If you want to add one of the fields to 

your list, drag it to your preferred location in the list. Two arrows indicate the position of the new 

column.  
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3. To delete a column heading from the list, drag the field back into the dialog box or into the empty 

area below the list. 

  

Group feature 
1. To group time tracking entries by a specific column, drag a column header into the field directly 

above the column headers.  

 

2. By clicking on the arrow next to the group criteria, you can change the order from ascending to 

descending or the other way round. 

3. Here you can use an additional filter option: Move the cursor over the group criteria. A filter icon 

appears in the right corner. Click on that icon to further limit the criteria.  

 

  

Sort time tracking entries 
Additionally, you can sort time tracking entries by column headings. Click on the column heading and 

then click again to change the sorting order.  

 

Save customized views 
After you have customized your time tracking views regarding your personal needs, you can save 

those views for a later time. 

• The time tracking view within a project automatically saves your adjustments. When you are 

opening the project the next time, your customized view will be automatically displayed. 
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• In the time tracking overview over all projects you have to save your customized view. By 

saving a customized view you can make it accessible for other users. How to save your 

customized view in the time tracking overview over all projects will be explained in the 

following step-by-step. 

  

Save a customized view in the time tracking overview over all projects 

1. Open the InLoox now or InLoox PM tab and then click on Time. The time tracking overview over all 

projects opens. Customize the view regarding your needs. 

2. To save the customized view, open the Start tab and click on Save and then on Save current view. 

3. Name the view (e.g. Grouped by projects) and activate the check box Visible for all users, if you 

want to make your view accessible for other users. Then click on OK. 

4. You can find the view in the tree structure on the left side directly below time.  

 

 


